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COURSE OBJECTIVE:
e Understand basic multimedia concepts, devices and the current trends in
multimedia.
e To understand the basic software tools used in multimedia.
e To learn the basic tools and techniques in photoshop

e To learn essential concepts in Adobe Flash

COURSE OUTCOME:
After the completion of this course, a successful student will be able to do the following:
e Understand basic multimedia concepts.
e Acquire basic knowledge on Multimedia devices.
¢ Identify the basic components of a multimedia project.
Identify the basic hardware and software requirements for multimedia
development.
e Understand current trends in multimedia
e Will be able to develop a simple action scripts using flash.

e Will be able to perform photo editing process using Photoshop.

UNIT-I
Definition of multimedia — Introduction to making multimedia: the stages of a project —
Basic software tools-Using Text in multimedia - font editing and design tools —

hypermedia and hypertext.
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UNIT-1I
Introduction to Photoshop 6: Interfaces and Navigation-Tools-Text-Working in

Photoshop-Creating new documents-Saving Files.

UNIT-111

Displaying the Images — Using Ruler, Guides and Grids — Making Selections- Layers and
Types-Choosing Colors-Creating Brushes- painting & editing Tools-Making and
Applying Gradients.

UNIT-1V
Introduction to Flash: Variables & data types-Data types in Action Script-Creating and
placing variables — Buttons with text fields.

UNIT-V
Basic Actions: Play, stop, Back & forth-Between frames and scenes — Timelines —

External scripts-Loops.

TEXT BOOKS

1. Bill Sanders. 2001. Flash5 Action Script, 1° Edition, DreamTech Press, New Delhi.

2. Steve Romaniello. 2001. Mastering Photoshop 6, 1% Edition, BPB Publications, New
Delhi.

3. Tay Vaughan.2014. Multimedia making it Work, 9" Edition, Tata McGraw-Hill, New
Delhi.
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DreamTechPess, New Delhi.
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3. Ze-Nian Li and Mark S. Drew. 2004. Fundamentals of Multimedia, Pearson
Education, New Delhi.

4. Scott Kelby . 2016. How Do | Do That in Photoshop? Rocky Hook Publications

5. Glyn Dewis. 2014. The Photoshop Workbook: Professional Retouching and
Compositing Tips, Tricks, and Techniques , Preachpit Press

6. Annesa Hartman . 2011. Exploring Adobe Flash CS5, Delmar Cenage Learning.

7. Richard Wagner. 2011. Professional Flash Mobile Development: Creating Android
and iPhone Applications 1st Edition, Wiley Publishing.
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Lecture Support Materials/
S.NO | Duration Topics To Be Covered PP
PageNo
(Hrs)
UNIT 1
1 1 Definition of multimedia T1:1-4
-CD-ROM and the Multimedia Highway
-CD-ROM, DVD, and Multimedia
-The Multimedia Highway
2 1 Multimedia Uses T1:5
3 1 Where to use Multimedia T1:5-12
-Multimedia in Business
-Multimedia in Schools
-Multimedia at Home
4 1 Multimedia in public places T1:8-12
-Virtual Reality
S 1 Introduction to making Multimedia T1:18-19
-The Stages of a project
6 1 Basic software tools T1:262-264
-Text editing and word processing tools
-OCR Software
-Painting and drawing tools
7 1 3-D Modeling and Animation tools T1:264-270
-Image-Editing tools
-Sound editing tools
8 1 -Animation ,video ,and Digital movie Tools T1:270
9 1 Using Text in multimedia T1:55-56
-Designing with text
-Choosing text fonts
10 1 -Menus for navigation T1:56-58
11 1 -Buttons for interactions T1:58-62

-Fields for reading
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12 1 HTML documents T1:62-66
-Symbols and Icons
-Animating text
13 T1:66-68
1 Font editing and design tools w2
-Fontographer
14 1 Making pretty text T1:80-84
15 1 Hypermedia and hypertext T1:84-85
-The power of hypertext
16 1 Using hypertext T1:85-87
17 1 Recapitulation and Discussion of Important
Questions
Total No Of Hours Planned For Unit | 17
UNIT 2
1 1 Introduction Photoshop 6 T2:17
2 1 Interfaces and Navigation T2:21-22
-Accessing and Navigation
-Palettes
3 1 -Presets T2:22
4 1 Tools T2:22
-Toolbar
-Crop Tool
-Shape Tools
5 1 -Path Component Selection Tool T2:22-23
-Annotation Tools
6 1 -Patterns and Gradients T2:23-24
-Slice Tools
7 1 Text T2:25-30
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-Layer Management
-Mini Programs
8 1 Working in Photoshop
-Strategies T2:39-43
9 1 -Opening Documents T2:43-45
10 1 Importing a scanned image T2:45-46
1 1 Creating new documents T2:46-47
-Creating a document from the clipboard
12 1 Saving Files.
-Save as W3
-Save
13 1 -Save for web T2:49-51
-Path to illustrator
14 1 Recapitulation and Discussion of Important
Questions.
. 14
Total No Of Hours Planned For Unit Il
UNIT 3
1 1 Displaying the images T2.Pg.no:70-71
-The zoom tool
-Scrolling in Photoshop
2 1 -Navigation shortcuts T2.Pg.no:71-74
-The navigator
-The view menu
-Display modes
3 1 Using Rulers ,Guides and Grids T2.Pg.no:75-78
-Settings preferences for rulers and guides
4 1 -Using Guides T2.Pg.no:78-80
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-Using a grid

S 1 Making Selections
-Layers and Types
-Arranging layers

T2.Pg.n0:198-204

6 1 -Using layers to create and edit

T2.Pg.no:204-207

7 1 -Entering type
-Adjusting opacity of a layer

T2.Pg.no:208-213

8 Merging layers

T2.Pg.no:210-213

9 1 Choosing Colors
-The color picker
-Active parameters of color

T2.Pg.no:256-261

10 1 -Using color palettes T2.Pg.n0:262-265
-Sampling colors
11 1 Creating Brushes T2.Pg.n0:265-266

-Make a new brush
-Modify an existing brush

12 -Create a custom brush

T2.Pg.n0:266-268

13 1 Painting & Editing Tools
-The painting tools

T2.Pg.n0:268-274

14 -The editing tools T2.Pg.n0:272-276

15 1 -Brush dynamics T2.Pg.no:276-277
-Color blending modes

16 -Painting tool shortcuts T2.Pg.no:277

17 1 Making and Applying Gradients T2.Pg.no:277-278

-Choosing gradients

18 1 -Making custom gradients T2.Pg.n0:279-280
19 -Applying gradients T2.Pg.no:281-282
20 1 Recapitulation and Discussion of Important

Questions

Total No Of Hours Planned For Unit 3

20
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UNIT 4
1 Introduction to Flash T3.:20
2 Flash -Variables T3.:21
3 Data types W5
4 Data Types in Action Script T3:22-28
5 Creating Variables T3:29
6 Placing Variables T3:30
7 Buttons with text fields T3:33-35
8 Text fields T3:33-35
9 Creating an instance of the Button component T3:36
10 Resizing and Positioning Buttons W1
11 Recapitulation and Discussion of Important
Questions
Total No Of Hours Planned For Unit 4 11
UNIT 5
1 Basic Actions T3:58-60
2 Play & Stop T3:58-60
3 Back & Forth between frames T3:61
4 Back & Forth between scenes T3:62
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5 1 Time lines T3:67
6 1 Parts of the Time lines W4
7 1 External scripts T3:69
8 1 Loops T3:104-108
9 1 Loops example T3:108
10 1 Recapitulation and Discussion of Important
Questions
11 1 Discussion of Previous ESE question paper
12 1 Discussion of Previous ESE question paper
13 1 Discussion of Previous ESE question paper
Total No Of Hours Planned For Unit5 13
TEXT BOOKS

1. Bill Sanders. 2001. Flash5 Action Script, 1% Edition, DreamTech Press, New Delhi.

2. Steve Romaniello. 2001. Mastering Photoshop 6, 1% Edition, BPB Publications, New
Delhi.

3. Tay Vaughan.2014. Multimedia making it Work, 9" Edition, Tata McGraw-Hill, New
Delhi.

REFERENCES

1. Dinesh Maidasani. 2006. Flash 8, 1% Edition, Firewall Media Publications, New
Delhi.
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2. Robert Shufflebotham. 2004. Photoshop CS in Easy Steps, 1% Edition,
DreamTechPess, New Delhi.

3. Ze-Nian Li and Mark S. Drew. 2004. Fundamentals of Multimedia, Pearson
Education, New Delhi.

4. Scott Kelby . 2016. How Do | Do That in Photoshop? Rocky Hook Publications

5. Glyn Dewis. 2014. The Photoshop Workbook: Professional Retouching and
Compositing Tips, Tricks, and Techniques , Preachpit Press

6. Annesa Hartman . 2011. Exploring Adobe Flash CS5, Delmar Cenage Learning.

7. Richard Wagner. 2011. Professional Flash Mobile Development: Creating Android
and iPhone Applications 1st Edition, Wiley Publishing.
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UNIT-I
SYLLABUS

Definition of multimedia — Introduction to making multimedia: the stages of a project —
Basic software tools-Using Text in multimedia - font editing and design tools — hypermedia
and hypertext.

MULTIMEDIA TOOLS

Definition of multimedia:

“Multimedia can be defined as the technology engaging a variety of media, including text,
audio, video, graphics, and animation, either separately or in combination, using
computers, to communicate ideas.”

TEXTS
VIDEO

MULTIMEDIA

g

GRAPHICS

ANIMATION

AUDIO: Speeches, music and other types of sounds. Audio element is generally used to
enhance the usual multimedia environment, but in some cases may become more effective
than all other media put together.
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TEXT: The usual text with some difference as compared to the print media. Since
computer can display a variety of fonts, beautiful color combinations, and background
features in almost all of the multimedia titles, which is far better then the printed text.

GRAPHICS: pictures, photographic images and other art works.
ANIMATION: the artificial movements of texts or objects, created in visual environments,

using specialized software packages. There are 2D and 3D animations. Animation is the
most interesting part of multimedia.

VIDEO: the actual video clips that could be embedded right over the application and can
be played back without a hitch. But the sizes of the clippings are usually much smaller than
that from video cassette players.

Multimedia Definition :
The use of multiple formats for the presentation of information, including, text,

sound, video, images, and animation. Computer-based interactive multimedia includes
Hypermedia and hypertext. Multimedia means more than one media.

=  Text

= Sound

= |mages

= Animation
= Video

Hypermedia :

computer-based  system that allows interactive linking of multiple format
information including text, sound, video, images, and animation. Allow non-
linear traversal.

Hypertext :
Non-linear organized and accessed screens of text and static diagrams, images,
and tables.

Multimedia hardware
e Selection of the proper platform for developing your multimedia project may be
based on:
o Personal preference
PC or Macintosh
Budget constraints
Delivery requirements
Type of material and content in the project

O O O O

Stages of a Multimedia Project:

(2) Planning
« Planning involve:-
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= Developing an idea
= |dentifying Objectives and Users
= ldentify Skills and Resources
= Developing a graphic template, the structure, and a navigational system.
= Estimating Time and Cost
= Develop a small prototype or proof of concept
(2) Design and Production
= The planned tasks are performed to create a finished product.
= Task include storyboarding, designing a detail navigation structure, GUI
consideration and HCI consideration.
o The product is revised, based on the continuous feedback received from the
client by doing an evaluation.
(3) Testing
e The program is tested to ensure that it:
e meets the objectives of the project
e works on the proposed delivery platforms
e meets the client requirements.

(4) Deliver

« The final project is packaged and delivered to the end user.
Requirements for a Multimedia Project

Hardware
Software

Enabling Technology

Creativity &
Organizational Skills

Where to use multimedia

Multimedia is media and content that uses a combination of different content
forms. The term can be used as a noun (a medium with multiple content forms) or as an
adjective describing a medium as having multiple content forms. The term is used in
contrast to media which only use traditional forms of printed or hand-produced material.
Multimedia includes a combination of text, audio, still images, animation, video, and
interactivity content forms.
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Categorization of multimedia

Multimedia may be broadly divided into linear and non-linear categories. Linear
active content progresses without any navigational control for the viewer such as a cinema
presentation. Non-linear content offers user interactivity to control progress as used with
a computer game or used in self-paced computer based training. Hypermedia is an
example of non-linear content.

Multimedia presentations can be live or recorded. A recorded presentation may
allow interactivity via a navigation system. A live multimedia presentation may allow
interactivity via an interaction with the presenter or performer.

Usage

A presentation using Powerpoint. Corporate presentations may combine all forms of
media content.Virtual reality uses multimedia content. Applications and delivery
platforms of multimedia are virtually limitless.VVO Multimedia-Terminal in Dresden
WTC (Germany)Multimedia finds its application in various areas including, but not limited
to, advertisements, art, education, entertainment, engineering, medicine, mathematics,
business, scientific research and spatial temporal applications. Several
Examples are as follows:

Creative industries

Creative industries use multimedia for a variety of purposes ranging from fine arts, to
entertainment, to commercial art, to journalism, to media and software services provided
for any of the industries listed below. An individual multimedia designer may cover the
spectrum throughout their career. Request for their skills range from technical, to
analytical, to creative.

Commercial

Much of the electronic old and new media used by commercial artists is multimedia.
Exciting presentations are used to grab and keep attention in advertising. Business to
business, and interoffice communications are often developed by creative services firms
for advanced multimedia presentations beyond simple slide shows to sell ideas or liven-up
training. Commercial multimedia developers may be hired to design for governmental
services and nonprofit services applications as well.

Entertainment and fine arts

In addition, multimedia is heavily used in the entertainment industry, especially to develop
special effects in movies and animations. Multimedia games are a popular pastime and are
software programs available either as CD-ROMSs or online. Some video games also use
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multimedia features. Multimedia applications that allow users to actively participate instead
of just sitting by as passive recipients of information are called Interactive Multimedia.

Education

In Education, multimedia is used to produce computer-based training courses
(popularly called CBTSs) and reference books like encyclopedia and almanacs. A CBT lets
the user go through a series of presentations, text about a particular topic, and associated
illustrations in various information formats. Edutainment is an informal term used to
describe combining education with entertainment, especially multimedia entertainment.

Journalism

Newspaper companies all over are also trying to embrace the new phenomenon by
implementing its practices in their work. While some have been slow to come around, other
major newspapers like The New York Times, USA Today and The Washington Post are
setting the precedent for the positioning of the newspaper industry in a globalized world.

News reporting is not limited to traditional media outlets. Freelance journalists can
make use of different new media to produce multimedia pieces for their news stories. It
engages global audiences and tells stories with technology, which develops new
communication techniques for both media producers and consumers. Common Language
Project is an example of this type of multimedia journalism production.

Engineering

Software engineers may use multimedia in Computer Simulations for anything from
entertainment to training such as military or industrial training. Multimedia for software
interfaces are often done as a collaboration between creative professionals and software
engineers.

Industry

In the Industrial sector, multimedia is used as a way to help present information to
shareholders, superiors and coworkers. Multimedia is also helpful for providing employee
training, advertising and selling products all over the world via virtually unlimited web-
based technology

Mathematical and scientific research

In mathematical and scientific research, multimedia is mainly used for modeling and
simulation. For example, a scientist can look at a molecular model of a particular
substance and manipulate it to arrive at a new substance. Representative research can be
found in journals such as the Journal of Multimedia.
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Medicine

In Medicine, doctors can get trained by looking at a virtual surgery or they can simulate
how the human body is affected by diseases spread by viruses and bacteria and then
develop techniques to prevent it.

Requirements for a Multimedia Project:
(1) Hardware
1. Fast processor
o e.g. Pentium
2. Large RAM (Random Access memory)
= Memory space that the computer uses when performing work.
= More RAMs means computer works quicker and more efficient.
3. Storage
= Large Hard Disk
Capable of supporting fast data transfer rate.
= Removable large-capacity storage devices
E.g. rewritable CD-Rom, Zip drive

4. A good CD-ROM burner & good CD-R software to complement it
= Easy CD Creature Deluxe

5. High resolution and a large monitor
Minimum 17 inch monitor

6. Good video display card
preferable capable of displaying 24 bit colors

7. Good video capture cards

= Allow you to capture video from a tape or camcorder
8. A good quality digital camera

= At least support 640 x 480 pixels images

= Has display panel
9. Input devices

= Keyboard, mouse, track ball, touch screen, graphic tablet, data glove
10. A good flatbed scanner

o 24-bit color depth and 300-dpi resolution
11. Color Printer
12. Color projector

Software

« Graphic design photo editing application

Adobe Photoshop, Corel’s Photo-Paint
« 3D modeling and animation application

Maya, 3D StudioMax
« Digital sound editing application
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Sonic Foundry’s Sound Forge
 Digital video editing application
Adobe’s Premiere

« Multimedia authoring application
Adobe Director
« Web page authoring/design tool
Adobe Dreamweaver, Microsoft’s FrontPage

Enabling Technology

Computing Power

= Increase in CPU processing power

= Increase in storage capacData Networking
Data Networking

= Better transmission media

= Fiber optic as compared to copper wire
= Better transmission technique

o Fast packet switching

= Better services offered

= ATM, ISDN, B-ISDN, Broadband

Compression Technology

= GIF (Graphical Interchange Format)
Mostly used with the internet

= JPEG (Joint Photographic Experts Group)
Still image compression

= PNG (Portable network Graphic)

Very popular nowadays especially for web-based application

= MPEG (Motion Picture Expert Group)
Full motion video compression

Creativity and Organizational skills.

« In a multimedia project, being creative implies knowledge of hardware and

software.

« It is essential to develop an organized outline detailing the skills, time, budget, tools

and resources needed for the project

« Assets such as graphics, sound and the like should be
throughout the project’s execution.

« A standardized file-naming procedure should be followed
and swift retrieval.

continuously monitored

for precise organization
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Basic software tools

The tools used for creating and editing multimedia elements on both Macintosh
and windows platforms support the authoring systems.
e Text editing and word processing tools:

®,

% It is usually the first software tool computer users learn.

% From letters, invoice and storyboards to project content

% Workgroup will choose a single word processor to share documents in a standard
format.

% Include spreadsheet, database, e-mail, Web browser and presentation

applications.

Word processors such as

X/

X/

X/

*,

% Word and WordPerfect

Include spell checkers, table formatters prebuilt templates for
letters, resumes, purchase orders.

Multimedia elements such as sounds, images and video.

L)

X/
X4

L)

7/
‘0

*,

7/
‘0

*,

Do pnie & wiileeis fr gedie vein
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e OCR Software
%+ Optical Character Recognition.
%+ Often you will have printed matter and other text to incorporate into your
project, but no electronic text file. With Optical Character Recognition
% (OCR) software, a flat-bed scanner and your computer you can save many
hours of typing printed words and get the job done faster and more

accurately.
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¢

Reading 8 to 36 point characters at 300 dpi(dots per inch)

Processing speeds 150 characters per second.

The text areas of the images are then converted to ASCII characters using
probability and expert system algorithm.

Ex: Perceive

OCR - for printed text recognition
ICR — for hand-printed text recognition
OMR - for marks recognition

OBR - for barcodes recognition

BCR — for business cards recognition
DLR - for document layer recognition

o
A5

*
°e

X/
X4

L)

X/
X4

L)

¢

o
%

X/
o

X/
o®

L)

X/
o®

L)

X/
o®

L)

X/
o®

L)

e Painting and Drawing Tools:

% Painting and drawing tools are the most important items in your toolkit
because the impact of the graphics in your project will likely have the
greatest influence on the end user.

% Painting software is dedicated to producing excellent bitmapped images

¢+ Such us Photoshop, Picture Publisher and Fractal Design Painter

% Drawing software is dedicated to producing vector based line art that is
easily printed to paper.

% Drawing packages include powerful and expensive computer-aided
design (CAD) software.

¢ Such us CorelDraw, FreeH And Canvas.

%+ software applications combine drawing and painting capabilities.

%+ But many autoring systems can import only bitmapped images.

% Ex: DeskDraw, DeskPaint, Designer

The following features in a drawing or painting packages:

% Paint tools to create geometric shapes,from squares to circles and from
curves to complex polygons.

Ability to pour a color,pattern or gradient into any area.

Ability to paint with patterns and clip art.

Eyedropper tool that samples colors.

Zooming for magnified pixel editing.

Multiple undo capabilities to let you try again.

Airbrushing in variable sizes,shapes,and pattens

Washing colors in gradients,blending and masking.

Support for scalable text fonts and drop shadows.

e

%

e

%

e

%

e

%

e

%

e

AS

e

AS

e

AS

e 3-D Modeling and Animation Tools
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% 3 — D modeling software objects rendered in perspective appear more
realistic

» We can create stunning scenes and wander through them.

» Choosing the right lighting and perspective for you final rendered image.

% Powerful modeling packages such as Macromedia’s Estreme 3D,AutoDesk’s
3d studio Max.

R

¢+ Application also include export features enabling to save a moving view.
% Each rendered 3-D image takes from a few seconds to a few hours to
complete

+ Depending upon the complexity of the drawing and number of drawn objects.

>

L)

()

L)

L)

Features

>

X/
*

Ability to drag and drop primitive shapes into a scene.

Color and texture mapping.

Ability to add realistic effects such as transparency.shadowing and fog.
Ability to draw spline-based paths for animation.

Unlimited cameras with focal length control.

L)

7/
X4

L)

7/
X4

L)

7/
X4

L)

7/
X4

L)

e Image-Editing Tools

“ Image editing applications are specialized and powerful tools for enhancing
and retouching existing bitmapped images.

These programs are also indispensable for rendering images used in
multimedia presentations.

*
o

>

D)

» Modern versions of these programs also provide many of the features and
tools of painting and drawing programs, and can be used to create images
from scratch as well as images digitized from scanners, digital cameras or
artwork files created by painting or drawing packages.

Ex: Photoshop

*,

D)

A X4

Features

e

%

Multiple windows provide views of more than one image at a time.

Good masking features

Multiple undo and restore features.

Direct inputs of images from scanner and video sources.

Conversion of major image-data types and industry standard file formats.

e

%

e

%

e

%

e

AS
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e Sound Editing Tools

°

R/
°

-— - P =l AL

“Qv...|

_l,l
. '.-
X

T T

Sound editing tools for both digitized and MIDI sound let you see music as
well as hear it.
By drawing the representation of the sound in a waveform, you can cut,

copy, paste and edit segments of the sound with great precision and making

your own sound effects.
» Using editing tools to make your own MIDI files requires knowing about

D)

*,

keys, notations and instruments and you will need a MIDI synthesizer or
device connected to the computer.

5

S

5

S

e

%

e

%

e

%

Dr.S.ManjuPriya & Mr. K.Yuvaraj, Department of CS, CA & IT, KAHE

Many MIDI applications provide both sequencing and notation capabilities
Need a MIDI synthesizer or device connected to computer.
MIDI files and multimedia project without learning any special skills.
Editing software such as Creative Labs,WaveStudio.
Ex: SoundEdit Pro
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e Animation Video and Digital Movie Tools

% Animations and digital movies are sequences of bitmapped graphic scenes
(frames), rapidly played back.

% But animations can also be made within an authoring system by rapidly
changing the location of objects to generate an appearance of motion.

%+ Movie-making tools let you edit and assemble video clips captured from
camera, animations, scanned images, other digitized movie segments.

% The completed clip, often with added transition and visual effects can be

played back.

e Video Formats
< The AVI Format

The AVI (Audio Video Interleave) format was created and released by
Microsoft. Being a very common format, computers operating Windows and
also most of the web browsers as Internet Explorer, Firefox or Safari support
it. The video files encoded in AVI can be easily recognized by their
extension:example “videofile.avi” .Systems running other operating systems
than Windows may not support the avi format.
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0,

«+ The Windows Media Format

This format is also a Microsoft release. First it was created for online
streaming apps (WMV) and as a countermove to the RealVideo solutions

R

<+ The MPEG Format

The Moving Pictures Expert Group format seems to be the most popular
online format. This maybe because it is supported by the most of the web
browsers and operating systems.

X/

% The QuickTime Format

Released by Apple, it is a very popular format on the Web. Movies need an
additional plugin in order to play on a Windows based environment.
QuickTime 10.0 is the latest release being available on MAC OS v.10.6. .mov.
is the extension for QuickTime video files

e Movie Editors

RS

% QuickTime X

QuickTime Player is a perfect video editor if you just need some basic video
editing functions like trimming, rotating, or combining video clips. With the
video trimming feature, you can remove the part you don't want and get your
desired video parts. Also you can combine 2 or more clips and merge them
into one.

Rotate Right
Flip Morzontal
Flip Vertical

Clip Alignment

Add Clip to End
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% Windows Movie Maker(Windows)

Window Movie Maker has been on the market for many years for Window
systems to let you easily edit QuickTime video. You can use it to rotate
QuickTime video, resize QuickTime video, or crop, zoom, add title,
transitions and other effects to your clips. The software can also blend audio
files with video tracks to produce video remixes. The supported video formats

Bl Wircows Moe Makor —y =)

include MOV, WMV, AVI, MP4, M4V, 3GP and more.
Compression Movie files
% Audio, image and video require vast amounts of data

%+ 320x240x8bits grayscale image: 77Kb

¢+ 1100x900x24bits color image: 3MB

% 640x480x24x30frames/sec: 27.6 MB/sec

% Low network’s bandwidth doesn't allow for real time video transmission
% Slow storage devices don't allow for fast playing back

% Compression reduces storage requirements

Classification of Techniques

/7

¢+ Lossless: recover the original representation
%+ Lossy: recover a representation similar to the original one
¢+ high compression ratios

¢+ more practical use
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% Hybrid: JPEG, MPEG, px64 combine several approaches

Using Text Elements in a Multimedia Presentation

O The text elements used in multimedia are:
Menus for navigation.

Interactive buttons.

Fields for reading.

Portrait vs. Landscape

HTML documents.

Symbols and icons.

Fonts and Faces

Animating Text

>
>
>
>
>
>
>
>

Menus for Navigation

2nd Speech Center

J File Edit Search Playback Toolz Help Buy Mow

[ORO]eN0]e | m—

samnple] Isamph2| SampESI

|What's znd Speech Center?

| »

Znd Zpeech Center lets vou listen to text instead of reading on
soreen! It uses 'Text to Speech' techhology to syhthesize natural
sounding speech frow ordinary text. Just copy texXt to the cliphoard
or import frow text files and listen as z2nd Speech Center reads it
back to you!

Znd Speech Center also allows you to COnvert text into a MP3/ WAV
audio file so0 wou can listen later. Create MP3 files from vyour
emall, news articles, any text you waht, download to your portable
MP3 player and off wvou go! LI

Interactive Buttons

O A button is a clickable object that executes a /command when activated.

O Users can create their own buttons from bitmaps and graphics.

O The design and labeling of the buttons should be treated as an industrial art project.
Fields for Reading

U Reading a hard copy is easier and faster than reading from the computer screen.
O A document can be printed in one of two orientations - portrait or landscape.
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U The taller-than-wide orientation used for printing documents is called portrait.

U The wider-than-tall orientation that is normal to monitors is called landscape.
Portrait vs. Landscape

« Monitor use wider-than-tall aspect ratios called landscape

» Most books use taller-than- wide orientation, called portrait

* Don’t try to shrink a full page onto a monitor

portrait landscape

HTML Documents

HTML DocumentsHTML stands for Hypertext Markup Language.
It is the standard document format used for Web pages.

HTML documents are marked using tags.

An advanced form of HTML is DHTML.

DHTML stands for Dynamic Hypertext Markup Language.
DHTML uses Cascading Style Sheets (CSS).

O Ooooo0do

Some of the commonly used tags are:
» The <B> tag for making text bold faced.
» The <OL> tag for creating an ordered list.
» The <IMG> tag for inserting images.

Symbols and Icons

U Symbols are concentrated text in the form of stand-alone graphic constructs.
O They are used to convey meaningful messages.

U Symbols used to convey human emotions are called emoticons.

O Icons are symbolic representations of objects and processes.
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Fonts and Faces
« Atypeface is a family of graphic characters that includes many type sizes and styles
(such as Times, Arial, Helvetica)

« Afont is a collection of characters of a single size and style belonging to a typeface
family (such as bold, italic)

» Font sizes are in points 1 point = 1/72 inch
(measured from top to bottom of descenders in capital letter)
« X-height is the height of the lower case letter x
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Character Metrics

o Sert Mean line.
A P { -
| — A ____
I Cap height tHeighl
Ly ATVA O U W VA
Point size Baseline Counter e Sel x| < Descender
. L width : :
Y y Shouider - B
Factors affecting legibility of text
— Size.
— Background and foreground color.
— Style.
— Leading (pronounced “ledding”).
Styles
» Examples of styles are boldface and italic
Italic
Bold
Underlined

Leading and Kerning
Computers can
 adjust the line spacing (called leading)
The space between pairs of letters,
Called kerning

Av Av

Kerned Lnkerned
Fonts and Faces
« PostScript, TrueType and Master fonts can be altered

« Bitmapped fonts cannot be altered
« The computer draws or rasterizes a letter on the screen with pixels or dots.

Serif and Sans Serif
« Type either has a little decoration at the end of the letter - called a serif
* orit doesn’t - sans serif ( “sans” from the French meaning without)
« Examples ( Times - serif “T” )
( Arial - sans serif “T”)
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» Use what is appropriate to convey your message

Animating Text
* To grab a viewer’s attention:
— let text “fly” onto screen
— rotate or spin text, etc.
» Use special effects sparingly or they become boring

Fonts Editing and Design Tools

U Macromedia Fontographer
» Fontographer is a specialized graphics editor.
» It is compatible with both Macintosh and Windows platform.
» It can be used to develop PostScript, TrueType, and bitmapped fonts.
» It can also modify existing typefaces and incorporate PostScript artwork.

ﬁf Fontographer 4.1
File Edit iew Element FEaoints
tdetrics Hints  YWindow Help

B willegha -

Dr.S.ManjuPriya & Mr. K.Yuvaraj, Department of CS, CA & IT, KAHE Page 19\24



Unit-1 MULTIMEDIA TOOLS |2015-Batch

ResEdit
» Introduced by Apple Text to design text as a bitmap image.

P
-

RN
il I

Fazk

U Creating attractive texts.
» Applications that are used to enhance texts and images include:
Adobe Photoshop
TypeStyler
COOL 3D

HotTEXT
TypeCaster

ANANENENEN

Hypermedla and Hypertext

Multimedia - combines text, graphics and audio

 Interactive multimedia - gives user control over what and when content is viewed
(non-linear)

» Hypermedia -provides a structure of linked elements through which user navigates
and interacts

» Hyper media provides a structure of links

« Hypertext words are linked to other elements

« Hypertext is usually searchable by software robots
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Normzaul Text
— —

Hypermedia Structures
= Hypermedia elements are called nodes
= Nodes are connected using links
= A linked point is called an anchor
= Link - connections between conceptual elements (navigation pathways and menus)

Node - contains text, graphics sounds
Anchor - the reference from one document to another document, image, sound or
file on the web

= Link anchor - where you came from

Multimedia and Hypertext

Hypertext system.

Using hypertext systems.

Searching for words.

Hypermedia structures.

Hypertext tools.

Hypertext System

Hypertext is defined as the organized cross-linking of words, images, and other
Web elements.

A system in which words are keyed or indexed to other words is referred to as a
hypertext system.

O A hypertext system enables the user to navigate through text in a non-linear way.

O Oooooooo

Using Hypertext Systems

O Information management and hypertext programs present electronic text, images,
and other elements in a database fashion.

O Software robots visit Web pages and index entire Web sites.

O Hypertext databases make use of proprietary indexing systems.

O Server-based hypertext and database engines are widely available.
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Searching for Words

U Typical methods for word searching in hypermedia systems are (cont):

» Adjacency

v Words occuring next to one another, usually in phrases or proper
names

» Alternates
v" Applying OR

» Association
v" Applying AND

U Typical methods for word searching in hypermedia systems are (continued):
> Negation
v' Applying NOT
» Truncation
v Words with its possible suffixes
» Intermediate words
» Frequency

Hypermedia Structures

O Anchors.
» Anchor is defined as the reference from one document to another document,
image, sound, or file on the Web.
» The source node linked to the anchor is referred to as a link anchor.
» The destination node linked to the anchor is referred to as a link end.

O Navigating hypermedia structures.
» The simplest way to navigate hypermedia structures is via buttons.
» Location markers must be provided to make navigation user-friendly.
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Hypertext Tools

U Two functions common to most hypermedia text management systems are building
(authoring) and reading.
U The functions of ‘builder’ are:
» Creating links.
» ldentifying nodes.
» Generating an index of words.

Dr.S.ManjuPriya & Mr. K.Yuvaraj, Department of CS, CA & IT, KAHE Page 23\24



Unit-1 MULTIMEDIA TOOLS |2015-Batch

NS

NG

Dr.S.ManjuPriya & Mr. K.Yuvaraj, Department of CS, CA & IT, KAHE

POSSIBLE QUESTIONS(8 Marks)

Briefly explain about basic software tools.
Explain Font Editing and Design Tools
Discuss in detail about uses of multimedia and stages of a project.
Explain

a. i) The power of hypermedia (i) Using hypertext

b. (iii) Searching for word (iv) Hypermedia structure
Explain about the stages of project.
Write any two types of basic software tools in multimedia.
Write in detail about multimedia uses with real time examples.
Discuss in detail about hypermedia and hypertext.
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SNo [Questions
The people who weave multimedia into meaningful tapestries are ---------
1
---------- multimedia allows an end user to control what and when the elements are
2 delivered
3 |- is a structure of linked elements through which the user can navigate.
HTML and DHTML Web pages or sites are generally viewed using a
4 | -
Multimedia elements are typically seen together into a project using
T (—
The sum of what gets played back and how it is presented to viewer on a monitor is the -
=S
The hardware and software that govern the limit of what can happen are the multimedia
y 2 P
A browser is used to view ---------
8
9 CD & DVD -----—--mm-- are used for reading and making discs.
PDA stands for ------------
10
11 Cell phones and PDA utilize ---------- communication technology
VR stands for -------------
12
VRML stands for -------------
13
DVD stands for ---------------
14
15  |Macintosh is an operating systems developed by -------------
16 [-----—--—-- file requires no cross platform conversion
Which of the following is not a stage of multimedia production?
17
A family of graphic characters that usually include many type sizes and styles is called
18 a -
19 A e is a collection of characters of a single size
20 Type sizes are usually expressed in -------------
21 One point i§ ---------------- inch
22 [ are general measurements applied to individual characters




I is the spacing between character pairs
24 Which of the following term represent the spacing between characters of the text?
25 The ---------- is the little decoration at the end of the letter stroke
26 Designers call roomy blank areas as ------------------
---------- blends the colors along the edges of the letters to create a soft transition
27 between the letter and its back ground
28 The pages are coded using
29 The taller-than-wide orientation used for printed document is called ----------
30 The wider — than —tall orientation normal to monitors is called-------------
CSS stands for ----------
31
Which of the following is displayed on a web page after installation of a browser plug-
32 in?
WYSIWYG stands for ------------
33
What is ESQ?
34
35  |--—--—-- are connections between conceptual elements
----------- text can be link and can navigate through text in non linear way
36
---------- is a specialized graphics editor for both Macintosh and Windows platform
37
38 |Fontographer is supplied by -----------------
39 Translating or designing multimedia is called ----------
In Macro media’s director, font mapping can be controlled by altering the ----- file.
40
Substituting a font that is not existed on the target is called ------------
41
What is ANSI ?
42
43 Which of the following is not part of multimedia specification
----------- is required to display type 1 post script font at all sizes without jaggies
44
45 Jaggies can be avoided by --------- edges of the text characteristics
46  |Hypercard was first introduced in --------
DHTML uses ---------- to define choices ranging from line height to margin width to
47 font face.
48 Placing an upper case letter in the middle of a word called-----------
49 A file in Macintosh AIF format we get ------------- sound.




Web sites with rich media require large amount of ----------

50
Which of the following is displayable on a web page after installation of a browser plug;
51 in?
At one time, the technology that brought the greatest amount of multimedia to the
52 classroom was the ------
Which H/W platform is considered by many multimedia developers to be better
53 equipped to manage both sound and video editing?
54 Which of the following is multimedia software?
I is searching for a word with any o its possible suffixes
56 [Leading is the space between ------------
--------- is really a method of describing an image in terms of mathematical constructs.
57
-------------- is a powerful OCR program that reads documents on a flatbed scanner &
58 turns them into formatted word processing documents
----------- let you extrude, warp, twist and rotate characters and adjust lighting and
59 texture effects foe high impact 3D titles
60 A smaller version of an image is called a:
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optl opt2
Multimedia producers Multimedia
developers
Hyper media Interactive
Multimedia
Hyper media Multimedia
MS Office Paint
Editing Tools Unauthoring
tools
UML URL
Platform bandwidth
program code story boards

Banners video discs
personal data agency personal data
assistants
GPRS Internet
Virtual reality visual random

virtual reality modeling language

visual response

modeling
language
digital versatile disk digital video
disk
Windows Apple
Digital Apple
Planning and costing designing and
producing
type face font
Attribute font
Font inches
0.0138 0.1038
Kerning tracking




leading kerning
Leading gothic
Serif sans serif
Blending white space
anti — aliasing aliasing
HTTP ASCII
Portrait newsscape
Landscape newsscape

cascading sheet styles

cascading style
sheets

Windows 98

Macromedia
Flash

what you see is what you get

Where you see
is where you

g0

enhanced system quality

enhanced
screen quality

Point node

hyper text linked text

texto-grapher fontographer

Apple IBM

Specialization globalization

FONT MAP .BMP FONT
MAP.JPG

font replacement font
substitution

American national standard institute American
nation standard
institute

Text Odors

Adobe tool manager Adobe type
manager

anti — aliasing editing

1989 2000

CCS CSC

midle cap center cap

Analog digitized




Bandwidth memory
windows 98 macromedia
flash
DVD video tape
Dell Sun
3D Studio SPSS
Association truncation
Alignment words
PostScript Sub Script
OminiPage Pro wipro
Cool 3D HotTEXT
clipart bitmap




opt3 opt4 Answer

Multimedia Multimedia |Multimedia

Projectors Creatures. developers

Non interactive Non Interactive

Multimedia Hypermedia |Multimedia

linked list circular list |Hyper media

Browser Notepad. Browser

Integrated Tools  |Authoring Authoring tools
tools

GUI GPRS GUI

content storyboard Platform

fonts web-based  [web-based pages &
pages & documents
documents

pictures authoring tool|Banners

principle data principle data [personal data

agency assistants assistants

Bluetooth Intranet Bluetooth

Video raster video Virtual reality
response

video raster mode |video raster [virtual reality

language modeling modeling language
language

digital virtual disk

dynamic
versatile disk

digital versatile disk

Microsoft IBM Apple
hexadecimal decimal Apple

Marketing Delivering  |Marketing

point link type face

group link font

no of characters  |points points

0.0318 0.0381 0.0138

character metrics |[type face character metrics




tracking points kerning
tracking trimming tracking
gothic arial Serif

gothic kerning white space
anti — aligning alignment anti — aliasing
HTML FTP HTML
netscape Unicode Portrait

flat file portrait Landscape
cascading spread |cascading cascading style
styles spread sheets |sheets

Photo shop Power builder|Macromedia Flash

when you see is
when you get

what you see
is where you

what you see is what
you get

g0
enhanced software |enhanced enhanced screen
quality screen quality

quantity
link tag link
navigate text document hyper text

text
post script true script fontographer
Macro media Microsoft Macro media
localization serilization |localization
FONT MAP . FONT FONT MAP.TXT
DOC MAP.TXT

font exchange

font — editing

font substitution

Advanced national | Advanced American national
standard institute |nation standard institute
standard
institute
Sound Video Odors
Adobe state Adobe data |Adobe type manager
manager manger
aliasing filtering anti — aliasing
1979 1987 1987
CSS CCS CSS
inter cap joint cap inter cap
hyper media hyperlink digitized




software tools software Bandwidth
packages

mozilla internet macromedia flash
explorer

smart media card [laser disc smart media card

Apple IBM Apple

Tally Inspro 3D Studio

frequency categories truncation

characters lines lines

Adobe’s Script Font script  |PostScript

Adobe Pro Foxpro OminiPage Pro
Both a& b U-lead Both a& b
portable network |thumbnail thumbnail

graphic
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Favorities and recent buttons in the let you
1 quickly access recent files save dialog box
2 The open dialog box offers browsing web
3 The menu has an open recent command View
You can undo a step backwards or redo a step forward
4 from the File menu
5 Command for step backward crtl+alt+z
6 Command for step forward shift+z
7 creates a guide in a designated location view->new
8 The brush palette is attached to the bar menu
Pressing the key hides all palettes except the tool
9 palette and options bar Tab
10 Descriptive labels are called tool box




The in the tool palette contains the icon,name and

11 shortcut key File menu
When you click a tool,its options appear at the of
12 the screen left
dims the portion of the image outside the
13 Crop marquee shield cropped area
The provides a method of quickly drawing
14  |vector shapes crop tool
The let you to attach written or audio notes to
15 your document crop tool
The are used to cut an image into smaller
16 component slice select tool
option lets you bend and flex type into
17 large variety of shapes text
is the method of organizing your documents
18 into accessible dynamic components layer
To name a layer ,press and double click the
19 layer to display the layer properties dialog box option/ctrl
Blending and advanced blending options have been
20 included in the dialog box blending
TIFF refers to
Text-Image File
21 Format
GIF refers to Graphical
Interchange Format
22
JPEG refers to
23 J-P Expert Group
PNG refers to
24 Ping Net Graphics




25 Photoshop keeps track of all your edits in the palette. [Family Tree
The new to select & modify shapes & paths. [crop tool
26
The new let you attach written or audio notes to
zoom tool
57 your document for later reference.
support the selection of slices created n
— save for web
photoshop6.
28
The fills similarly colored areas with the
29 foreground color. Paint Bucket tool
If you change your mind you can click the Undo command
30 Or you can press CTRL+Z
The Letter used as shortcuts for Lasso Tool Q
31
The Letter used as shortcuts for Switch background / X
forground colors Tool
32
Open recent
33 The file menu has an command
34 An annotation tool has brash tool
35 tools is used to cut an image slice tools
36 To create a new document edit-->view-->new
file-->export-->path
37 Where will you choose path illustrator. to illustrator
38 consists of all the photoshop available options toolbox




39 has various tools for editing the image palettes
40 palettes displays the names of its colors swatches
MPEG stands for Moving picture
Expert Group
41
application is used for viewing and
converting still images among many standard image-file Viewer
42 formats.
schemes preserve the original data precisely.  |Lossy
43
indicates the URL to link to when the
TRT REF
movie is clicked.
44
The Zoom tool is represented in the Toolbox by a Magnifying
glass
45
The layer shows a small image of the contents
46 of the image thumbnail
The Letter used as shortcuts for Switch background / X
forground colors Tool
47
48 Shortcut key for select all alt+a
49 Shortcut key for deselect alt+d
50 Shortcut key for reselect shift+ctrl+d
51 Shortcut for painting brush is \%
tool is used to copy an ares of the image and paint it
52 elsewhere with a brush. brash tool




53 brush restore a portion of the image. Painting tool
Contains numerous options for setting brush

painting characteristics, such as color dynamics, brush shape
54 dynamics, texture, and paint scattering. Tool Presets picker

In the color model HSB refers to High, Saturation,

and Brightness

55

The Letter used as shortcuts for Marquee Tool Q
56

The Letter used as shortcuts for Lasso Tool Q
57

tool enables to select a foreground and

background color in any of several ways
58 painting

If you change your mind you can click the Undo command
59 Or you can press CTRL+Z

is the artists term for trimming away unwanted |crop

parts of a picture
60
61 lets you lighten image areas Dodge
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opt2 opt3 opt4 Answer
open dialog box tool dialog box Edit dialog box [open dialog box

windows applications |[thumbnail web application [thumbnail
Edit open File File

View menu Edit menu Tool menu Edit menu
Alt+z Crtl+z shift+ctrl+z crtl+alt+z
ctrl+z alt+z ctrl+shift+z ctri+z
file->new edit->new insert->new view->new
status tool option option
Shift Shift-+tab ctrl Shift+tab
view tips tool tip file tip tool tip




view menu tool menu edit menu tool menu

right top bottom top

cropped shield area  [shield area crop area shield cropped area
annotation tool slice tool shape tool shape tool
annotation tool slice tool shape tool annotation tool

slice tool slice select tool and slice tool |crop tool slice select tool and slice tool
wrap wrap text text wrap wrap text

tool text pattern layer

option/alt shift/alt ctrl/shift option/alt

style layer layer style layer style

Title-Image File Tagged-Image File Format  |Table-Image Tagged-Image File Format
Format File Format

Geometrical Gamma Interchange Format |Geological Graphical Interchange
Interchange Format Image Format |Format

Jagged Photographic |Joint Photographic Expert H-P Joint Photographic Expert
Expert Group Group Photographic  (Group
Expert Group
Part Net Graphics Pass Network Graphics Portable Portable Network Graphics
Network

Graphics




Edits

Marquee

History

History

zoom tool

navigator tool

path component
selection tool

path component selection
tool

navigator tool annotation tool crop tool annotation tool
save for file zoom tool crop tool save for web
Art History brush tool |History Brush tool gradient tools

Paint Bucket tool
CTRL+A CTRL+U CTRL+F

CTRL+Z
L A M L
Z I G X
images windows palettes Open recent command
Notes tool Painting tool selection tools |Notes tool

Audio

brash tool selection tools annotation tool |[slice tools
edit-->new file-->new image-->new [file-->new

image->export--

edit-->export-->path |view-->export-->path to >path to file-->export-->path to
to illustrator illustrator illustrator illustrator
palettes interface menubar menubar




toolbox menubar interface toolbox
info layers history swatches
Movie Picture Expert Music Pic Expert Group Media Picture |Moving picture Expert
Group Expert Group |Group
Editor Convertor Picture Viewer |Picture Viewer
Lossless decompression Transferring Lossless
Click HREF URL HREF
diminishing zooming alternative Magnifying
mask list Icons
thumbnail

Z I G X
shift+a ctyl+a tab+a ctyl+a
shift+d ctrl+d tab+d ctrl+d
shift+alt+d alt+ctrl+d shift+del+d shift+ctrl+d

p b t b
editing tool Painting tool history tool clone stamp tool




history brush brash tool editing tool history brush

Brush Presets picker Brushes palette |Brushes palette
Paint
Hue, Saturation, and |Heavy, Saturation, and Hitech, Hue, Saturation, and
Brightness Brightness Saturation, and |Brightness

Brightness
L A M M
L A M L
brushes history color picker color picker
CTRL+A CTRL+U CTRL+F
CTRLAZ

Single column Magic Wand Magnetic Lasso |crop
marquee
crop magic wand

slice Dodge




Displaying the Images 2015-Batch

UNIT-I11
SYLLABUS

Displaying the Images - Using Ruler, Guides and Grids — Making Selections- Layers and
Types-Choosing Colors-Creating Brushes- painting & editing Tools- Making and Applying
Gradients.

DISPLAYING THE IMAGE

i) The Zoom Tool

Choose the Zoom tool from Tool palette. Place your cursor on the area of the image.
you will see the Zoom tool cursor with a plus sign indicate the Zoom tool with enlarge the view
.The image appear larger to maximum view size of 1600 percent.

if) Scrolling in Photoshop
The Hand Tool: choose the Hand tool .click the image and drag to move the image.
Scroll Bar: Click and Drag scroll Handle or click an arrow at end of the scroll bar.
Keyboard : you can use the keyboard to scroll the image up ,down, left, or right.

Keyboard commands for scrolling

Scroll Action Mac KB Mac Extended KB Windows KB
Up Control+K PgUp PgUp

Up Slightly Shift+Control+K Shift+PgUp Shift+PgUp
Down Control+L PgDn PgDn

Down Slightly Shift+Control+L Shift+PgDn Shift+PgDn

Left Cmd+Control+K Cmd+Control+PgUp Ctrl+PgUp

Left Slightly  Shift+Cmd+Ctrl+K Shift+Cmd+Ctrl+PgUp Shift+Ctrl+PgUp
Right Cmd+Control+K Cmd+Control+PgDn Ctrl+PgDn

Right Slightly  Shift+Cmd+Control+L Shift+Cmd+Control+PgDn  Shift+Ctrl+PgDn

iii) Navigation shortcuts
Centering the image: This technique centers and zoom and area of image on the screen.
Restoring the display to a 100 % view: Double click the Zoom tool icon in the tool palette
Toggling to the Zoom tool:
eHold down the command or ctrl key and space bar and click the mouse to zoom
in.
eHold down the option or alt key and space bar and click the mouse to zoom out.
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Toggling to the Hand tool:

The hand tool lets you scroll around the image when it exceeds the size of the image
window.

iv) The Navigator

The navigator is map of the image displayed as thumbnails showing the exact location of what
appears in the image window relative to the entire image. Navigational features are,

View box:

The red rectangle on the thumbnail indicates what is currently displayed in the image window
.you can choose a color from pull down menu or click the swatch to choose a color from the
color picker.

Zoom slider:

You can Zoom in on the image by moving the slider to the right , or zoom out by moving the
slider to the left.

Zoom in & Zoom out buttons:

The button with the small mountains on the left of the slider zooms out, and the button
with the large mountain to the right of the slider zooms in. The buttons use the same predefined
increments as the Zoom tool.

Magnification Box

At the bottom-left of the Navigator palette, you can enter a specific percentage at which
to view your image.

Sizing the Navigate Palette

You drag the lower-right corner of the Navigator box to increase or decrease the size of
the Navigator palette and its image thumbnail.

V) The View Menu

For example, the View—>Zoom In command achieves the same result as the keyboard
shortcut Command /Ctrl + plus sign; The Zoom Out command is the same as typing

Command/ctrl+minus sign. These techniques are identical to the Zoom tool and ,of course, all of

Dr.S.ManjuPriya & Mr. K.Yuvaraj, Department of CS, CA & IT, KAHE 2/41




Displaying the Images 2015-Batch

these commands are similar to the function of the Navigator and the magnification box, slide
variations.

The other options in the View menu are
Fit on screen displays the image at the maximum horizontal or vertical size the monitor screen
will accommodate.
Actual Pixels displays the image in a 1:1 ratio with the monitor’s screen resolution.
Print Size accurately displays the height and width dimensions of the image.
New View the View->New View command displays multiple windows of the same document.
Multiple windows give you the ability to observe two or more views of your image
simultaneously, so that you can see the close-up detail in which you are working and the global
effect on the entire image. When you edit the image, you will see the changes on both views.

vi) Display Modes

Three icons on the Tool palette determine how the image is seen on screen. These modes
act like electronic mats. There are three options:

Standard Background The default view displays the image up against the operating
system’s desktop.

Full Screen with Menu bar The image takes up almost the entire surface of the monitor
screen and displays menu bars across the top. When you zoom to a smaller display size, the
image appears centered against a great background.

Full Screen The image takes up the entire surface of the monitor screen. When you zoom

to the smaller display size, the image appears centered against a black background.

USING RULERS, GUIDES, AND GRIDS
Rulers, guiders and grids are used to align image content. Alignment of visual elements is

critical to maintaining a cohesive structure to the composition. A good composition gently guides
the viewer’s eye across its surface so that important elements are emphasized. Rulers, guiders,
and grids are also used to assure the precision measurement and placement of image
components.

i) Setting Preferences for Rulers and Guides
Photoshop can display a horizontal ruler across the top of the screen and vertical ruler

along the left side of the screen; to display them, choose View—->Show Rulers. Rulers give you a
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visual remainder of the physical size of your image, which you may forget from time to time as
you zoom in or out. Ruler units can be changed by choosing Edit—>Preferences—> Units &Rulers.

The zero point or point of origin for all measurements is in the upper-left corner of the
image, where the ruler intersects. The point of origin can be changed by lacing your cursor on
the cross hairs, clicking and dragging down and to the right, positioning to the desire location,
and releasing the mouse.

Graphic designers use grids and guides to align element within a layout. Aligning visual
elements creates a composition structure, which helps to control the view’s eye. The importance
of good composition in a Photoshop document can’t be stressed enough. The View menu
contains the commands that let you create guides and display a grid which are superimposed
over the image to help you align elements within the composition. Neither guides nor grids print.
The color and properties of guides or grids can be changed by choosing
Edit—>Preference>Guides &Grids.

ii) Using Guides
Guides are horizontal or vertical lines that can be positioned anywhere on the image’s

surface. To create a horizontal or vertical guide, choose View—>Show Rulers. Place your cursor
on the ruler, click your mouse, and drag down or to the right, releasing the mouse wherever you

want to place a guide.

Display or Conceal Guides
You can hide or reveal guides. The operation is under the new Show of command in

version 6. Choose View—->Show->Guides toggle them on and off; if the option is checked,
they’ll be visible, and if it’s and checked they’ll be hidden.

Snap To Guides
When moving a portion of a layer is a selected area of the image, you can snap it to a

guide to assure the accuracy of its position. The operation is under the new Snap to command in
version 6. Choose View->Snap To->Guides to the toggle snapping on and off.

Move a Guide
With the Move tool currently selected, click the guide and drag. If another tool is

selected, Command-click(Mac)or the ctrl-click(Win)the guide and drag.

Delete a Guide
Select the guide as if you were going to move it and drag it out of the image window.
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Delete All Guides
Choose View->Clear Guides.
Lock a Guide
Choose View->Lock Guides. This prevents accidentally moving a guide while you work

New Guide

Another method of generating a new guide is to Choose View—>New Guide. This has the
advantage of enabling you to enter a value for the guide’s exact location. A dialog box appears
where you can determine whether the guide is horizontal or vertical.
Change the Orientation of a Guide

You can change a guide from horizontal to vertical or vertical to horizontal. While in the
Move tool, place your cursor on the Guide. Hold down the Option key( Mac)or the Alt
key(Win)and click the guide.
Change Guide Characteristics

The color and style of your guides can be modified by choosing Edit—>Preferences
Guides &Grid. Choose a color from the pull-down menu, or click the swatch to display the Color

Picker. From the Style pull-down menu, choose either a dashed or solid line.

iii) Using a Grid
A grid helps you see the global relationships between aligned elements on a page. A grid
is a series of equally spaced horizontal and vertical lines that creates a virtual matrix. Like

guides, grids do not print.

Display or Conceal the Grid Choose View—>Show-> Grid.

Snap To Grid When moving a portion of a layer or a selected area of the image, you can snap it
to a horizontal or vertical grid line. The operation is under the new Snap To command in version
6. Choose View Snap To—->Grid.

Grid Characteristics The color and style of the grid can be modified by choosing

Edit—>Preferences> Guides &Grids. Choose a grid color from pull-down menu, or click the
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swatch to display the Color Picker. From the Style pull-down menu, Choose either a dashed line,
a solid line, are dots. You can also change 5the grid size by entering values in the Gridline and
Subdivisions boxes.

Making Selections

The Power of Masking

Making or the process of protecting portions of an image, used to be an entirely manual
process.

Photoshop’s selection tools are similar in principle, but quite difference in application to
the traditional mask. Masking techniques in Photoshop 6 afford even more control and are even
more user friendly than in previous version. The selection tools range from purely manual, like
the Lasso, to semi manual, likely marquee, to semi automatic, likely magnetic Lasso, to fully
automatic, like the magic wand. Each selection tool is designed to hasten the masking process,
developing on the characteristics of the image.

There are many situations were one selection tool is insufficient and several must be
combined to surround the target area. Often, other selection techniques will be employed in

combination with tools for grated accuracy or to isolate a tricky area.

Using Selection Tools

When you make a selection in Photoshop, an animated marquee defines the boundaries of
the selected area. This moving dash lined border is sometimes referred to as the “Marching ants”
because of its resemblance to a column of tiny insects on the move.

There are Photoshop’s selection tool are located at the top of the tool palette. When you
press and hold the mouse on the rectangular marquee tool, the palette expanse to reveal three
additional tools. When you expand the Lasso tool, two more tools are revealed, for a total of

eight different selection tools.
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1) The Selection Tool Options Bar

Photoshop 6’s Options bar replaces the tool options palettes of prior versions. Choosing a
tool displays its options automatically in the Options bar. Each tools has specific options, but
some options are universal to all of the selection tools.

When you choose a selection tool, the icon that represents it appears on the left end of
the options bar. The next four icons represent selection option that in format version were
performed only by key commands.

*New Selection Click this button to create a new selection with the chosen selection tool.

*Add To Selection Click this button to add to an existing selection with the chosen
selection tool. You can perform the same function by holding down the shift key as you drag
with the selection tool.

*Subtract From Selection Click this button to omit from an existing selection with the
chosen selection tool. You can perform the same function by holding down the option or alt key
as you drag with the selection tool.

*Intersect Selection After the first selection is made, you draw another selection that
overlaps it. Photoshop makes the selection from only the overlapping area of the two selections.
You can perform the same operation by pressing shift+options or shift + alt as you use the
second selection tool.

*Feather Prior to drawing a selection, you can program a tool to produce a soft edged
selection by specifying a numerical value in the feather field in the tools Option’s bar.

Feathering creates a gradual transition between in inside and the outside of the border.
When u apply an effect tool a feathered selection, it diminishes and becomes more transparent,
producing a softening of blurring effect.

When you choose select->Feather, a dialog box appears; Enter the value for a feather
Radius, The Feather Radius extends the specified humber of pixels into the selection outline and
outside the selection border.

A feather differs from anti-alias in that you can determine the size of the soft edge in
pixels that the marquee will affect. The width of an anti-alias is determined by the resolution of
the image; you have no control over its size.

When you apply a feather to an existing selection border, sometimes you will see it

decrease in size or slightly change shape.
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*Anti-Aliased An anti-alias is a two-or three-pixel border around an edge that blends
into the adjacent color to create a small transition zone. It is intended to simulate depth of field in
a photograph. Without the anti-alias, an image would look “aliased” stair-stepped, without

smooth transitions between colors

i1) Shapes Selection Tools

The Rectangular Marquee tool and its fly-out, the Elliptical Marquee tool, are useful
when you need to select a fairly standard shape within your image-a rectangle, square, circle, or
ellipse.

From the Tool palette (but for some reason not included in the Shift+M key short-but
when you cycle through them), you have more options for these”predefined” selections: the
Single Column Marquee and the Single Row Marquee.

Rectangular Marquee

The Rectangular Marquee tool is used to select rectangular or square portion of the
image. Click the image and dragging any direction to select rectangular area of the image.

The Style menu in the Marquee tools’ Options bar enables you to choose from three
methods for sizing the Rectangular and Elliptical Marquees.

*Normal By choosing Normal, you determine the size and proportion of the marquee by
dragging.

*Constrained Aspect Ratio Enter numerical values for the proportion of the marquee in
the Height and Width fields.

*Fixed Size The size of the marquee is determined by the values in pixels, that to enter in
the Height and Width fields. The marquee size is defined by pixels because it can’t select

anything smaller.
Elliptical Marquee
Use this tool to create ellipses or circle. Its performance is identical to the Rectangular

Marquee: Click and drag in any direction to produce and elliptical or circle selection.

Single Column Marquee
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The Single Column Marquee tool selects a single vertical column or pixels. Click any-
where in the image, and a selection marquee appears around single column of adjacent pixels
that runs vertically across the entire image.

One way you can use this feature used to create stripes that can later the colorizes to
produce wood-grain effects. Here’s how:

1. Open an RGB document with a white background.

2. Select a single column of pixels.

3. Choose Filter->Noise-> Add Noise—=>400, and click OK,

4. Choose Edit-> Transform—>Scale. Drag the center handle of the left or
right edge to the left or right.

5. Press the Return/Enter key to initiate the transformation (or the Esc key
to cancel).
Single Row Marquee

The Single Row Marquee tools select a single horizontal row of pixels. Click enters on
the image, and a selection marquee appears around single, continuous row of adjacent pixels that

runs horizontally across the entire image.

iii) Free-Form Selection Tools

Photoshop offers three main ways to make irregular-shaped selections. The Lasso tool
(and its fly-outs, the Polygonal Lasso and Magnetic Lasso)draw selection based on your mouse
movements, in varying degrees of freedom. Cycle through these tools by pressing Shift+L.

The Magic Wand tool (shortcut key Shift +W) allows you to select without regard for

position, instead based on the brightness of the pixels in your image.

Lasso
The Lasso tool draws free-form selections. Click the edge of the area you want select and
drag the tool surround the area with the selection border. Close the marquee by placing the

cursor on the starting point are release the mouse to close the selection with a straight line.

Polygonal Lasso
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The Polygonal Lasso tool is used to create straight —edged selection borders. Click and
release mouse. Reposition the mouse to the next corner of the polygon, and click and release
again. Repeat the process until the area is surrounded. Close the marquee by clicking the starting

point again.

Magnetic Lasso
The Magnetic Lasso tool intuitively makes selections based on the contrast values of
pixels. As you click and drag, the Magnetic Lasso deposits a path that is attracted to areas of the
most contrast. When the mouse is released, the path becomes a selection.
The tool as 3 settings in the Options bar that affect is behavior:
*Width (in pixels)This setting determine the distance from the path of mouse
within which pixels will be evaluated for contrast by the Magnetic Lasso.
*Edge Contrast This is the minimum percentage of pixel contrast that the
Magnetic Lasso will be attracted to. The higher the number, the smaller the range of contrast,
hence the more selective the tool will be.
*Frequency Enter the value for the frequency with which points are
automatically deposited. The points create segments along the path that fix the previous

segments and better control its behavior.

Magic Wand

The Magic Wand tools select the areas of an image that are similar in brightness. To use
the Magic Wand, place your cursor on the area to be selected and click your mouse. Adjacent
pixels of similar color will be included in the selection.

You can affect the range of pixels that are selected by adjusting the Tolerance in the
tool’s Options bar. Higher Tolerance values include in the selection more pixel of grater color
and brightness range. Lower values include fewer pixels in the selection.

Other values in the Options bar enhance your ability to control the operation of the Magic
Wand tool:
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*Contiguous By default, the Contiguous box is checked, which limits the
selection to adjacent pixels. Uncheck this box to select all the pixels in the image with in the
same Tolerance range.

*Use All Layers If this box is unchecked, you will limit the selection to only
pixels within the same Tolerance range on the same layer.

Applying Selection Techniques

There are several ways to modify a selection outline; among them, you can conceal it,
transform it, add to it, subtract from it, soften its edges, and eliminate it. These commands are
important because they facilitate the process of masking.

i) The Select Menu

Some selection adjustment can be automatically applied by accessing them from the
Select menu or applying a shortcut key command.

*Select All (Cmd + A on Macintosh, Ctrl+A in Windows) This command selects the
entire content of an image or a targeted layer.

*Deselect(Cmd/Ctrl+D) Use Select->Deselect to deactivate the selection. Another
method is to click off the selection, anywhere on the image.

*Reselect(Shift + Cmd/Ctrl+D) Choose this command to reactivate the last deselected
selection border.

*Inverse(Shift+Cmd/Ctrl+I) To deselect the selected portion of the image and select the
masked portion, choose Select = Inverse. This technique can save time when an image has been
photographed on a single color background. The background can be selected quickly with the
Magic Wand and inverted to select desired content.

*Hide Edges (Cmd /Ctrl+H) Use Select->Hide Edge to conceal and reveal the marching
ants from view whiled selection remains active. This command is useful to be able to see
changes to the image without the distracting selection border.

*Feather After you’ve made a selection, you can soften its edges by applying a feather

radius to it.
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*Modify Once a selection has been made, you can alter its dimensions by choosing one
of the Select->Modify sub commands. Each command changes the selection marquee and alters
its dimensions:

=> Border frames a selection and deselects the inside area of the outline,
producing a selected “border” of specific thickness. When you choose Select>Modify—> Border,
you are presented with a window. To determine the thickness of the border by entering a value in
pixels into the Width field.

=>»Smooth round sharp corners of a selection, eliminating protrusions and stair-
stepped areas of the selection border. When you choose Select->Modify->Smooth, you are
asked to put in a Sample Radius value. Enter the large values to increase the effect.

=>Expand and Contract both perform in the same way to enlarge are reduce the
size of the selection by a specified number of pixels. This command is quite useful for trimming
off stubborn, unwanted edge pixels. Choose Select->Modify—>Expand or Contract. And enter
the value between 1 &16 pixels. Click OK to implement the operation.

*Grow The value entered in the Tolerance field of the Magic Wand’s Options bar
determines how much selection will grow. When you choose Select->Grow, the select marquee
expands to include adjacent pixel that are lighter or darker by no more then the Tolerance range.

* Similar In order to use this operation, a selection must be activated. When you choose
Select->Similar, Photoshop select all pixels within the image that are the same colors as the
pixels within the selected area.

ii) Transforming a Selection

Once you have made a selection, you may want to alert it safe before applying
one of Photoshop’s many powerful operations to its content. Photoshop gives you the ability to
scale, rotate, or move a selection border. To transform a selection, choose Select—>Transform
Selection. The Rectangular transformation box appears around the selection border. You can
then transform the size, angle, or position of the selection border with the following procedures:

*Move To move the selection, place your cursor within the rectangular
transformation box; the Move cursor appears. Press your mouse button and drag the selection

into position, then release the mouse.
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*Scale To scale a selection border, place your cursor on one of the square handles
on the corners or sides are the box. The Scale cursor appears. Press your mouse button and drag.
To constraint the selection border to its current position, press your Shift key while dragging.

*Rotate To rotate a selection, place your cursor outside the box. The Rotate
cursor appears. Press your mouse button and drag to rotate the selection.

After you have chosen Select>Transform Selection and the
transformation box is displayed, you can also apply many more transformation to the selection
by choosing Edit->Transform. A list of options appears, including Skew, Distort, Perspective,
and various precise Rotate commands. The Flip Horizontal or Flip Vertical commands will

mirror the marquee across a horizontal or vertical axis passing through its point of origin icon.

iii) Other Selection Techniques
Once selection has been made, you can reposition the marquee with or without its contents

using the following techniques:

Move Selection Outline
While in any selection tool, click inside the marquee and drag. When you've
relocated the outline, release the mouse.
Nudge Selection Outline
While in any selection tool, press the right, left, up, or down arrow keys to move the
selection name increments of one pixel. Press the shift key plus any of the arrow key to move the
selection outline ten pixels at a time.
Move Selection Content
Choose the move tool; click inside the marquee and drag. When you have relocated the
marquee, release the mouse. You can also move the contents while in any selection tool:
Cmd_click or Ctrl_click inside the marquee and drag. When you've relocated the selection,

Release the mouse and then the key.

Nudge Selection Contents
You can nudge the selection content in one pixel increment: With the move to active

press the right, left, up, or down arrow keys press the shift key plus any of the arrow key to
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move the selection outline ten pixels at a time.
Duplicate Selection Contents
Position the cursor inside the marquee, hold down the option+command (Mac)or

alt+ctrl(Win) while you click and drag.(Or get the move tool and hold down option or alt while

you drag.)When you have relocated the copy to the desired position, release the mouse.

Layers and Types
Getting Started

Once you have launched Photoshop with default preferences, here’s how to begin the

Hands-On project:
1. Insert the Mastering Photoshop6 CD in the CD ROM drive.

2. Choose File->Open; Select and open Flying_Women_start.psd in the Ch08

folder on the CD.
3. Save the file to your disk us Flying_Women.psd

Arranging Layers

Viewing Layers

1. When you open the file Flying_Women_start.psd, you see only the

transparency checkerboard. The Layers Palette, however, reveals that the

image contents 2 layer sets (containing two layers each),8 additional layers,

and a Background. To reveal the contents of the Background , click the 1%

column next to its thumbnail. An eye icon appears, and the Background image

appears in the image window

2. Reveal the contents of all layers. Option-click or Alt-click the eye icon of the

Background, The two layer, set folder are closed, are closed, but their content

are visible in the image window.

3. Then conceal the layers that we don’t need right now. click the eye icon next

to the following layer sets to conceal their content:Purpul,Layerl,Layer2,Bule.

Moving Layers
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The contents of layers can be repositioned. We will move the planets into their vertical

and horizontal positions on the image.

1.
2.
3.

5.

Be sure the rulers are visible (choose View—>Show Ruler if they’re not).
Target the Mars layer by clicking its thumbnail or its name.

Select the Move tool. Place your cursor in the approximate center of Mars,
click, and drag until Mars aligns with the 12”vertical and 8 horizontal marks
on the rulers. Release the mouse

Target the Jupiter layer. Using the same technique, place the center of Jupiter
on the 2”vertical and the 8 horizontal ruler marks

Save your work (press Cmd/Ctrl+S or use File ->Save).

Moving Linked Layers

When items or linked, the can be moved or transformed simultaneously.

1.
2.
3.

Target the Saturn layer.
Click in the second column next to the Rings layer. The link icon appears.
With the Move tool. Drag and place the center of Saturn and its rings at the

7.25” vertical and 3”horizontal marks. Check your image against.

Naming Layers

To keep your document organized, name your layers.

1. Display Layer 1 and 2; target Layer 1. From the Layer palette pull-
down menu, choose Layer Properties. The Layer Properties dialog box
appears.

2. Name the layer Yellow Women.

3. Press the Option or Alt key and double —click Layer 2 to get the Layer
Properties dialog again.

4. Rename Layer 2 as Yellow Costume.

Making a Layer Set

Layer sets organize your layers so that they can be easily managed.
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. Target the Yellow Women layer. Click the Create A New Set icon on

the Layers palette. A new layer set folder appears above the targeted
layer.

Double-click the layer set. The Layer Set dialog box appears. Rename
the layer set Yellow. For Color, choose yellow.

Click the Yellow Costume layer and drag it on top of the Yellow layer
set icon. The layer becomes part of the set.

Drag the Yellow Woman layer on top of the Yellow layer set. Notice
that the layers inside the folder have been automatically color-coded

yellow.

. Save your work.

Moving Items Within a Layer Set

The costume is not on the yellow woman. She might be getting cold, flying around in

deep space in her underwear. We need to dress her. You can reposition the contents of a

layer and change its stacking order within the layer set.

1.

Target the Yellow Costume layer, choose the Move tool, and drag the
yellow costume onto the yellow woman.

The costume is behind the yellow woman. In the Layer palette, drag the
Yellow Costume layer above the Yellow Woman layer within the layer
set.

With the Move tool, on the image window, reposition costume so that it

aligns with the yellow woman.

Changing the Order of Layers

You can change the position in the stacking order of a layer or of a group of a layers in a

layer set. Use the order, from top to bottom in the Layers palette, to control which content

lays” on top of” other image elements. Note that you can restack all of the layersO within

a set simultaneously-no other does this.
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1. Option-click or Alt-click the 1st column of Layers palette to make the content

of all layers visible. Notice that the Blue Woman is behind Mars.

2. To bring all the layers in the layer set forward, they must be moved up in the
stacking order. Place your cursor on the Blue layer set floder or name. Click and drag the
layer set to the top of the stack. The women and her costume appear in front of Mars.

Using Layers to Create and Edit
Cutting and Copying Images to a New Layer
New layers can be made from the contents of existing layers. This can make it
easier to apply effects to specific pieces of your image.
1. Target the Uranus layer.
2. Option-click or Alt-click the eye icon of the Uranus layer to reveal only its
contents against a transparent checkerboard.
3. Choose the Rectangular Marquee. Draw a marquee around the blue planet.
4. Choose Layer->New Via Copy or Press Cmd/Ctrl+J. The selected planet is
copied onto a new layer. Name the layer Galaxy.
5. Target the Uranus layer again. Draw a rectangular marquee around the green
planet.
6. Choose Layer->New Via Cut or press Shift+Cmd/Ctrl+J. The selected planet

is cut to a new layer. Name the Layer Mercury.

Editing the Contents of a Layer
1. Target the Galaxy layer
2. Option/Alt-click the eye icon of the Galaxy layer to reveal only its content
against a transparent checkerboard.
3. Choose the Move tool. In the Option bar, choose Show Bounding Box.
4. Click the top-middle handle of the bounding box and drag downward to
squash the circular planet into an oval. Press Return(Mac)or Enter (Win) to

implement the transformation.
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5. Choose Filter>Blur->Gaussian Blur->10 to blur the edges of the oval.

6. Draw a Rectangular Marquee around the oval.

7. Choose Filter->Distort->Twirl, and set a value of -999 to twirl the oval into a
galaxy.

8. Press Cmd/Ctrl+D to deselect.

9. With the Galaxy layer still targeted, choose the Move tool and drag the galaxy
into the upper-left corner of the document so that its approximate center aligns
with the 1”vertical and 2” horizontal marks on the rulers.

10. View and target the Mercury layer. Press the Shift key as you drag Mercury to
constraint its horizontal movement; reposition the planet so that its center
aligns with the 6.5” vertical and 8.75”horizontal marks on the rulers.

11. View and target Uranus layer. Move Uranus so that its center aligns with the
14” vertical, 2.25’horizontal marks on the rulers.

12. Save the Document.

Moving layers From Another Document
You can easily move layers from one document to another .Here we will move
two linked layers.

1. In the Flying_Woman.psd file, click the eye icon next to the
Background and the Saturn and Ring layers to make them
visible. Target the Saturn layer.

2. Open the file Red_Woman.psd from the Chapter 8 folder on the
CD, and target the Red Costume layer.

3. In Red_Woman.psd, click in the second column next to the Red
Women layer to link it with Red Costume.

4. Place your cursor on the Red_women.psd image. Press your
mouse, drag the image ,and place it on the Flying_ Woman.psd
document. Release the mouse and a new layer appears between
the Saturn layer and the Ring layer.

5. Choose the Move tool and position the Red Woman and the Red

Costume between Saturn and its rings.
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There are 3 Different ways to drag layer and place them on another image. Make
sure you use the right one:

e You candrag and individual layer from the Layers
palette or from the image window to another image.

e Todrag linked layers and maintain the linked
relationship, you must target one of them and drag from
the image window.

e Todrag a layer set from an image, drag from the name
or folder of the layer set in the Layer palette.

Apply a Style To a Layer
A drop shadow adds realism and depth to an image. Creating the drop shadow as
a layer style is easy.
1. With the Red Woman layer targeted, double-click the layer to bring up
the Layer Style dialog box.
2. Click the Drop Shadow option to display its control.
3. Set the following specifications, then Click OK.
Opacity=>63%
Distance=>»13 px
Spread=>»10%
Size=>»5 px

Entering Type
Photoshop 6’s Type tool is powerful for producing sophisticated text effects. Combined with
Photoshop’s layer styles, the graphic possibilities are endless.
1. Display all of the layers in the document by pressing the Option /Alt key and clicking the
eye icon next to the background.
2. Choose the Type tool and enter the following specification in the Options bar:
Font Helvetica
Size 100 pt
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Anti-Alias ~ Smooth
Alignment  Centered
Color Red

3. Display the character palette (Window ->Character, or click the palettes button on the
option bar); in the palette set leading at 100 pt.

4. Click the image, somewhere between the galaxy and Saturn. (if necessary, you can
reposition the type after you've entered it.) You see a blinking insertion point. Type this:
amazing <return>flying women. When you're finished typing, click the check mark on
the option bar. This will create a new typing layer named amazing flying women.

5. Change the settings on the option bar to font: Helvetica Bold, Size: 45, and color: yellow.
Form the character palette pull_down menu, choose all caps.

6. Type the words: form outer space. Click the check mark in the option bar to create a new

type layer. You text should resemble.

i) Warping Text
Photoshop6 lets you bend and twist type to any shape.
1. Target the amazing Flying Women layer and choose the text tool
2. Click the create warped text button in the option bar.
3. Choose style -> flag.
4. Enter the following values and click ok.
Bend 50%
Horizontal distortion -34%
Vertical distorting 0%
5. Target the from outer space layer.
6. From the style list, again choose flag.
7. Enter the following values and click ok.
Bend 66%
Horizontal distortion -24%
Vertical distorting 0%

8. In the layers palette, adjust the opacity of from outer space layer to 55% your text
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should now look like.

i1) Applying Multiple Effects To Layer

We've seen how you can apply a drop shadow layer style to a layer. We 'll now apply
several difference effects to a type layer.

1. Target the Amazing Flying Women layer.

2. Double click the layer to display the layer style dialog box.

3. From the style list on the left, click the name inner shadow. The check box is

automatically checked, and the inner shadow controls are displayed.

4. set the following specification (use the default values for settings that aren't listed

here):
Angle 63
Distance 8px
Choke 0%
size 5px

5. Click the bevel and emboss style. Set the following specification(Use the default for
the remaining options):
Style outer bevel

Techniques  smooth

Depth 201%
Direction up
Size 5px
Soften 5px

6. Click the satin style.
7. Click the color overlay style.

8. Click the strike style. set the color to yellow, and use the default for the other settings.

Adjusting Opacity of A Layer Set
Now that all of the poster elements are in place, You can subdue the color of the planets
so the flying women stand out more.

1. Link all of the planet layers except Saturn and rings. That includes Jupiter, Mars,
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Uranus, Mercury, and Galaxy.

2. Make a new layer set by choosing, from the layer palette pull_down menu, new set
from linked.

3. Name the layer set the planets.

4. In the layer palette, adjust the opacity of the planets layer set to 75%.

Merging Layers

IN order to reduce the file size and more efficiently manage your document, you can
merge layers.

1. Click off the eye Icons next to all the layers but the blue, purple, and yellow layer sets.

Target one of the layer sets.

2. Choose merge visible from the layers palette pull-down menu. The content of all three

of the layers sets is merged into one layer. (Name that layer purple). Notice the reduction

in the file size in the information field in the lower-Left corner of the image window.

3. Choose image -> duplicate. Name the new image Flying_Women_Flat.psd.

4. Be sure all layers are visible, and make a note of the file size in the information field in

the lower-Left corner of the image window. From the layers palette pull-down menu,

Choose flatten image. Notice the dramatic reduction of the file size.

5. Save the image
CHOOSING COLORS

Picking a color in Photoshop 6 is as simple as squeezing paint from a tube. It is a matter
of choosing a color from one of Photoshop’s three color interfaces. In addition you can sample
color directly from an image.

There are two color swatches near the bottom of the tool palette, representing the current
foreground and back ground colors. The swatch on the left is this foreground color, a which is
applied by any of the painting tools. The default foreground color is black. The background color
on the right is applied with this eraser tool or if you cut a selected portion of an image on the
background. The default background is white.

You can reverse the fore ground and background colors by clicking the curved arrow to

the upper _right of the swatches.
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1)The color picker

"To choose the fore ground or back ground color, click its swatch; the color picker
appears. The color picker lets you choose from four methods of defining your colors: HSB,
RGB, Lab, and CMYK. Your main tool in the color picker is a vertical slider and a large colors
field.

Hue: This is the position of the color on a color wheel. When the H radio button it’s
selected in the color picker, the vertical slider is displays in the spectrum of all of the available
hues, and the color fields presents that hue's saturation and brightness variation. Notice that the
top and bottom of the spectrum slider or both red. If you drag the slider to the top or bottom of
the color bar, the values in the hue box are the same: 0 degrees. No, we are not taking the hue's
temperature; we're determining its position on a color wheel. The vertical bar is actually a color
wheel that has been cut and straightened at the 0 degree, or red, position drag the slider anywhere
on the bar, notice that the hue values change the to a number between 0 and 360 degrees. As you

move the slider, the field to the left changes color.

Saturation: The color field on the left determines the saturation and brightness of the
hue. Saturation is the intensity of a particular hue. There are two ways to determine the saturation
of color in the color picker: Enter the value in the saturation box, or click or drag within the
coloe field. If the value in the saturation box is 100%, or if the circle on the color fields is to the
far right, the color will be as intense as it can possibly be. If a O is entered in the saturation box,

or if the circle is the placed at the far left of the field, the color will be gray.

Brightness: The value of the color is controlled in a simalar manner. Brightness is the
lightness or darkness of a color.Lower values produce darker color,with 0% equaling
black.Higher values produce lighter colors,with 100%equaling white when there is no colors
saturation or the lightest possible combination of hue and saturation. Click toward the bottom of

the color field to darken the color or toward the top to lighten it.

ii) Active parameters of colors
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By default, the color picker opens in HSB mode with hue as the active parameter. The
slider represents the colors (hues) on the color wheel, and the field represents the saturation and
brightness of the selected hue. The color picker can be changed to display several different
configurations: the color section of this book includes a side by side comparison of the color
picker's appearance when using each of the value fields.

The color picker can be configured for HSB, RGB, Lab, and CMYK active parameters by
clicking a radio button next to the desired model. Then vertical bar then represents the selected
characteristic in the selected model When the S radio is active, for instance, active parameter of
the color picker shifts to saturation mode and the vertical bar becomes a saturation slider. The
color field now displays hue and brightness variations. If you click or drag in the field to the left
or right, you affect the hue: if you click or drag up or down, you affect the brightness.

When the B radio button is checked, the active parameter of the color picker shifts to
brightness, on the vertical bar becomes a brightness slider the color field now displays hue and
saturation variation: clicking in field or dragging the circle to the left or right affect the hue and
dragging it up or down affect the saturation.

In the case of RGB and Lab (lightness, a, b) when a color channel's radio button is
selected the vertical slider displays the variation of the color within that channel, and the color
field becomes the other two color is channels, one represented the horizontally and the other
represented vertically.

The color swatch at the top of the color picker has two parts. The bottom of the swatch

shows the current color setting: the top shows the color you have selected in the color picker

Specifying CMYK Colors

Let's say a client walks into your office and wants you to add a logo to an image with
specific CMYK color values to correspond to the official corporate colors of her business. Once
you have scanned to logo, you can define the colors in the color picker and fill the logo with the
exact tint values of cyan, magenta, yellow, black needed to produce the corporate color.

To define and apply CMYK colors:

1. Click the foreground swatch to display the color picker.

2. Enter the CMYK %value in the boxes.

3. Click OK. The color appears as the foreground color.
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4. Select the area to be filled.

5. Press option + delete (Mac) or Alt + Backspace (Win) to fill the selected area.

The CMYK Gamut Warning

You would think that because CMYK is represented by 4 color channels instead of three
would be more colors available in this color mode. But in fact, a high percentage of black plus
any combination of cyan, yellow and magenta usually yields black. This greatly limits the
possibilities of CMYK. In fact, the CMYK gamut is so small that some colors can’t be produce
at all especially highly saturated one’s the color section includes a schematic comparison of the
gamut of visible, RGB, and CMYK Colors.

If you choose a color in HSB or RGB that is outside the printable range or gamut of
CMYK, you will see the percentage values in the CMYK boxes. However, you will also see a
CMKY Gamut Warning next to the swatch in the Color Picker. The small swatch blow the
warning is a representation of how the color will print. Some CMYK colors, especially highly
saturated colors, can vary significantly from their RGB counter part. If you get a warning, you
may want to specify a different color for a close match, or be prepared to accept considerable
variation of the color on the printed piece.

Specifying Web Colors

In HTML code, colors are coded with a combination of six hexadecimal digits so that
WWW browsers can read and display them. Not all browses can display all colors you can use
the Color Picker to assure that the colors you use are browser-safe.

To Specify a Web color, check the Only Web Color box at the bottom of the Color
Picker. The color bar and color field then unique themselves to 216 Web-Compatible colors.

Like CMYK colors, Web colors have a very limited gamut compared to RGB. When the
Only Web Colors box is unchecked, the Color Picker displays a Web Color Gamut Warning next
to the large swatch in the Color Picker. The small swatch below the warning shows how the

color will be seen on Web browser.

Specifying Custom Colors
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The PANTONE Matching System is a group of inks used to print spot colors. where
CMYK mixes only 4 colors to produce a full color a spectrum, PANTONE inks are solid colors
used to print rich solid or tinted areas.

To specify a custom color:

1. Click a color swatch to display the Color Picker.

2. Click the Custom button to display the Custom Color
dialog box.

3. From the Book pop-up list, choose the desire matching
system.

4. Enter the color’s number using the keypad. you can,
instead, scroll through the color list using the slider;
when you find the color you want, click it.

5. Click OK.

iii) Using color palettes

While the color picker displays all of the color characteristics and models in one integrated
fields, it is sometimes cumbersome to use because it is not context-sensitive. A context-sensitive
palette’s will response immediately to your commands without having to click an OK button.
But the color picker must be displayed by clicking the foreground or background swatch. You
must then choose a color model and a color. Finally you must click OK. This process can be
time-consuming because of the many steps involved. Instead, you may want to use the context-

sensitive color and swatch palettes that conveniently float on the desktop.

The Swatches Palette
To display individual swatches of color, choose the Swatches palette from the

palette cluster. Predefined color can be chosen, or new colors can be added and saved.

Swatches Technique How To Do It
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To Select a Foreground Color Click it; the color will appear as the foreground
swatch on the Tool palette

To Select a Background Color Press the Option(Mac)or Alt(Win) key while

clicking the color

Add Color Place your cursor in the blank space below the
color swatches. The cursor changes to paint

can. Click your mouse, name the color and the
foreground color will appear in the palette as a

new swatch.

To Delete a Color Press the Command (Mac) or Ctrl(Win) key
and click the swatch. Or, control-click (Mac)or
right-click(Win) and select Delete Swatch from

the shortcut menu.

To Save a Swatch Palette Once you have added colors to the swatches,
you may want to save the palette for use in
other documents. From the Swatches palette
menu, choose Save Swatches. Designate a

folder in which to store your palette

To Load Swatches To access a saved palette, choose Load
Swatches from the Swatches palette menu. You
can then access the Swatch from folder in
which you saved it, or choose a specific palette
like PANTONE, Focoltone , ANPA, or Web

Save Colors from the list.

To Reset Swatches The Reset Swatches command on the palette
menu restores the swatches to the Photoshop

default palette.

To Name a Swatch Color Swatches can be named for identification.

To name a swatch, double-click it and enter the

name in the Swatch Name dialog box. Or
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Control-click (Mac) or right-click (Win) and
select Name Swatch.

iv) Sampling Colors

Foreground and background colors can be specified by sampling directly from the image.
To sample a color, choose the Eyedropper from the Tool palette and click or drag across the
image. As you drag, notice that the foreground swatch changes to the color the eyedropper is

touching. To sample a background color, hold down the Option or Alt key as you click.

Creating Brushes

Photoshop provides you with many brushes that apply color to your image in a variety of
ways. In addition, you can create new brushes and control their size, hardness, spacing,
roundness, and angel you can also make custom brushes in virtually any shape.

In Photoshop 6, the brushes are display on the left side of the Options bar of all of the
painting and editing tools. Choose a brush, choose a painting tool, click the small arrow to the
right of the Brush icon in the Option bar to expand the panel, and then click the desired icon. The
currently loaded brushes are displayed as icon in a grid.

From a pull-down on the expand Brush panel, you can add new brushes to the palette,
change the characteristics of existing brushes, and name brushes .As with Swatches, you can and

load brushes as well.

i) Make a New Brush
From the Brush pull-down menu, choose New Brush and a dialog appears. Adjust the

following characteristics.

Diameter Determines the size of the brush, from 1 to 999 pixels. Higher resolution
documents need larger brushes; f or eq, a 72 pibrush on a 72 ppi document will paint a stroke 1
inch in diameter .the same brush will paint a half-inch stroke on a 144 ppi document.

Hardness Specifies the gradient transition of the edges of the brush,0%to 100%.

Spacing Affects how frequently the color is deposited as you drag, from 0% to 100%.
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Roundness Affects The shape of the brush, from 0% (a line) to 100%(a full circle).
Angel Determines the angle of the brush store if you have modified its roundness so that
it political. Angel values range from+180 degree counterclockwise from horizontal to-180 degree

clockwise from horizontal.

i) Modify an Existing Brush

If you wish to change the characteristics of an existing brush, click it in the brush palette;
its icon will appear in the Options bar. Now, click the Options bar icon to display the Brush
Characteristics dialog box, which is similar to the New Brush dialog. Make the desire adjustment

to the brush, then close a dialog by clicking the icon in the upper —left corner.

iii) Create a Custom Brush

A brush of virtually any shape can be made from a selected piece of your image and later
be used to clone an area of the image or paint it with a texture. The process of creating a custom
brush has changed significantly in photo shop6 in that the brush shape now needs to the isolated
on a separate layer.

To create custom brush, follow the steps:

1. Select an area of an image. Choose layer-> new -> via copy to isolate it to a
transparent layer.(you can also paint on a new layer or copy and paste an image to an new layer)

2. Choose edit -> define brush. The brush name dialog box appears.

3. Name the brush and click OK. The new brush dialog box appears.(no, you're
not confused -naming the brush brings of the new brush dialog, which also has a name field.
These could have been combinated into one dialog box.)

4. Choose a desired spacing and click OK. The brush appears on the brush palette.

5. Choose a painting tool. Choose the custom brush from the brush palette,

choose a color, and paint with brush. The brush image is content of the entire layer.

USING THE PAINTING AND EDITING TOOLS
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The painting and editing tools are used to manually apply color or to modify an area of
the image. You can access the painting and editing tool by clicking them in the tool palette or by
pressing the appropriate letter key on the keyboard.

1) The Painting Tools
The painting tools include the Airbrush, paintbrush and pencil; these tools are designed to
simulate real studio painting techniques.

Airbrush (Shortcut Key-J)

Use the airbrush to spray color. By placing your cursor on the image, clicking your
mouse, and dragging, you can spray a pattern of color. If you drag slowly or stop dragging the
color will build just like a real airbrush. You can adjust the pressure of the airbrush in the options
bar, which controls amount of color that is deposited.

Paintbrush (B)
You apply color to the image with the paint brush by clicking your mouse

Button and dragging. By default, the stroke is a solid color. You can adjust the characteristics of
the tool to alter quality of the paint stroke.

Opacity The transparency of the stroke is controlled with the opacity slider from
0% t0100%.When painted on a colored surface, the transparent of translucent stroke will reveal
the pixels underneath it.

Wet Edges this adjustment provides a water color stroke that looks as though the

color is concentrated along its edges and translucent in its center.

Pencil (B)
The pencil is the only tool that produces an aliased or hard-edged stroke. Use the pencil to draw
crisp horizontal or vertical lines or stair-stepped diagonals.
Like the paint brush, you can adjust the opacity or assign a color mode to the stroke.
You can use the pencil as an eraser by checking the auto eraser box. If you start painting

an a area containing the foreground color, the auto erase function replaces it with background
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color. If you start painting on an area containing any color other than the foreground color, the
pencil paints with the foreground color.

i1) The Editing Tools

The editing tools include the clone stamp, pattern stamp, history brush, Art history brush,
eraser, background eraser, magic eraser, blur, sharpen, smudge, dodge, burn, and saturate tools.
While the editing tools don’t apply the color directly to the image, they are essential for
manipulating small regions with in the image and modifying existing colors.
Clone Stamp (S)

To clone an area,you must 1% sample it:

1. Choose the Colne Stamp from the Tool paletee.

2. Choose an appropriate brush from the Bush menu on the Options bar.

3. Press the Option(Mac) or Alt(Win) key and click your mouse on the
point that you want to copy.

4. Release your mouse and reposition the cursor were you want sample to
be painter.

5. Click your mouse and begin painting. As you paint, that tool will begin
coping the point of the image that was sampled.A small cross will
indicate the area that is begin copied as you drag the brush across the

image.

Pattern Stamp(S)

Use the pattern stamp to paint an area with a repeating pattern that you choose from the
pattern pull-down menu on the options bar.

Check the aligned option to maintain the alignment of the brush with the pattern. Each
time release the mouse, move the brush, and resume painting, the alignment of the pattern
continues. If aligned is unchecked, the image time you click, the center of the pattern till will

again the source of the new image.
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History Brush(Y)
The History Brush restores a portion of the image to a formal state. Choose the History
Brush and target a state in the History palette, choose a brush size, press the mouse and drag

across the image.

Art History Brush(Y)

This tools is quite handy for creating instant Impressionists effects. When you
paint with the Art History Brush,color is deposited rapidly in several directions. Choose from a
list of characteristics in the Options bar that affect the style of the stroke and the rapidity in
which it is deposited.

*Style Determines the size and shape of the strokes that art deposited. Choose
from a list that includes Tight,Loose,Short,Long,Dabs,and Curls.

*Fidelity Is a percentage(from 0% to 100%) that affects the color of the stroke
and how close it will be to the color on which your painting. Higher values produce more
monochromatic affects,and lower values produce more color variation.

*Area Determines how wide a region the strokes will be deposited over, from 0

to 500 px. Higher —resolution files need higher values.

*Spacing Control the freequency(from 0% to 100%) at which the stroke is

deposited as you drag. Dragging faster produces wider gaps between stroke clusters.

Eraser(E)

The Eraser performs differently depending on whether you’re working on the
Background or a layer.when working on the Background,the Eraser replace the area with the
background color in the Tool palette.When erasing to a layer, it replaces the layer content with
transparency.if the transparency option on the layer is locked,then the pixels are replaced with
the background color.

The Eraser offers 4 modes in which to work:Airbrus,Paintbrush,Pencil,or Block. The
characteristics of each tool are inherent in the erasure. For eg,if you choose the Wet Edges

option in paintbrush mode, the Eraser erases to a watercolor effect.
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You can erase the image back to a history state by clicking the 1% column in the history
palette to set a source and choosing the Erase To history option from the options bar.

Background Eraser(E)

The Background Eraser tool is a combination of the Magic Wand tool and the eraser,in
that it lets you sample and set a tolerance to determine what range of color will be erased. You
can also determine the sharpness of the remaining edges. The Background Eraser erases to
transparency of a layer,or automatically converts the Background into a layer when applied
there.

1. Erasing Modes Control what pixels will be erased. Choose:

@ Discontiguous To erase all of the pixels within the

tolerance range on the entire layer.

@ Contiguous To erase pixels of the sampled color that are

adjacent to each other.

@ Find Edges To erase pixels of the sampled color that are
adjacent to each other but better preserve the sharpness of the edge

pixels of the remaining iamge.
2. Tolerance Controls the range of colors to be erased. Low tolerance erases
colors that are similar to the sampled colors : High tolerance erases to colors
that are more diverse in range.

3. Sampling Option Determines the method in which the colors will be chosen

@ Continues Sample color continuously as you drag, erasing

area‘s of different colors.
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@ Once Samples a color when you 1% click and then
continues to erase only that color. Use this option to erase areas of
solid color.

@ Background Swatch Erases areas that are the current
background color.

Magic Eraser(E)
The Magic Eraser erases all px of similar color within the Tolerance range when you

click the color you want to erase . It allows you isolate the erasure 2 specific colors.

1. Tolerance In the options bar controls the range of colors to be erased. Low
tolerance erases color that are similar to the sampled colors ; High tolerance

erases to colors that are more diverse In range.

2. Opacity Determines the strength of the erasure.

3. Contiguous Determines what px will be erased. When checked, you erase
only adjacent px of the color. With Contiguous unchecked,the magic eraser

erases all px of the color on the layer.

4. Use All Layers Determines where the information will be erased. With this
option checked,the magic eraser erases through all of the visible layers ;

without this option, it erases only the px on the target layer.

Blur(R)
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The blur tool soften the region us you apply it by decreasing the relative contrast of
adjacent pixels. Use it to blend colors and soften edges,or to reduce focus of a background.
Increase the pressure setting in the options bar to strengthen the effect.

Sharpen(R)

The sharpen tool increases the relative the contrast values of adjacent pixels. As you drag
over an area, the px randomly change color. Sharpening fools your eyes into thinking and image
is in focus. This tool can be used to enhance portions of an image that you want to emphasize,or

as a quick fix for photographs that are slightly out of focus.

Smudge(R)
Use the smudge tool to simulate charcoal or pastel effects . As you drag with the smudge
tool,you move one area of color into another while blending and mixing the colors as you move

them.

Dodge(O)

Dodging is a technique used by photographer in the darkroom to overexpose or lighten
specific areas of an image. In photoshop,the dodge tool performs a similar function by increasing
the brightness values of pixels you paint with it. The effect on the specific range of tonality by

choosing Highlights,Midtones, or Shadows from the range pull-down menu.

Burn(O)
Photoshop’s burn tool darkens by lowering the brightness values of pixels as you move it
over the image .As with dodge tool, the options bar lets you pick a range of px to effect by

choosing Highlights, Midtones, or Shadows from the menu.

Sponge(O)
The sponge tool changes the intensity as it touches pixels. From the Option bar, choose

either Saturate to enhance a color or desaturate to diminish the color and push it toward gray.
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iii)Brush Dynamics
The behavior of all of the painting tools can be controlled from the brush dynamics menu
on the right side of the options bar. This control lets you fade ,taper, or changed the color of a
stroke over a specified distance.
Choose from the following characteristics:
Size Specify a number of steps to gradually taper the thickness of the brush stroke
until it disappears.
Opacity Set a number of steps to gradually fade the brush until it completely
disappears.
Color Enter a number of steps gradually fade the foreground color into the

background color.

iv)Color Blending Modes
Blending modes control the relation of the color that is begin apply to the existing colors
on the image. The normal blending mode, at 100% opacity, applies in a color as if it were

painted straight out of a tube.

v)Painting Tools Shortcuts

Here are a couple of shortcuts that will increase your dexterity in handling the painting
tools and performing tasks the would be otherwise impossible. For horizontal and vertical lines,
press the Shift key as you drag up or down, left or right. for straight line in any other direction,

click and release your mouse, then move the cursor to a new location as shift-click

Making and Applying Gradients
The ability to gradually blend color is essential to the credibility of a realistic image.
Photoshop gradient blend multiple color into each other or into transparency over a specified

distance.

i) Choosing Gradients
Choose the gradient tool from the tool palette .At the far left is a preview bar, or gradient

swatch, with a down —arrow ; clicking in this swatch calls are in the gradient editor, while
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clicking the arrow pops up a similar gradient picker panel. Both display all saved gradient,
beginning with the several preinstalled gradients. The default gradient creates a fill that blends
from the foreground color to the background color. Use it to gradually fade a single color or
multiple colors.

If you click the arrow at the upper-right of the gradient picker path — up panel, you will
display the gradient options pull — down menu. The second group displays different ways of
view the gradient in the menu at the bottom of the menu is a list of additional pre-made
Photoshop gradients.

Gradient Type Effect

Linear applies a continual gradient over a specified distance from beginning point
to end point.

Radial radiates around a center point to its end point.

Angle radiates counter clockwise around a center point.

Reflected creates to linear gradients on each side of a center point.

Diamond radiates from a center point into a diamond blend.

i) Making Custom Gradients

Use the gradient editor to edit existing gradients or make new custom gradients and add
them to the list. You can also save and load entire gradient palettes from the gradient editor or
from the preset manger.

Call up the gradient editor by clicking the gradient swatch in the option bar. Click a
gradient in the preset list to select it. T he gradient preview bar shows the gradient’s colors, there
proportional distribution, and the position of any transparency. These characteristics can be
editor.

Editing Gradient Color

The house shaped makers alone the bottoms of the color bar are color stops, used to
determine where a solid color ends and where a gradient begins. You can assign a color to a
color stop by clicking it to highlight it. Move the cursor off the gradient editor and on to the
image, the color palette, or this swatchs palette to sample a color. Another method of choosing a

color is to double click the swatch in the stops area: the color picker will be displayed .To
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redefine a stop’s location, drag it left or right set a value In the location field as a %of the
gradient length.

To an add a color to a gradient, click underneath the preview bar and a new color stop
will appear. Determine a color for a color stop, drag the stop into position, and adjust the colors
midpoint. To delete a color drag its color stops off gradient editor.

Editing Gradient Transparency

The house shaped markers alone the top of the gradient preview bar determine were
transparency ends and where it begins. To blend transparency into the gradient, click a
transparency stop and enter a % value in the opacity field drag a stop to determine its location or
enter a number in the stops area.

If transparency is set anywhere along the gradient, a diamond on top of the preview bar
marks the center point of the transparency range. Move the midpoint to redistribute the portion of
transparency in the gradient.

To add transparency to a gradient, click above the color bar. Determine an opacity value
in the Opacity field, move the stop into position, and adjust its midpoint. To delete a
transparency, drag the transparency stop off the Gradient Editor.

Editing an Existing Gradient

1. Choose the Gradient tool and click the gradient swatch on the Options bar to display
the Gradient Editor.

2. At the top of the Editor is a list of Presets-the gradients that have already been saved.
Double-click the gradient you want to edit. The Gradient Name dialog box appears. If
desired, enter a new name and click OK.

3. On the preview bar in the Gradient Editor, you see the configuration of color and
transparency of the selected gradient as determined by the number and position of the
color and transparency stops and the midpoint diamonds. Slide the stops to the left or
right to adjust the color or transparency proportions. Slide the midpoint diamonds to
adjust the centers of the blend.

4. Add a color by clicking under the preview bar to create a new stop.

5. Double-click the stop to display the Color Picker. Choose a color for the stop and
click OK.
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6. When satisfied with the edited gradient, click OK to leave the Gradient Editor. The
edited gradient now appears in the Option bar.

7. Choose a Gradient tool, click in the image, and drag. Release the mouse to apply the
gradient.

Making a Noise Gradient
The Noise option under Gradient Type in the Gradient Editor adds random colors to a
gradient depending on the predefined colors you choose. The result can be somewhat
unpredictable, so experiment to achieve the best results. To create, a noise gradient
1. Inthe Gradient Editor, under Gradient Type, choose Noise.
2. For Roughness, choose or enter a percentage. This will determine the strength of the
noise.
3. Choose a color mode or model-RGB, HSB, or Lab. The effect will vary significantly
with each system.
4. Check Restrict Colors to prevent oversaturation.
5. Check Add Transparency to create a transparent gradient.
6. Click Randomize to preview variation of the effect.
Creating a New Gradient
1. Click the gradient swatch on the Options bar to display the Gradient Editor.
2. Click the new button. The name field displays the name of the currently selected
gradient, and the preview bar displays its properties.
3. Enter a name for the new gradient
4. Target each of the color or transparency stops and change their colors and locations as
described under “Editing an Existing Gradient”
5. Add color or transparency stops if desired by clicking under or over the preview bar

6. click OK to finalize the gradient and to select it into the gradient swatch

iii) Applying Gradients
All gradients are applied over a specified distance. You choose the gradient tool, click the
image where you want the gradient to start, and drag in the desired direction. Release the mouse

where you want the gradient to end. You will fill a selection if one is active or the entire
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Background or layer if no selection is active. The distribution of the gradient depends on its color

content and the position of the stops, but just as important are the placement of the cursor and the
length and direction you drag on the image
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PART-B
POSSIBLE QUESTIONS(8 Marks)
Discuss about Displaying Images in Photo shop.

Illustrate about Making & Applying Gradients.

Explain in detail about Rulers, Guides & Grids.

Discuss about Painting & Editing Tools

Explain in detail about Navigation shortcuts.

How can you create animated artwork images with beautiful lighting in Photoshop

Discuss about Creating Brushes in Photo shop with a neat sketch

© N o g &~ w DN E

Write about displaying the images with a neat sketch
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Which among the following is not [marquee Move lasso
1 the selection tool
Which among the following is not |Airbrush Lasso Pencil
2 the Painting tool
enables to combine channel Layer swatces
images and create collages by
working on one part of an image
3 at a time
sketches is an artist's term |List Details Thumbnail
for a small version of a picture
4
The Tool is used to |crop Single column [Magic Wand
select adjacent pixels based on marquee
5 color similarites
When you have to select irregular |crop Single column |Magic Wand
shapes tool is used marquee
6
tool creates hard- Airbrush paintbrush eraser
7 edged lines
tool sprays paint or |Airbrush paintbrush eraser
8 pixel on the canvas
tool is applied more |Airbrush paintbrush eraser
evenly and is the arthouse of all
9 painting tools in Photoshop
A photo edit of shrinking is Enhancements |Color
considered in the category |Resize and and Layering
10 of edits. Focus
s the process of changing Zoomify Maximization
the photo to make it most
11 effective for its purpose. Magnification
option works the same as intersect with feather
holding down the shift key when |subtract from [selection
12 new selection is active selection




intersect with feather
option removes all of selection
the selected areas except for those |subtract from
13 included in your new selection selection
setting determines intersect with feather
whether the edges of the selected selection
14 area are sharp or blurred Anti-aliasing
The option intersect with feather
determines whether the edge of selection
the selected area is smooth or
15  |jagged Anti-aliasing
New layer set creates a task Frame
inside the layer
16 palette scene
The Opacity setting allows you to
change the opacity of your layer
17 from invisible to opaque 25% to 75% (0% to 50% 0% to 100%
lets you select a crop
specific color in an image for use
18 another part of your image slice eyedropper
The ratio of the height and width matrix ratio reference ratio
19 of the actual document aspect ratio
lets you distort Warping air brush
type to conform to a variety of
20 shapes pencil
Stores saved Brush Presets picker
brush tip settings, such as brush
size, hardness, and airbrush, and
the brush options available in the |Tool Presets
21 Brushes palette. picker Paint
Stores saved settings of Brush Presets picker
a brush tip preset, other options
from the options bar such as
opacity or blending mode, and Tool Presets
22 [paint color. picker Paint
The window containing an open screen window |dialog box
file is also called document
23 the window
Patch The Clone Stamp
tool removes the [The Healing
24 red reflection caused by a flash.  |Brush
The tool paints The Healing |Patch The Clone Stamp
25 with a sample of an image. Brush




The tool repairs
imperfections in a selected area of

Patch

The Clone Stamp

an image using a sample or The Healing
26 pattern. Brush
The tool paints Patch The Clone Stamp
with a sample or pattern to repair |The Healing
27 imperfections in a image. Brush
The changes the color Smudge tool Sharpen tool
28 saturation of an area. Sponge tool
The smudges data Smudge tool Sharpen tool
29 in an image. Sponge tool
he sharpens soft Smudge tool Sharpen tool
30 edges in an image. Sponge tool
Background Magic Eraser tool
The erases Eraser tool
pixels and restores parts of an
31 image to a previously saved state. |Eraser tool
Background Magic Eraser tool
The erases Eraser tool
32 areas to transparency by dragging. |Eraser tool
The erases solid- Background Magic Eraser tool
colored areas to transparency with Eraser tool
33 a single click. Eraser tool
The paints a copy of Art History History Brush tool
the selected state or snapshot into |Paint Bucket [brush tool
34 the current image window. tool
Art History History Brush tool
The paints with brush tool
stylized strokes that simulate the
look of different paint styles, Paint Bucket
35 using a selected state or snapshot. [tool
The create straight- Art History History Brush tool
line, radial, angle, reflected, and |Paint Bucket |brush tool
36 diamond blends between colors.  |tool
The fills similarly Art History History Brush tool
colored areas with the foreground |Paint Bucket |brush tool
37 color. tool
palettes is used to
38 adjust the zoom level of an image |swatches Navigator layers
tool is a fast way take a
39 closer look at the image. hand tool image tool zoom tool
shortcut key is used
40 to zoomin alt/spacebar |ctrl/spacebar enter/spacebar




shortcut key is used
41  |to zoomout ctrl/spacebar |enter/spacebar |shift/spacebar
There are types of
42 selection tools 5 2
selection tools
selects a single line of pixcels single row single column
43 vertically tool tool rectangle tools
selection tools
selects a single line of pixcels single row
44 horizontally tool single row tool rectangle tools
tools draws free form
45 selection lasso tool elliptical tool polygonal tool
tool is used to create
46 straight edged selection borders. |lasso tool elliptical tool polygonal tool
tools makes a selection
based on the contrast values of
47 pixcels. slice tool magnetic tool  [polygonal tool
48 The default foreground coloris  |red white black
49 The default background color is  |red white black
In HSB top and bottom of the
50 spectram slider are both blue green red
The hue value is changes from
51 0 to 80 0 to 360 0 to 30
If 0 is entered in the saturation
52 box, the color will be gray red white
If 0 is entered in the brightness
53 box , the color will be gray red white
In HTML code, colors are coded
with a combination of
54 | hexadecimal digits. 1 4 6
Brushes are displayed on the
55 of the option bar. top bottom right
In the brush pull bown menu,
diameter determines the size of
56 the brushes from 1 to 350 1 to 100 1to 99
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Eraser Eraser
Rubber Stamp Lasso
path Layer
Icons Thumbnail
Magnetic Lasso Magic Wand
Lasso Lasso
Pencil Pencil
Pencil Airbrush
color picker paintbrush
Correction
Resize and Focus

Optimization Optimization

Add to Selection

Add to Selection




Add to Selection

intersect with
selection

Add to Selection

feather

Add to Selection

Anti-aliasing

folder folder
negative to
positive 0% to 100%
magic wand

eyedropper

max_ratio

aspect ratio

pencil brush

Warping

Brushes palette | Brush Presets picker
Brushes palette

Tool Presets picker
full screen

document window
Red Eye Red Eye
Red Eye The Clone Stamp




Red Eye Patch
Red Eye
The Healing Brush

Dodge tool

Sponge tool
Dodge tool Smudge tool
Dodge tool Sharpen tool
Sharpen tool

Eraser tool
Sharpen tool Background Eraser

tool

Sharpen tool Magic Eraser tool
gradient tools History Brush tool

gradient tools

Art History brush
tool

gradient tools

gradient tools

gradient tools

Paint Bucket tool
history Navigator
slice tool zoom tool
shift/spacebar ctrl/spacebar




alt/spacebar

alt/spacebar

4

double row tools

single column tool

double row tools

single row tool

slice tool lasso tool
slice tool polygonal tool
lasso tool magnetic tool
gray black
gray white
black red
0 to 100 0 to 360
black gray
black black

8 6
left left
1 to 50 1to 99
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UNIT-IV
SYLLABUS

Introduction to Flash: Variables & data types- Data types in Action Script-Creating and
placing variables — Buttons with text fields.

INTRODCTION TO FLASH

Macromedia's popular application Flash has redefined the way web developers
approach web design. With flash the web developer is now able to create a user
experience that is rich in media and relatively quick loading, especially compared to
traditional methods like GIF animations.

Websites made up of music, videos, and custom, graphic intensive interfaces are
all possible with Macromedia Flash. In flash you can create unique text, animations,
movies, web applications, games and more. Although flash is somewhat more complex
than traditional web development technologies like HTML and CSS, this tutorial will
give you the basics you need to immediately get started with designing your own flash

projects.

Flash is an incredibly powerful program that has seemingly endless potential. Flash can
be used for creating games, making presentations, animations, visualizations, webpage
components, and many other interactive applications. Some of the Flash interface
components will look familiar to you, as they have the same functionality as other Adobe
applications. However, Flash requires a certain mindset to work in it properly, especially

when animating with vector graphics and coding with action script 3.0.
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Action script:

Adds interactivity and/or playback efficiency to a movie via coding.
General characteristics of the ActionScript:

1) ActionScript is an object-oriented programming language. The approach
focuses on treating all of the elements in a program as an object.. A scene,frame, a text
box, a drawing, and a symbole are all Actioscript objects. The objects have attributes that
can be altered by actioscript and each object has a unique ID that can be referenced by
Actionscript. Objects can live in hierarchy. An object can be made up of several other
objects.

2) The ActionScript is very similar to the Javascript; if you know Javascript,
the syntax and the style of ActionScript will seem imediately familiar to you. You can
find the differences between both languages in the help that accompanies Flash.

In most cases, it will not be necessary "to program" indeed, Flash places at our
disposal an impressive collection of "functions" already implemented that do what we
looked for. It will be enough to place them in the suitable place.

3) ActionScript is a modular programming language. This means that the

scripts are little modules that do particular things such as stop or play a movie.Each

Dr.S.ManjuPriya & Mr. K.Yuvaraj, Department of CS, CA & IT, KAHE 2/17



Unit-4 Introduction to Flash 2015-Batch

module stands alone but is related to the rest of the flash movie. Actionscript involves
understanding where and how to use familiar programming structures such as

conditionals, arrays and loops.

VARIABLES & DATA TYPES:

One of the fundamental components of any kind of programming is the variable.
As the name implies variable change .the best way to think of a variable is as box of
different things .in programming variables store data of different sorts with different
values
For example: a pet store can be considered a variable because its contents may change
initially the pet store (variable)may sell only puppies .waiting to expand the owner of the
pet store may decide to offer Kkittens ,fish, birds, and lizards as well as puppies. The pet
store (variable)is the same store with the same name but it has different mix of animals
therefore its quality has changed.
Is the variable going to store text ,integers or floating point numbers.Actionscript

automatically deals with different types of data stored in variables.

NAMING VARIABLES:
The name to select for a variable should give a clue to what the variable does.

Name such as “Variable A” Variable B” and so forth are virtually useless.

Variables must be a single string of connected characters with no spaces between the
words Variable name such as “petstore” or “johnsmith” are not acceptable however
“petstore”,pet_store”or “petstore” are moreover Action script is not case sensitive if a
variable is named petstore you can use “PETSTORE” or “petstore” to call the variables

current value.

However “pet_store will not be recognized as the same variable as petstore because it

contains an extra characters the underscore. This lack of case sensitivity makes it easier
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Another naming convention you need to consider in naming Variable is the use of
reserved words or keywords .the keywords in the action script vocabulary cannot be used

as labels variable names, or function name.

Break continue delete else  for function if in new
return this type of var void while with

Keywords are as follows:

break
continue
delete
else

for
function
if

in

new
return
this
typeof
var
void
while
with

Two more terms-true and false-are Boolean literals, which also cannot be used.

ARRAYS:

A Special type of variable called an array and is now part of ActionScripts structure.
Arrays are similar to variables. It is a containers for data, except that they can hold more
than one piece of data, each element(piece of data) is referred to by an index. Arrays can
be used to keep your scripts more organised, they are usually used to group together
multiple values that are in some way related to each other, the values use an index to
distinguish them from each other. Suppose you wanted to write out 3 quotes for use in
your movie and use variables for each quote. Arrays have one or more dimensions.

Obijects are a collection of properties and those properties are the array elements. For
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example, a simple or one dimensional array named “Fruit” has four elements and looks
like the following

Ex:

Fruit[0]="apples”

Fruit[1]="oranges”

Fruit[2]="peaches”

Fruit[3]="pears”

VARIABLES & DATA TYPES: DATA TYPES IN ACTION SCRIPT

STRINGS
A variable of type String is made up of any combination of alphanumeric characters
(a-z, A-Z, 0-9). The value of a string (its sequence of alphanumeric characters) must be
enclosed in quotes, either single or double , when the value is assigned to a variable. One
string may be concatenated to another with the "+" operator. Strings used as messages.
For example, a string in a variable can be
Airplane=" Cessna Cardinal”
The variable is “Airplane” and the string literal is “Cessna Cardinal”. A literal is the raw
data that goes into a variable. A string can be a numeral such as ,
StreetNumber="250"
The variable “StreetNumber” is just another string literal that consists of numeric
characters. Any alphanumeric string of characters is a string. The phrase “string of
characters” means that it can contain most punctuation marks and spaces as well as
alphabetic characters and numbers can be used in any combination..
Expressions:

Here are some example string operations.
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o Set variable excerpt_str to be the 3rd to 5th characters in string phrase_str
var excerpt_str:String = phrase_str.substr(2, 3);
o Set variable found to true if string main_str contains another string (‘abc’)
var found:Boolean = (main_str.indexOf(‘abc’) >= 0);
o Save the numeric position of the start of findme_str within phrase_str in variable
posn
var posn:Number = phrase_str.indexOf(findme_str);
o Get length of (number of characters in) string phrase_str and save it in phraselen
var phraselen:Number = phrase_str.length;
o Concatenate strings city_str and state_str into another variable, citystate_str
var citystate_str:String = city_str +", " + state_str;
e Make string lowercase
word_str = word_str.toLowerCase();
e Append a string to an existing string

citystate_str = citystate_str + + zipcode_str;

or, abbreviated:

citystate_str += + zipcode_str;
e Replace piece of string ("Main" with "18th™) in addr_str
var addr_str:String = "402 Main Street";
addr_str = addr_str.split("Main™).join("18th");
EXPRESSIONS
Expression are considered compound because they contain more than a single

element in action script.
Total=7+5;

The value of “total is 12 the expression is compound but the value of totall2 because it is

not broken down into its component properties.

STRING CONCATENATION
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Two or more string are joined together the process is know as concatenation .all
concatenation are treated as expression in action script the added operator + or the string
operator add joins string

The expression: both="johnnie”+”Sally”;

: both="johnnie”add”Sally”;
Result in “johnnieSally *“ the value of the variable “both” become “johnniesally”
concatenation is very useful when putting together strings that go together such as first

and last names.

BOOLEAN EXPRESSIONS

Boolean expressions can also be used in action script the result of a Boolean
expression In flash are O(no false) or 1(yes true).named after george boole a brilliant
British mathematician
For ex : the following variable “Bigger” declares that 10 is greater than 15 because that’s

not true the variable”’Bigger”is false

Bigger=10>15;

Boolean Objects
Boolean literals are very smart if you assign a Boolean value to a variable

Boovar=9<10;

The result is true but it can also be interpreted as a 1

The Boolean object acts as a container for the Boolean properties. three Boolean objects
are available in action script:

1. new Boolean(0-Acts as a container for the Boolean property.

2. toString()-Converts Boolean literal to string “true” or “false”

3. valueOf()=Returns the Boolean primitive
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The following script uses all three objects.

1. The variable “booVar” provides a name for the Boolean object with the contents
of the Boolean literal “true” or “1” because 8 is greater than 7.

2. The variable “s” then stores the string literal of “booVar”. Which is true.

3. The variable “v” stores the primitives value of “booVar” which again is the
Boolean literal of “true” or “1”.

4. The variable “textVal’uses the plus sign(+), whish works like ass for
concatenation. Because adding a string to anything else returns the string and the
number as a string, the outcome should be “true2.”

5. When the Boolean literal is treated as a value, the results should be 3(1+2=3) and
stored in the variable “realVal”.

booVar=new Boolean(8 > 7);
s=booVar.toString();
v=booVar.valueOf();
textVal=s+2;

realVal=v+2;
output=textVal+newline+realVal;

The variable “output” is a textfield sothat the results show on the screen.

NUMBERS

Numbers are pretty straightforward unlike strings humbers must be written only
as such .A variable defined as a numbers is a humber and has all the properties of a
number. Numbers can have positive or negative values. you can create a variable that

includes both positive or negative.

Nuts=-5+15;

INTEGERS
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Integers are simply whole numbers with any decimals lobbed off. in creating
variables you do not have to declare what type of variable you are using. To create
integers however you must tell the variable that the numbers are to be treated as integers.
an integer is declared as such by using the integer function
For ex:

Whole=int (allstuff/parts);

REAL NUMBERS (FLOATING POINT)
To avoiding losing those added decimals and to have greater accuracy most
programmers use real or floating point numbers .The default character of numbers in

action script is floating point.

Movie Clips:

The final type in Action script is the movie clip. Unlike other data types, it is only one
That references a graphic. Like arrays, movie clips(MCs) have their own methods that
can be used with the Movie Clip object. MCs can issue actions only to other MCs or go
to a specific frame.

The following are examples of MovieClip objects.In this example the instance name
“flame” is a reference of the MC.

flame.getandstop(8);

flame.gotoandplay(6);

flame.play();

flame.stop();

flame.nextframe();

CREATING AND PLACING VARIABLES
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That you have an idea of the data types you need a way to get them into an action script

and use them in flash. Flash tries to make this easy with the action script editor in the

action panel but variables are also associated with text fields.

Build Settings - [Praject_KB - CYBCA245AXI-483] DS
Corfiguration: [ Debug {Active) w7 ]
Toolchain: [ﬁF{M GCC 473 - ] Processor Type CortexMO
(=3 P_rDject_KB B General

-- Code Generation Additional Libraries

(- Debug Additional Library Directories

[~ Customizer Additional Link Files

E-ARM GCC 4.7.3 Create Map File True
- General C-\Users\soox\Project_KB cydsn\cmilges_custom Id ()]
-- Compiler Remove Unused Functions True
-- Assembler Use Debugging Information True
=- Linker Use Default Libraries True

| i General Use newlibnano True

Custom Linker Script
The path to an altemate linker script to use when building the project.

%{Project Short Name} map specs=nano.specs -W| —gc-sections

-mthumb -march=amvé-m -T C:\lUsers‘wococProject_ KB cydsnemOgec_custom Id -g -WI -Map, ${Output Dirl

T 1|‘

Example using both types of variable placement and setting so pull out flash and follow

these instructions:

1. Create a new page in flash.

2. double click on layerl and rename it “sales tax”

3. Select window |panels|text options from the menu bar to bring the text options

panel to the screen. Create a text field by selecting the text tool from the tools

window .With the text filed selected choose dynamic text from the pulldown

menu in the text options panel

4. in the text options panel window select html and border/bg checkboxes

5. in the variable window type in the word “result”

placing a text field on the stage is a great utility and learning tool with variables when the

flash movies runs you can see whats going on in your action scripts by assigning different
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values to the text variables .Because no action script is written the next step is to place on
action script in the action script editor.

1. Click on the keyframe in frame 1.

2. Select window|Actions from the menubar or
ctri+Alt+A(windows)/Cmd+option+A(Macintosh) to open the frame actions
window and the action script editor.

3. in the left pane of the action script editor you will see basic action and action
folders among other folders click on the actions folder to open it.

4. Double-click on set variable from the action list.

5. At the bottom of the action script editor in the right panel you will see variable

name and value

The following script set the remaining variables and their values.all the values are
expressions so be sure to check the expression checkbox to the right of the value
window.

Itemcost=12;

Tax-itemcost*0.08;

Result=itemcost+tax;

After all of the variables and their associated values are entered test the script select
control |test movie from the menu bar or ctrl+Enter/cmd+return.

Global Variables:

A Variable has a scope that encompasses either the whole movie or just segments of
it. Before, the Actionscript variables were global.. As long as the addressing was done
correctly, you could access any variable on any level and in any scene.

Global variables are the default variables established using the set variable action.
Every object can affect and be affected by the changes in a global variable. Global
variable can be very helpful.For example, a common loop variable is “I” because it
has conventionally been shorthand for “increment”. If the same loop variable is used
in two different scripts inside the same timeline, the value of the variable may have

been changed in one loop, yet it affects another loop.
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Local variable:

Local variables are ones declared using the var statement inside of a script. When a
variable is declared using var between the curely braces({}) of a script, only changes
within that script affect the variables value. For example, whenever a button is used to
launch a script, it creates a block of code contained within curly braces.

Example of a script with local variables:

on(release){

var retail=50;

var wholesale=30;

var markup=(retial-wholesale);

output=markup;

}

Several different buttones can use the same variable names in their scripts as can

scripts in movie clips and frames.

BUTTONS WITH TEXT FILEDS

This movies uses scripts in three buttons to demonstrate how to manipulate data

entered into a variable through text fields the layer include following

concatenate strings
add numbers
test Boolean

output window

o M w0

input window

Create a Page with Action script:

How button work with variables follow these instructions to create a page and its
associated action script.

1. create a single button symbol and name it change variable
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Create three instances of the button one each in these layers:concatenate strings
add numbers and test Boolean.

Add an output windows layers which will contain the text fileds.

Add an input window layer where users can change values and watch the results

note that there are two input windows.

Each of three buttons uses the action script editor set variable action to the list in the

action script editor

1.

create a symbol by drawing a button on stage and selecting insertjconvert to
symbol from the menu bar or pressing f*.alternatively you can create a button in
the symbol editor by selecting insert new symbol editor by selecting insertjnew
symbol from the menu bar or ctrl+f8/cmd+f8 and drawing the symbol in the
editor.

in the symbol properties dialog box select button as the behavior type in name in
the name window this examples uses the name change variable

select window |[library or ctrl+l/cmd+l to open the library window drag an
instance of the button to the stage for each of the button layers

Select each button and enter the action script in the action script editor if the
actions panel is not on the screen. open it by selecting windowj|actions or
ctrl+alt+A/cmd+Option+A as you select each button the script you enter

automatically becomes the script associated with the selected button..

Start off by creating a new file. Then choose the Text Tool (it's the letter A) from the

Tools window and choose Static Text from the Properties window.

RNV N IR

e ¥ Properties  Filkers | Parameters
2 [static Text || A
&
= Text Toal -*-E"f'
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Left click and drag a textbox like we have on the stage to create a default text field.
Within the text field type: "I am writing some text that is more than one line"

Notice that the text field is now three lines of text, this is because the default text field
will automatically wrap to the next line when your text reaches the width limit. Your text
should look something like this, but if it doesn't do not worry, we are just about to start
playing around with the Text Properties

CONCATENATE STRING LAYER

The change string layer is used to create a change variable button with the
following action script

BUTTON -CONCATENATE STRING
(An instance of change variable button)

on (release) {

a=inputA:

b=inputB:

output=a+b;

}

Either the add operator or the plus sign can be used to concatenate strings.

ADD NUMBERS LAYER

The add numbers layer is used to create a change variable button with the
following action script

Button -Add(An instance of change variable Button)
on (release) {
a=Number(inputA):

b=Number(inputB):
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output=a+b;

ks

Number function to change the text into real numbers.using parseint() & parsefloat()

allows you to change a string or text field data into exactly the type of number.

TEST BOOLEAN LAYER
In the test boolean layer the outcome of a boolean expression is either true or false
if the variable inputA has a larger value than that in InputB the output is true otherwise
the output is false”
Button -Test Find String Boolean(An instance of change variable button)
on (release) {
a=inputA:
b=inputB:
output=a+b;
}

if you enter a number you can get some interesting result

OUTPUT WINDOW AND INPUT WINDOW LAYERS
The output window layer sets up the movie clip for fisplaying the outcome of a particular

action script.

1. Create your text fields using the values in table2.3 remember that all text field

variable associations are entered in the text options panel

2. open the text options panel by selecting window|panels|text options or pressing

ctrl+T/Cmd+T.Create the text fields by selecting the text tool from tools and
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selecting input text from the top pulldown menu provide the variable name in the

variable window.

3. Set text alignment in the paragraph panel.the paragraph panel is in the same panel

window as the text options and character panels.

Text Options panel and names

Variable name
Output
Inputl
Input2

Concatenate

Add

Find String Boolean

Border/Bg  Text Alignment

None Right

Yes Right

Yes Right
7 Output
88 InputA
95 InputB
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PART-B

POSSIBLE QUESTIONS(8 Marks)

1. Write in detail about Buttons with Text field in Flash.

2. Why Flash is used in multimedia? Explain the data types in flash with example.
3. Mlustrate with examples about Variables in Flash.

4. Describe about Creating & Placing variables in Flash.

5. Elucidate in detail about Data types in Action Scripts.

6. Describe the steps involved in creating animation in flash.

7. lustrate the steps to create moving objects using buttons
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1 Action script is a ------------ .
2 The operator joins two strings in actionscript.
3 The function returns the boolean primitive
4 Anything that is a collection of properties in ActionScript is considered as
5 eliminates the first array element andreturns it.
6 Buttons are sources for changing variables.
7 The layer sets up the movie clip for displaying the outcome of a particular
action script.
8 in flash can now have their own scripts.
9 keyword cannot be used as a variable name
10 There are keywords in actionscript
11 must be a single string of connected characters with no spaces between the

words.




12 String datatype should be enclosed within

13 Expressions are considered because they contain more than a sinlge
element.

14 acts a container for the boolean property.

15 converts boolean literal to string

16 The default character of numbers in ActionScript is

17 are objects containing several properties.

18 to create an array use object

19 joins two or more arrays.

20 is used to find the length of the array with no arguments

21 is used to reverse the order of the array elements

22 datatype references a graphic.

23 is used to open the frame actions windows

24 Global variables are default variables established using the variable action.

25 Local variables are declared using statement inside a script.




26 can use data that is generated either by other frames or by buttons.

27 In Flash 4, a was used to trace a path to a movie clip and its varaibles

28 In Flash 5, a was used to trace a path to a movie clip and its varaibles

29 The layer is the top layer.

30 To test a movie in flash use

31 must be a singlestring of connected characters, with no spaces between
the words.

32 is an invalid variable name.

33 A is a raw data that goes into a varaible.

34 thereare  boolean objects in Actionscript

35 The syntax to extract a substring of the array is

36 is used to delete specfied number of elements in an array.

37 is used to add elements to the end of the array and return new array length

38 length."hello world" returns the result as

39 canbe used to test the action scirpt




40 buttons canbe created in
41 is used to open the library window
42 The ---------- layer is used to create a change variable button, with the action script to
demonstrative how a string variable is changed by user input
43 The output layer contains and but no key frames.
44 MCs means
45 Are simply whole numbers with any decimals  lobbed off
46 The sign uses for concatenation
47 converts Boolean literal to string “true”or “false”
48 literals contain true or false values.
49 One of the fundamental component of any kind of programming is the
50 ActionScript uses
51
A data type is a type of data that isn't based on any other data types.
52
A is the value that a variable contains before you set its value.
53 Array in Actionscript is an




54 Variable names cannot use special characters except

55 Which of the following is not a valid varaible name?

56 For variables of type Number, the default value is

57 The value of an uninitialized variable depends on its

58 A is a variable that you define outside of any function or class definition.
59 are symbols that contain four frames.

60

The only object type in Flash, that can detect mouse events is the object.
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UNIT-V
SYLLABUS

Basic Actions: Play, stop, Back & forth- Between frames and
scenes — Timelines — External scripts-Loops.

Basic Actions
Play, Stop, Back & forth:
An action script may use both Stop and Play actions, which contradict each other.
For example, what happens if a movie includes a goto And Stop action to a frame that has
a Play() script

Stop or Play and Buttons:

This movie shows the effects of scripts in frames and stop or play commands
associated with Go To actions. The two layers in this movie are:
The Stop or Play layer contains five key frames with actions. Each is labeled as shown in

below.

Macrome dia Flash MX - [intro.fla]

i [

¢ | malm] ®a| 2 e [zowms [ zas 4] | |
= | = Scene 1 |§‘ B [153 =1

| Bhadd o I

I €n Actions for [Mo instancs nams assigns 4] [Symbel 2] -] =

=+ 2w == @ B2 AL
on (release)] { =1
pl=ay ()
+
L
EN| | _>l_I
> | |Lline 4 of 4, Cal 1

» Properties

Dr.S.ManjuPriya & Mr. K.Yuvaraj, Department of CS, CA & IT, KAHE 1\22



Unit -V Basic Actions | 2015-Batch

| -
Foys | o |6 el w Cf e [zowes [ zes 4] | |

- | ) Scene 1 |é‘ A [152 =

woop ‘

cccccc

gotaAndPlay
gotoAndStop

99999900@

prevFrame =
prevScens 4 | | »

stop ~| |tine zof 2, Col 1

~ » Properties

The Beginning

Go to Play Go to Play Goto &
& Stop & Play Stop at Go

Stop or Play Layer

On the first layer, the keyframes are labeled as indicated and contain a text message
added at the keyframe. The following labels and messages are used in the frames.
Frame 1- stopFirst(label)

Put a text message on the page that reads, “The Beginning”.

Stop();
Frame 10-Playlt(label)
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The message on the page is “Thios is the Play Place”.
Play();

Frame 18-Stop Me(label)

The message on the page is “You are stopped”.
Stop();

Frmae 27-GoAway(label)

The message on the page is “Go Away”
gotoAndPlay(“Away”);

Frame 36-Away(lable)

The message on the page is “Away”

Stop();

Button Layer

Buttons are organized by the frame grouping. The button is Figure 3.6 are all identified
by a functional label beneath each button and are referenced as such. The first frame
(stopFirst)has three instances of a button symbol named ButtonUp:

GotoAndPlay & Stop

On(release)

{
gotoAndStop(“playlt”);

}
GotoAndStop & Play

On (release)

{
gotoAndPlay(“StopMe”);

}
GotoAndStopat Go To

On(release)

{
gotoAndStop(“GoAway”);

}
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The button in the Stop Me and Away frames are additional instances of the
ButtonUpSymbol. They simply contain a play action and are labeled “Click to continue”.
Click to continue

On(realease)

{
Play();
}

Watch carefully when you run this movie. Scrutinize the movie as the message
that begins in the playit frame coasts by until the movie reaches the stop me
keyframe.However you will never see the message “Go Away!”. Why is it clearly in the
movie, but never viewed?

To solve the mystery of the missing message, consider the Action Script in the Go Away
Frame:
gotoAndPlay(“Away”);

As soon as the movie encounters the key frames with the Action Script, it
executes the action command and never stop to display the frame itself. As a result,
when the sample movie encounters Go to and Play(“Away”) in the Go Away frame, it

immediately past the frames that display the “Go Away” message.

Back and Forth between Frames and Scenes

Besides going to a specified frame by number or label, you may also write script that
sends your movie one frame ahead or back. In the previous section, you saw how movies
that jumped to a frame would either play or stop. If no script is in a frame when a Go to
and Play action is issued, the movie keeps playing. If a Go to and Stop action is selected,
the movie stops. However, no matter whether the action is Stop or Play, any action script

in a frame is initiated by a go to that frame.
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Next and Previous Frames:

This next set of actions goes just one frame forward or backward and stops. In most
respects, these action targets are like a gotoAndStop statement. Unless script is in the
frame, the movie stops. Because this action moves the playhead oneframe either forward
or backward, regardless of whether it is a keyframe or not, unlabeled frames can be
navigated relative to a timeline instead of to a specific frame number or label. The action
itself is quite simple and unique in that no “Go To” of any kind is mentioned. For
example, in the following button script, the command to go to the previous frame
specifies only the target:

on(release){

previrame();

}

The script for going to the next frame is equally simple.

nextFrame();

either action can be used in an MC, button, or frame.

Next and Previous Scenes:

ActioScript also contains a set of targets to the next or previous scene. The action
statements are almost identical to those for frames, but the next or previous scene
constitutes the targets. A move to the next scene in a button script would look like the
following:

on(release)

nextScene();

}

Going to a scene where the movie had just been uses a similar statement:

prevScene();

Going to another scene has interesting consequences. If you go frame by frame, the first
frame number of the new scene is 1 plus the frame number of the previous scene. For
example, if the last frame scene 1 is 30, the first frame in scene 2 will be 31 and can be
referenced as such. SO the statement

gotoAndPlay(31)
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would go and play Frame 1 of Scene 2. You could also use the statement.
gotoAndPlay(“Scene 2”,1)

to go to the same frame.

Frame labels are accessible across scenes anywhere in the main timelines. Flash will

search all scenes in the main timeline to find the one referenced in an action script.

Frames and Rates

When you are dealing with motion, you are often working with frames. A frame is

a snapshot of what you are currently depicting such as a blue circle on a light gray
background:

A single frame by itself does not really convey much. Get enough of these frames (with

some slight changes in what you are depecting) and start cycling through them:

The end result is an animation. There are two things that determine how well your

animation works - the number of frames and how quickly you change these frames

Number of Frames

Creating the illusion of motion requires a transition between two points. How jerky or
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smooth the transition depends partly on how many intermdiate points you define. Let's
say | have an example of a circle scaling and shifting over a period of time:

You have a starting point, an ending point, and a few intermediate points where the
circle's scaling and shifting are defined. This entire animation is only five frames long.
To contrast that, let's add more intermediate frames to define this animation:

This time around, more of your circle scaling and shifting is explicitly defined. There are
around 20 frames that make up our animation this time.

Based on just what I've provided, which one would you think looks smoother when
played back? This depends, as you will see in the next section, on the frame rate. If you
were to ignore the frame rate for a moment, with both animations played back at the same
frame rate, the one with more intermediate frames would look smoother because there are

more points defined.
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Frame Rate

The next thing we will look at is the frame rate. The frame rate determines how many
frames are played in a given second of time. This value is measured in frames per

seconds or fps for short:

number of frames

fps = second

The higher your fps the faster your animation will proceed to completion because you are
running through all of your frames at a faster pace. Likewise, the slower your fps, the
slower your animation will proceed to completion. You saw this much in the Flash
example above where, when you slowed your frame rate down greatly, the animation
looked really jerky.

The frame rate you will use determines largely on what you are creating. In general, I like
to use 24 as a good number for the frames per second for the content that | create. This
means that every second of animation requires 24 frames. In the more recent versions of
Flash, the default frame rate is set to 24 as well. If you remember long ago, Flash used
used to be 12 (or was it 157?).

You can easily get away with great animations whose frame rates are either lower or
higher than 24. The thing you need to keep in mind, especially when working with Flash,
is performance. A higher frame rate requires a user's computer to do more work to cycle
through all of the visual information quickly. Having a high frame rate on simple content
should not be a problem. Having a high frame rate on visually complex content may be a
problem with many of your users viewing your content at a lower frame rate than what

you would have preferred.
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Flash and Frames and Rates

Flash, like many digital animation programs, abstracts away a lot of the details
related to frames and frame rates. In fact, all you really ever have to worry about is your
frame rate and how long your animation will be running for. Generating intermediate
frames are taken care of by the tweening engine. The only times you have to worry about
the intermediate frames is if you are actually drawing each frame by hand.
Let's look at how what you learned in the previous page applies in practice. For a 1

second animation, your timeline will look as follows:

TIMELINE

«

al o b WO 4 s Ls

The key things to notice are the values at the bottom right. The duration of the animation
is 1 second, the frames per second is 24, and the playhead is currently on Frame 24. If |
change the frame rate to 12, as you can guess, it now takes twice as long for the

animation to finish:
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The duration of my animation jumped from 1 second to 1.9 seconds. Despite all of this

changing, notice that I never had to define additional frames. This should seem very

casual because the equation for determining the frame rate is number of frames divided

by the duration. You can mathematically manipulate these variables to solve for the

missing value. A 24 frame animation with a frame rate of 12 frames per second will take

around 2 seconds to finish.

Using the Ul to Change the Frame Rate

i W properties
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The most common way to change your frame rate is to use the Properties panel and
change it globally for your entire application:

The default rate is 24 in more recent versions of Flash, and like I mentioned in the
previous page, that is a good value to keep your frame rate at.

Programmatically Changing the Frame Rate

When you are working with more interactive types of animations, you may want to
change your frame rate while your application is running. Fortunately, in ActionScript 3,
you have easy access to the frame rate property.

The way you access the frame rate is through:
stage.frameRate

Because stage is global, you can call the frameRate property from pretty much anywhere
in your application. You can easily set the frame rate value as well since this is a property

that you can both read and write:
stage.frameRate = 25;

That's all there is to programmatically being able to set the frame rate.

Timelines:

The timeline is the area on the screen where you will be working with layers and frames
to alter your movie's content and animation. A movie is a collection of frames and the
timeline is the area in Flash where you will be configuring those frames (like the way a
cartoon is made, with a collection of still pictures run together really fast to give the

illusion of motion). Below you can see a visual description of the timeline:
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individual frame

7 10 15 25 30 35 40 45

il

frames per second

4 wlw| B Y[ 1 [rzoks [ o0s 4

current frame/ Nquth of movie
in seconds

Current Frame: The current frame indicates the frame number whose contents are

directly visible on the stage (see stage below) and is the current position of the play head.
So, what you see on the stage, when there is no movie playing, is the current frame.

Frames per second: Frames per second (or Frame rate) is the actual frames per second

setting for your movie, when the movie is not playing. When the movie is playing, it
dynamically shows the actual playback speed. However, frames per second and actual
playback speed can differ dramatically based on the processor of the computer being
used. Frames per second will always stay the same, but with a slower processor a user
will view slower actual playback.

Length of Movie: The term "length of movie in seconds” may be a little deceiving. The

number is actually the elapsed time between the first frame of the movie and the current
frame. Depending on where you place the playhead, the number will dynamically change
as well.

Playhead: The playhead allows you to select the frame to be altered. It also allows you to
view the movie by scrubbing, or dragging the playhead across the timeline ruler.

The output created with Macromedia’s Flash program is called a movie - an animated
movie. When learning to make a Flash movie, it helps to view the work areas in terms of
movie making. The Timeline is one of the most important areas which can be compared

to the editing area of the movie set. Flash uses Timelines to plan and lay out the movie,
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allowing you to choose where and when a particular object starts, how long it runs, and
where and when it ends.

The Timeline consists basically of blocks laid in a linear pattern - each block or
frame represents a moment in time. Just like the frames in a movie reel, only laid out flat
for you to work with. The major components of the Timeline are layers, frames, and the
playhead. Special frames called keyframes mark significant changes in the timeline.
Keyframes are used to designate a special effect such as a motion change, morphing, a
change in scenery or alpha blending. A keyframe span have a light-gray background and

consist of a single keyframe followed by one or more frames of identical content.

Flash 5 offers two different formats of timelines: the original one that users of earlier
versions of Flash, especially version 4 are used to. The other version mimicks the
timelines used in Macromedia Director. Experienced Flash designers often first use
storyboards to map out their movies, just as cartoon, commercial or animation designers
would do, before actually working with the Flash timelines.

Layers are organized in a column to the left of the Timeline. Frames contained in
each layer appear in a row to the right of each layer’s name. The Timeline header
indicates the frame number. The playhead points out which is frame is the current one
being displayed on the movie’s stage. You can add, delete, and move frames around
within the Timeline. You can also add tweening and frame actions, which are signified
using keyframes. For instance, if you wanted two objects to move at once, you would
need to create two layers with two different timelines. You would then set frames and
build tweens for the objects on those lines. Eventually, you end up with a hierarchy of
timelines, just as you would have a hierarchy of files or directories in other programs.

Once your objects (text, images, sounds) are prepared, begin to place them into
the scene, at particular points in the timeline by assigning each image to its own layer.
The timeline controls actions in a linear way, even though symbols can have their own
timelines and act independently of other elements in the scene.

Each black circle on the timeline represents one frame of your animation. The
illusion of movement is created by having images in different locations on successive

frames. The smoothness of the animation is determined by how similar the images are
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from frame to frame. Many small changes to the image in each successive frame will
make the animation appear smoother than a few large changes. However, the smaller the
changes per frame the more frames are required to make the complete animation.

The other important factor is the number of frames that are displayed per second.
As the frames per second (fps) increase, more frames can be packed into the same
amount of time, and thus smaller changes can be made on each frame making the
animation smoother. Flash defaults to 12 fps, which is shown beneath the layer timelines.
You can change the fps by double clicking on the indicator. 12 fps is good rate for web-
based animation since it minimizes file size yet keeps the animation smooth

The timeline shows you the key frames in your animation. Most computer
animation is created by using key frames. These key frames indicate the final positions or
changes to the symbol or graphic. Flash calculates the in-between frames for you to make

your animation flow from keyframe to keyframe.

How to Create an Interactive Timeline in Flash

Timelines are compelling ways to express information in an online environment. From
historical sites to an illustration of the family tree, a timeline is a quick way to see the
order of events that have happened in the past. An ordinary timeline can be created with
just a graphic imaging program, but it will be static and non-interactive. Flash allows for
the creation of an interactive timeline that will display appropriate data or information

when the user clicks or mouses over certain sections

Plan & Design Your Timeline

1.Before you get into Flash, you will find it much easier if you design your Timeline
using pen and paper. First draw the timeline as you see it.

2. Include areas on the timeline where events take place, such as the dates. These should
be indicated with lines that are perpendicular across the main timeline.

3.Write a brief description of what takes place at each event. You will be able to include
as much or as little information as you want in the program. A brief note is sufficient for
now.

4.Decide on graphics that you will want in your timeline, if any.
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Draw your Timeline in Flash & Create Objects

The first thing you will do in Flash is to create the main timeline itself. This can
be as simple as a line drawn with the line tool, or an image you import. For this example
we will use a straight line drawn from left to right across the middle of the stage.

Create your event objects. Event objects are the perpendicular hash marks or lines
on the main timeline that indicate where something has happened. You only need to
create one for this timeline. Simply draw a vertical line that is large enough to have
presence if laid across your main timeline. Do not create it on your timeline.

Convert the event object to a symbol. With the line to represent your event object
selected, press "F8" to convert it to a symbol. Give it any name that you can remember,
such as "eventObject."”

Place your event objects on the timeline. Now that your event object is a symbol
you can drag as many instances of it out of the library (press CTRL+L to view the
library) and onto the stage as you need. Place as many event objects on the stage as you
need for your timeline in the appropriate places.

Create your main text/information area. Use the text tool to draw out a text box on
the stage anywhere near your timeline. This is where the information for each
eventObject will appear when the user puts their mouse over it. With the empty text field
selected in the Properties Inspector for the type of text, make sure the dropdown box is

set to "Dynamic Text™" and in the field for the instance name, call it "myText."

Program your Timeline

Select the first eventObject on your timeline. In the Properties Inspector, give it a
name like "eventObjectl.” Select the second eventObject in your timeline and give it a
unique name as well such as "eventObject2." Do the same for all of your event objects.

Open the ActionScript panel by pressing "F9" on your keyboard. Make sure the
first keyframe in the timeline is selected.

Assumning you named your eventObject as the example, paste in this code:
eventObjectl.onRollOver = overl;

eventObjectl.onRollOut = out;
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function over1(){

myText.text = "Put whatever you want between these quotes";
}

function out(){

myText.text=""

}

Repeat step, changing the appropriate parts of the code and the text that appears
between the quotes for each eventObject as appropriate. This code will have the text you
choose appear whenever someone rolls their mouse pointer over the specific timeline
event. When they roll their pointer away, the text will disappear.

If you want to add images to each section, you can do so by either manually
placing them on the stage next to each eventObject or by using code to make them appear

and disappear onRollOver and onRollOut using the ._alpha feature

Actions from External script:

If you have certain code that you use repeatedly win scripts, write it once and then
access it whenever we want to use it in a script. You can Actionscript code in any text
editor such as notepad or simple text. Flash 5 introduces the action that can be used to
open a script written in an external text file. The format is fairly straightforward. For
example , the following button script opens a text file named “remote.as”.
on(release) {

#include “remote.as”
}

The path to the external file is the same as for any URL. External file is stored in
the same directory as the SWF file, no special directory list needs to be included.

In using the include statement in a button or MC script, do not include an event handler in
the external text file. Any event handler, such as on(release) brings in the code itself from
the text file and launches it. An additional event handler negates any action from taking

place. For example, if you wanted a button to send the movie to a frame named “Score”.
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gotoAndStop(“Score”);

The button script would have just the event handler and the include action to call the next
file with the script in it.

Flash ActionScript loops

ActionScript loops are tools used to execute a segment of code repeatedly for a number
of times or while a certain condition is satisfied. This can save time and effort by not

having to type the same code multiple times to repeat a process.

For example, if we wanted to duplicate a movie ten times, without a loop, we would have

to type the same code ten times.

Using a loop to do this would reduce the amount of code significantly while generating
the same identical result. Below is an example of the same command to duplicate a movie

ten times using a loop.

for (i=1;i<11;i++){
duplicateMovieClip("movie_mc", "new_"+i, i);

¥

Loop Types

There are three main types of ActionScript loops, the for loop (which we used in the
example above), the while loop, and the do-while loop. The for and while loops do

exactly the same thing but with different syntax, the do-while loop differs in one small

aspect. We will go through all of these types in turn.

The For loop
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| think that the For loop is the most commonly used because it is the most compact and

the easiest to understand and use. You can use this loop to execute a number of code

statements multiple times using this format:

for (counter; condition; action){

statements;

¥

The example above shows the syntax used, the counter (1) sets the starting point for your

counter, the condition will determine the point at which the loop will have to stop, and
the action operate counter to eventually make it make the condition untrue to stop the

loop. The code to be repeated is placed with in the curly brackets.

For example, if we want to output some text ten times, we can do it this way.

for (i=1; i<11; i++){
trace ("This code is repeated ten times");

¥

In regular words the code above says, start counting i from 1, repeat the code below as
long as i is less than 11, and add 1 to i each time the loop is repeated. We start with i as

1, when the code is repeated the first time then the value of i increases by 1 making it

equal 2, when the code is repeated again it becomes 3, then 4, 5, 6, 7, 8, 9, and 10. After

that it becomes 11, and at that moment the condition is no longer satisfied because i is

not less than 11 (i>11), and so the loop ends at that point.

The While loop

The while loop repeats a set of code as long as the condition specified is true.
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while (condition) {
statements }

This looks very similar to a conditional, which execute a code once if the condition is
satisfied, but here the code is executed repeatedly instead of just once. If the condition
remained true forever, this means the loop will be repeated over and over again forever as
well, and that should be avoided at all costs, because an infinite loop will crash the Flash
player. So there is usually something within the statements that eventually makes the

condition untrue.

vari=1;

while (i < 5){

trace ("This code is repeated™);

i++; }

In the example above, the code will get repeated as long as i is less than 5, we made

sure that 1 increases by 1 each time the loop is cycled through.

The Do-While loop

This type of loop runs the code to be repeated before checking for the condition so that it
guarantees that the code is executed at least once whether the condition is satisfied or not.

It is used in the following format:

do { statements;

} while (condition);

This loop could just be used like the previous two as shown in the example here.

vari=1;

do { trace ("This code is repeated");
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i++;

Jwhile(i<5);

The upper example is exactly the same as the one we used for the while loop, but this
one would execute the code once even if 1 was never less than 5 (for example, if we set

its value of i as 10 from the start).

Practical Examples of loop Usage

Loops are very often used to manipulate and access the content of arrays. Arrays are lists
of data under which each item is identified by its order within the list. It is possible to
extract all the contents of an array using a simple for loop as illustrated in the example

below.

var oman3d = ["home", "tutorials"”, "features"”, "competitions”, "forum"];
for (i=0; i<oman3d.length ; i++){
trace (oman3d[i]);

¥

The code above cycles through the array as long as does not exceed the total number of
items within an array (its length). The code should be self-explanatory if you understand

the basics of arrays.

Another common use of loops involves the creation and control of dynamic movieclips.
While the process for creating such movieclips is quite easy using a loop, referencing to

these movieclips to control them later on can be quite tricky. The easiest method for
achieving that is by using the square brackets to generate those references dynamically.
The example below shows you how movieclips are created and then positioned next to

each other using a loop. The name of each movieclip is generated in the second line and

called back in the third line using the square brackets.
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for (i=1;i<6;i++){
duplicateMovieClip("movie_mc", "new_"+i, i);
this["new_"+i]._x=this["new_"+i]._width*i;

by

You can alternatively save the reference to the movieclip in a temporary local variable

which you can use within the loop to easily refer to your various movieclips in turn.

for (i=1;i<6;i++){
duplicateMovieClip("movie_mc", "new_"+i, i);
temp_mc = this["new_"+i];

temp_mc._x=temp_mc._width*i; }
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PART-B
POSSIBLE QUESTIONS (8 Marks)
Write about the Basic Action Play, Stop, and Back & Forth in detail.

Discuss in detail about Loops.

Explain about Between Frames & Scenes in Flash with an Example
Write short notes on External Scripts.

Explain about Timelines in flash.

S A

Illustrate the steps in creating an external script file and include it in the movie
creation

7.Create a movie with buttons in action script.
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Two of the most important actions in the flash are and -
1
------------ layer is used for setting a variable in a single frame on to the layer.
2
The ----------- property returns the current frame it specified MC or the main time line
3 through root.
Flash 5 introduces the ---------- action that can be used to open a script written in an
4 external text file.
When data from multiple fields is placed in the same field, the data already in that field
5 e
6 is used to open the frame panel
7 - property returns the current frame of a specified MC
8 command is used to stop the script
9 movie clips have their own
10 Flash provides basic types of looping actions.
In the loop, a condition at the beginning of the loop specifies the conditions
11 under which the loop terminates
the loop specifies a beginning value, a termination condition and the
12 counter for the loop
13 loop applies only to properties of objects.
14 loops are contained in a single frame, button or movie clip script.
15 loops exisiting within other loops are called as loops
16 The layer in a movie contains the background patterns.
The ----------- event is triggered by placing the mouse pointer on the button and pressing
17 it.
18 A statement excutes a process for n number of times
19 The statement gotoAndPlay(5) plays the frame
The syntax for moving to next frame is
20
The syntax to go to previous frame is
21
22 the function moves script to the next scence
23 The fucntion moves script to the previous scence
24 |A frame can be inserted by function key.




when you use a action at a frame with a Play action , themovie just keeps

25 on going.
26 | All of thebuttons contain variable codes to show the current frame.
27 Ususally button is used to move to the previous frame.
28 You can write actionscript code in any
29 A expression is used to determine when a loop should stop running
30 |All loop actions take place between the brackets.
31 Structured loops have similar conditional structures as the condition
32 Each element in an array can be identified by a number, beginnning with

Loops are often used to go through the and either assign values or pull them
33 out.
34 the command is used to open the align panel
35 A is made up of a name and a value.

he organizes and controls a document’s
36 content over time in layers and frames.
37 The timeline represents all of an animation
38 Each block or mark in a timeline represents a single frame.
39 Frames are numbered in increments of (by default) along the top of the timeline.
40 The is the red rectangular marker located within the frame numbers.
41 To stop your movie after it has played, use function .
42 add a higher level of interactivity to your Flash animations
43 and Illustrator can both use bitmaps and vector images.

are defined as 'movies within movies whose properties and

44 timelines are independent of the main movie'.

The property returns a Scene object that represents
45  |the scene that is currently playing.
46 SWEF stands for
47 is a file extension for a Shockwave Flash file format
48 The file format is the "master" document format for Flash projects.
49 event is triggered when you click the button.
50 event if triggereed, when you clicked the button, then released your mouse.
51 stops the timeline from playing.
52 starts playing the timeline.
53 goes to the next frame.
54 goes to the previous frame.
55 stops at the frame you specify.
56 goes to and starts playing at the frame you specify.
57 goes to the next scene.
58 goes to the previous scene.
59 Audio files embedded in flash takes time to download
60 |Flashis based
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1.
a.
C.

2

d.
C.

3.

a

7.

PART-A (20*1=20 Marks)
(Answer All The Questions)

The people who weave multimedia into meaningful tapestries are
Multimedia producers b. Multimedia developers
Multimedia Projectors d. Multimedia Creatures.
.____multimedia allows an end user to control what and when the elements delivered.
Hyper media b. Interactive Multimedia
Non interactive Multimedia d. Non Hypermedia
A family of graphic characters that usually include many type sizes and styles is called
. type face b. font c. point d. link
A is a collection of characters of a single size.

. Attribute  b.font  c.group d. link

. The taller-than-wide orientation used for printed document is called
. Portrait  b. Newsscape  c. Netscape d. Unicode

. CSS stands for .
. cascading sheet styles b. cascading style sheets
C.

cascading spread styles d. cascading spread sheets

The paints a copy of the selected state or snapshot into the current image

window.

a.

8.
a.

9.

Paint Bucket tool b. Art History brush tool c. History Brush tool d. gradient tools

The let you to attach written or audio notes to your document.
crop tool b. annotation tool c. slice tool d. shape tool

VR stands for

1]
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a. Virtual reality b. Visual random c. Video raster d. Video response

10. The fills similarly colored areas with the foreground color.
a. Paint Bucket tool b. Art History brush tool c. History Brush tool d. gradient tools

11. palettes displays the names of its colors.
a. .swatches b. info c. layers d. history

12. MPEG stands for
a. Moving Picture Expert Group b. Movie Picture Expert Group

c. Music Pic Expert Group d. Media Picture Expert Group

13. application is used for viewing and converting still images among
many standard image-file formats.

a. Viewer b. Editor c. Converter d. Picture Viewer

14. schemes preserve the original data precisely.

a. Lossy b. Lossless  c. decompression d. Transferring

15. tool enables to select a foreground and background color in any of

several ways.
a. painting  b. brushes c. history d. color picker

16. is the artists term for trimming away unwanted parts of a picture.
a. crop  b. Single column marquee c. Magic Wand d. Magnetic Lasso

17. Which of the following is multimedia software?
a. 3D Studio b. SPSS c. Tally d. Inspro

18. is searching for a word with any of its possible suffixes.
a. Association b. truncation c. frequency d. categories

19. Leading is the space between :
a. Alignment b. words c. characters d. lines

20. Multimedia elements are typically seen together into a project using :
a. Editing tools  b. Unauthoring tools  c. Integrated Tools  d. Authoring Tools

PART - B (3* 10 = 30 Marks)
(Answer ALL the Questions)

21. a) Discuss in detail about basic software tools for making multimedia.
The tools used for creating and editing multimedia elements on both
Macintosh and windows platforms support the authoring systems.

e Text editing and word processing tools:
1. Itis usually the first software tool computer users learn.
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2. From letters,invoice,and storyboards to project content
3. Workgroup will choose a single word processor to share documents in a
standard format.
Include spreadsheet,database,e-mail,Web browser and presentation
applications.
Word processors such as
% Word and WordPerfect

RO

¢+ Include spell checkers,table formatters prebuilt templates for

RO

% letters,resumes,purchase orders.

R

% Multimedia elements such as sounds,images and video.

X/

*
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%+ Optical Character Recognition.

% Often you will have printed matter and other text to incorporate into
your project, but no electronic text file. With Optical Character
Recognition

% (OCR) software, a flat-bed scanner and your computer you can save
many hours of typing printed words and get the job done faster and
more accurately.

% Reading 8 to 36 point characters at 300 dpi(dots per inch)

% Processing speeds 150 charaters per second.

% The text areas of the images are then converted to ASCII characters
using probability and expert system algorithm.

% Ex: Perceive

+ OCR — for printed text recognition
+ ICR — for hand-printed text recognition

+ OMR - for marks recognition



http://en.wikipedia.org/wiki/Optical_character_recognition
http://en.wikipedia.org/wiki/Intelligent_character_recognition
http://en.wikipedia.org/wiki/Optical_mark_recognition
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0‘0

» OBR - for barcodes recognition

0‘0

» BCR — for business cards recognition

0‘0

» DLR - for document layer recognition

e Painting and Drawing Tools:

% Painting and drawing tools are the most important items in your toolkit
because the impact of the graphics in your project will likely have the
greatest influence on the end user.

% Painting software is dedicated to producing excellent bitmapped images

L)

>

X/
*

Such us Photoshop,Picture Publisher,and Fractal Design Painter
Drawing software is dedicated to producing vector based line art that is
easily printed to paper.

» Drawing packages include powerful and expensive computer-aided
design (CAD) software.

Such us CorelDraw,FreeHANnd Canvas.

software applications combine drawing and painting capabilities.

But many autoring systems can import only bitmapped images.

Ex: DeskDraw, DeskPaint, Designer

L)

X/
X4

L)

DS

X/
X4

L)

X/
X4

L)

7/
X4

L)

7/
X4

L)

The following features in a drawing or painting packages:

% Paint tools to create geometric shapes,from squares to circles and from
curves to complex polygons.

Ability to pour a color,pattern or gradient into any area.

Ability to paint with patterns and clip art.

Eyedropper tool that samples colors.

Zooming for magnified pixel editing.

Multiple undo capabilities to let you try again.

Airbrushing in variable sizes,shapes,and pattens

Washing colors in gradients,blending and masking.

Support for scalable text fonts and drop shadows.

3

0

3

0

3

0

3

0

3

0

5

S

5

S

5

S

e 3-D Modeling and Animation Tools

% 3 — D modeling software objects rendered in perspective appear more
realistic

¢+ We can create stunning scenes and wander through them.

% Choosing the right lighting and perspective for you final rendered image.

s Powerful modeling packages such as Macromedia’s Estreme
3D,AutoDesk’s 3d studio Max.

+ Application also include export features enabling to save a moving view.

¢ Each rendered 3-D image takes from a few seconds to a few hours to
complete

¢+ Depending upon the complexity of the drawing and number of drawn

objects.

R/

Features
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*
°e

Ability to drag and drop primitive shapes into a scene.

Color and texture mapping.

Ability to add realistic effects such as transparency.shadowing and fog.
Ability to draw spline-based paths for animation.

Unlimited cameras with focal length control.

*
°e

*
°e

¢

o
A5

*
°e

e Image-Editing Tools

X4

Image editing applications are specialized and powerful tools for
enhancing and retouching existing bitmapped images.

These programs are also indispensable for rendering images used in
multimedia presentations.

*,

*
o

o

Modern versions of these programs also provide many of the features and
tools of painting and drawing programs, and can be used to create images
from scratch as well as images digitized from scanners, digital cameras or
artwork files created by painting or drawing packages.

Ex: Photoshop

o

Features

X3

S

Multiple windows provide views of more than one image at a time.
Good masking features

Multiple undo and restore features.

Direct inputs of images from scanner and video sources.

Conversion of major image-data types and industry standard file formats.

X3

S
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Sound editing tools for both digitized and MIDI sound let you see music as
well as hear it.

% By drawing the representation of the sound in a waveform, you can cut,
copy, paste and edit segments of the sound with great precision and
making your own sound effects.

Using editing tools to make your own MIDI files requires knowing about
keys, notations and instruments and you will need a MIDI synthesizer or
device connected to the computer.

Many MIDI applications provide both sequencing and notation
capabilities

Need a MIDI synthesizer or device connected to computer.

MIDI files and multimedia project without learning any special skills.
Editing software such as Creative Labs,WaveStudio.

Ex: SoundEdit Pro

¢

*
o

*
o

X3

A5

X/
X4

L)

X/
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e Animation Video and Digital Movie Tools
+ Animations and digital movies are sequences of bitmapped graphic scenes
(frames), rapidly played back.

++ But animations can also be made within an authoring system by rapidly
changing the location of objects to generate an appearance of motion.
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% Movie-making tools let you edit and assemble video clips captured from
camera, animations, scanned images, other digitized movie segments.
% The completed clip, often with added transition and visual effects can be
played back.
(OR)
b) (i) Explain the stages of developing a multimedia project.
Stages of a Multimedia Project:

(1) Planning
« Planning involve:-
o Developing an idea
= |dentifying Objectives and Users
o ldentify Skills and Resources
o Developing a graphic template, the structure, and a navigational system.
= Estimating Time and Cost
= Develop a small prototype or proof of concept
(2) Design and Production
= The planned tasks are performed to create a finished product.
= Task include storyboarding, designing a detail navigation structure, GUI
consideration and HCI consideration.
o The product is revised, based on the continuous feedback received from
the client by doing an evaluation.

]1(3) Testing
e The program is tested to ensure that it:
e meets the objectives of the project
e works on the proposed delivery platforms
e meets the client requirements.

(4) Deliver

« The final project is packaged and delivered to the end user.
Requirements for a Multimedia Project

Hardware
Software

Enabling Technology

Creativity &
Organizational Skills

Where to use multimedia

71
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Multimedia is media and content that uses a combination of different content
forms. The term can be used as a noun (a medium with multiple content forms) or as an
adjective describing a medium as having multiple content forms. The term is used in
contrast to media which only use traditional forms of printed or hand-produced material.
Multimedia includes a combination of text, audio, still images, animation, video, and
interactivity content forms.

Categorization of multimedia

Multimedia may be broadly divided into linear and non-linear categories. Linear
active content progresses without any navigational control for the viewer such as a
cinema presentation. Non-linear content offers user interactivity to control progress as
used with a computer game or used in self-paced computer based training.
Hypermedia is an example of non-linear content.

Multimedia presentations can be live or recorded. A recorded presentation may
allow interactivity via a navigation system. A live multimedia presentation may allow
interactivity via an interaction with the presenter or performer.

Usage

A presentation using PowerPoint. Corporate presentations may combine all forms
of media content. Virtual reality uses multimedia content. Applications and delivery
platforms of multimedia are virtually limitless.VVO Multimedia-Terminal in Dresden
WTC (Germany)Multimedia finds its application in various areas including, but not
limited to, advertisements, art, education, entertainment, engineering, medicine,
mathematics, business, scientific research and spatial temporal applications. Several
Examples are as follows:

Creative industries

Creative industries use multimedia for a variety of purposes ranging from fine arts,
to entertainment, to commercial art, to journalism, to media and software services
provided for any of the industries listed below. An individual multimedia designer may
cover the spectrum throughout their career. Request for their skills range from technical,
to analytical, to creative.

Commercial

Much of the electronic old and new media used by commercial artists is multimedia.
Exciting presentations are used to grab and keep attention in advertising. Business to
business, and interoffice communications are often developed by creative services firms
for advanced multimedia presentations beyond simple slide shows to sell ideas or liven-
up training. Commercial multimedia developers may be hired to design for governmental
services and nonprofit services applications as well.

Entertainment and fine arts

8]


http://en.wikipedia.org/wiki/Media_(communication)
http://en.wikipedia.org/wiki/Content_(media_and_publishing)
http://en.wikipedia.org/wiki/Content_format
http://en.wikipedia.org/wiki/Content_format
http://en.wikipedia.org/wiki/Writing
http://en.wikipedia.org/wiki/Sound
http://en.wikipedia.org/wiki/Image
http://en.wikipedia.org/wiki/Animation
http://en.wikipedia.org/wiki/Footage
http://en.wikipedia.org/wiki/Interactivity
http://en.wikipedia.org/wiki/Movie_theater
http://en.wikipedia.org/wiki/Interactivity
http://en.wikipedia.org/wiki/Computer_game
http://en.wikipedia.org/wiki/Computer_based_training
http://en.wikipedia.org/wiki/Hypermedia
http://en.wikipedia.org/wiki/Presentation
http://en.wikipedia.org/wiki/Spatial_navigation
http://en.wikipedia.org/wiki/Microsoft_PowerPoint
http://en.wikipedia.org/wiki/Virtual_reality
http://en.wikipedia.org/wiki/Platform_(computing)
http://en.wikipedia.org/wiki/Platform_(computing)
http://en.wikipedia.org/wiki/Dresden
http://en.wikipedia.org/wiki/Advertising
http://en.wikipedia.org/wiki/Art
http://en.wikipedia.org/wiki/Education
http://en.wikipedia.org/wiki/Entertainment
http://en.wikipedia.org/wiki/Engineering
http://en.wikipedia.org/wiki/Medicine
http://en.wikipedia.org/wiki/Mathematics
http://en.wikipedia.org/wiki/Business
http://en.wikipedia.org/wiki/Scientific_research
http://en.wikipedia.org/wiki/Visual_thinking
http://en.wikipedia.org/wiki/Creative_industries
http://en.wikipedia.org/wiki/Journalism
http://en.wikipedia.org/wiki/Old_media
http://en.wikipedia.org/wiki/New_media
http://en.wikipedia.org/wiki/Advertising
http://en.wikipedia.org/wiki/Creative_services
http://en.wikipedia.org/wiki/Governmental_services
http://en.wikipedia.org/wiki/Governmental_services
http://en.wikipedia.org/wiki/Nonprofit

First internal answer key

In addition, multimedia is heavily used in the entertainment industry, especially to
develop special effects in movies and animations. Multimedia games are a popular
pastime and are software programs available either as CD-ROMs or online. Some video
games also use multimedia features. Multimedia applications that allow users to actively
participate instead of just sitting by as passive recipients of information are called
Interactive Multimedia.

Education

In Education, multimedia is used to produce computer-based training courses
(popularly called CBTs) and reference books like encyclopedia and almanacs. A CBT
lets the user go through a series of presentations, text about a particular topic, and
associated illustrations in various information formats. Edutainment is an informal term
used to describe combining education with entertainment, especially multimedia
entertainment.

Journalism

Newspaper companies all over are also trying to embrace the new phenomenon by
implementing its practices in their work. While some have been slow to come around,
other major newspapers like The New York Times, USA Today and The Washington
Post are setting the precedent for the positioning of the newspaper industry in a
globalized world.

News reporting is not limited to traditional media outlets. Freelance journalists
can make use of different new media to produce multimedia pieces for their news stories.
It engages global audiences and tells stories with technology, which develops new
communication techniques for both media producers and consumers. Common
Language Project is an example of this type of multimedia journalism production.

Engineering

Software engineers may use multimedia in Computer Simulations for anything from
entertainment to training such as military or industrial training. Multimedia for software
interfaces are often done as a collaboration between creative professionals and software
engineers.

Industry

In the Industrial sector, multimedia is used as a way to help present information to
shareholders, superiors and coworkers. Multimedia is also helpful for providing
employee training, advertising and selling products all over the world via virtually
unlimited web-based technology

Mathematical and scientific research

In mathematical and scientific research, multimedia is mainly used for modeling and
simulation. For example, a scientist can look at a molecular model of a particular
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substance and manipulate it to arrive at a new substance. Representative research can be
found in journals such as the Journal of Multimedia.

Medicine

In Medicine, doctors can get trained by looking at a virtual surgery or they can simulate
how the human body is affected by diseases spread by viruses and bacteria and then
develop techniques to prevent it.

(1) Write short notes on hypermedia and hypertext

Hypermedia and Hypertext
Multimedia - combines text, graphics and audio
Interactive multimedia - gives user control over what and when content is viewed
(non-linear)
Hypermedia -provides a structure of linked elements through which user
navigates and interacts
Hyper media provides a structure of links
Hypertext words are linked to other elements
Hypertext is usually searchable by software robots

Normal Text

Hypermedia Structures

Hypermedia elements are called nodes

Nodes are connected using links

A linked point is called an anchor

Link - connections between conceptual elements (navigation pathways and
menus)

Node - contains text, graphics sounds

Anchor - the reference from one document to another document, image, sound or
file on the web

Link anchor - where you came from

Multimedia and Hypertext

o000 0

Hypertext system.

Using hypertext systems.
Searching for words.
Hypermedia structures.
Hypertext tools.
Hypertext System
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O Hypertext is defined as the organized cross-linking of words, images, and other
Web elements.

O A system in which words are keyed or indexed to other words is referred to as a
hypertext system.

O A hypertext system enables the user to navigate through text in a non-linear way.

Using Hypertext Systems

O Information management and hypertext programs present electronic text, images,
and other elements in a database fashion.

U Software robots visit Web pages and index entire Web sites.

U Hypertext databases make use of proprietary indexing systems.

U Server-based hypertext and database engines are widely available.

Searching for Words

U Typical methods for word searching in hypermedia systems are (cont):

» Adjacency

v Words occuring next to one another, usually in phrases or proper
names

» Alternates
v" Applying OR

» Association
v" Applying AND

O Typical methods for word searching in hypermedia systems are (continued):
> Negation
v' Applying NOT
» Truncation
v Words with its possible suffixes
> Intermediate words
» Frequency

Hypermedia Structures

4 Anchors.
» Anchor is defined as the reference from one document to another

document, image, sound, or file on the Web.
» The source node linked to the anchor is referred to as a link anchor.
» The destination node linked to the anchor is referred to as a link end.

11|
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U Navigating hypermedia structures.
» The simplest way to navigate hypermedia structures is via buttons.
» Location markers must be provided to make navigation user-friendly.

Hypertext Tools

U Two functions common to most hypermedia text management systems are
building (authoring) and reading.
U The functions of ‘builder’ are:
» Creating links.
» ldentifying nodes.
» Generating an index of words.

22. a) Discuss in detail about the usage of multimedia in different environment with
examples.

Usage of multimedia

A presentation using Powerpoint. Corporate presentations may combine all forms
of media content.Virtual reality uses multimedia content. Applications and delivery
platforms of multimedia are virtually limitless.VVO Multimedia-Terminal in Dresden
WTC (Germany)Multimedia finds its application in various areas including, but not
limited to, advertisements, art, education, entertainment, engineering, medicine,
mathematics, business, scientific research and spatial temporal applications. Several
Examples are as follows:

Creative industries

Creative industries use multimedia for a variety of purposes ranging from fine
arts, to entertainment, to commercial art, to journalism, to media and software
services provided for any of the industries listed below. An individual multimedia
designer may cover the spectrum throughout their career. Request for their skills
range from technical, to analytical, to creative.
Commercial

Much of the electronic old and new media used by commercial artists is
multimedia. Exciting presentations are used to grab and keep attention in advertising.
Business to business, and interoffice communications are often developed by creative
services firms for advanced multimedia presentations beyond simple slide shows to sell
ideas or liven-up training. Commercial multimedia developers may be hired to design for
governmental services and nonprofit services applications as well.
Entertainment and fine arts

In addition, multimedia is heavily used in the entertainment industry, especially to
develop special effects in movies and animations. Multimedia games are a popular
pastime and are software programs available either as CD-ROMs or online. Some video
games also use multimedia features. Multimedia applications that allow users to actively
participate instead of just sitting by as passive recipients of information are called
Interactive Multimedia.
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Education

In Education, multimedia is used to produce computer-based training courses
(popularly called CBTs) and reference books like encyclopedia and almanacs. A CBT
lets the user go through a series of presentations, text about a particular topic, and
associated illustrations in various information formats. Edutainment is an informal term
used to describe combining education with entertainment, especially multimedia
entertainment.

Journalism

Newspaper companies all over are also trying to embrace the new phenomenon by
implementing its practices in their work. While some have been slow to come around,
other major newspapers like The New York Times, USA Today and The Washington
Post are setting the precedent for the positioning of the newspaper industry in a
globalized world.

News reporting is not limited to traditional media outlets. Freelance journalists
can make use of different new media to produce multimedia pieces for their news stories.
It engages global audiences and tells stories with technology, which develops new
communication techniques for both media producers and consumers. Common
Language Project is an example of this type of multimedia journalism production.

Engineering

Software engineers may use multimedia in Computer Simulations for anything from
entertainment to training such as military or industrial training. Multimedia for software
interfaces are often done as a collaboration between creative professionals and software
engineers.

Industry

In the Industrial sector, multimedia is used as a way to help present information to
shareholders, superiors and coworkers. Multimedia is also helpful for providing
employee training, advertising and selling products all over the world via virtually
unlimited web-based technology

Mathematical and scientific research

In mathematical and scientific research, multimedia is mainly used for modeling and
simulation. For example, a scientist can look at a molecular model of a particular
substance and manipulate it to arrive at a new substance. Representative research can be
found in journals such as the Journal of Multimedia.

Medicine
In Medicine, doctors can get trained by looking at a virtual surgery or they can simulate

how the human body is affected by diseases spread by viruses and bacteria and then
develop techniques to prevent it.
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(OR)
b) Write about Font Editing & Design Tools with neat sketch.
Fonts Editing and Design Tools

U Macromedia Fontographer
» Fontographer is a specialized graphics editor.
» It is compatible with both Macintosh and Windows platform.
> It can be used to develop PostScript, TrueType, and bitmapped fonts.
» It can also modify existing typefaces and incorporate PostScript artwork.

ﬁ! Fontographer 4.1 - |1 ¥
File Edit iew Element Foints
tdetrics Hints  YWindow  Help

B willegha - .. o[ x|

b=
1025, 873

U ResEdit
» Introduced by Apple Text to design text as a bitmap image.
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FMask

U Creating attractive texts.
> Applications that are used to enhance texts and images include:
v Adobe Photoshop
v' TypeStyler
v’ COOL 3D
v' HotTEXT
v' TypeCaster
Hypermedla and Hypertext
Multimedia - combines text, graphics and audio
« Interactive multimedia - gives user control over what and when content is viewed
(non-linear)
« Hypermedia -provides a structure of linked elements through which user
navigates and interacts
« Hyper media provides a structure of links
« Hypertext words are linked to other elements
« Hypertext is usually searchable by software robots
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Hypermedia Structures

Hypermedia elements are called nodes

Nodes are connected using links

A linked point is called an anchor

Link - connections between conceptual elements (navigation pathways and
menus)

Node - contains text, graphics sounds

Anchor - the reference from one document to another document, image, sound or
file on the web

Link anchor - where you came from

Multimedia and Hypertext

O O0o0o0opopoo

(M

Hypertext system.

Using hypertext systems.

Searching for words.

Hypermedia structures.

Hypertext tools.

Hypertext System

Hypertext is defined as the organized cross-linking of words, images, and other
Web elements.

A system in which words are keyed or indexed to other words is referred to as a
hypertext system.

A hypertext system enables the user to navigate through text in a non-linear way.

Using Hypertext Systems

Q

a
a
a

Information management and hypertext programs present electronic text, images,
and other elements in a database fashion.

Software robots visit Web pages and index entire Web sites.

Hypertext databases make use of proprietary indexing systems.

Server-based hypertext and database engines are widely available.

Searching for Words

a

Typical methods for word searching in hypermedia systems are (cont):

» Adjacency

v" Words occuring next to one another, usually in phrases or proper
names

» Alternates
v' Applying OR

» Association
v" Applying AND
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U Typical methods for word searching in hypermedia systems are (continued):
> Negation
v' Applying NOT
» Truncation
v Words with its possible suffixes
» Intermediate words
» Frequency

Hypermedia Structures

Q Anchors.
» Anchor is defined as the reference from one document to another
document, image, sound, or file on the Web.
» The source node linked to the anchor is referred to as a link anchor.
» The destination node linked to the anchor is referred to as a link end.

U Navigating hypermedia structures.
» The simplest way to navigate hypermedia structures is via buttons.
» Location markers must be provided to make navigation user-friendly.

Hypertext Tools

O Two functions common to most hypermedia text management systems are
building (authoring) and reading.
U The functions of ‘builder’ are:
» Creating links.
> ldentifying nodes.
» Generating an index of words.

23. a) Elaborate how to work in Photoshop.
WORKING IN PHOTOSHOP

Adobe Photoshop is software’s that will enable the students to use the various
tools and effects available for photo editing and graphic design.
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Because of the growth of technology in this day and age, it is necessary to have the
ability to work with digital media. This presentation is an introduction to the basics of
Adobe Photoshop.

CREATING NEW DOCUMENT

To create a new document, click File > New. This will open the Document Setup dialog
box

New
Name: |Untitled-1 R — — ]
_ Preset: | Default Fﬁotosﬁop Size R = l.lT' )
Size A t Save Preset... )
Width: l7—| inches m Delete Preset..
ight: | i [R R —
Helght S ! nche} L ( Device Central... )
Resolution: E72 | pixels/inch m
Color Mode: ' RGB Color F‘ 8 bit m :
Background Contents: White m Image Size: ! 300 ppl’ RGB’
E[ Advanced - A0
Mame: | Untitled-1 [ oK |
Preset: | Custom [V] — 1 | Reset |
Width: | 12 | Crm [v] [ Save Preset, ., ]
Height: 9 | cm [V]
Resolution: | 300 | pizels inch [V]
Color Mode: | RiGE Color [V] | 2 hit [V]
Image Size:
Background Conterts: | Transparent [V]
4,31M
% Advanced
Color Prafile: | Working RGE: sRGE [EC61966-2.1 | v|
Fixel szpect Ratio: | Square [V]

Step 3. Press Save Preset... and you will see the New Document Preset dialog box.

The program offers us to save the preset as "'12 cm x 9 cm™. It's quite a good name, so we
just press Ok to save the preset.
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[ )

Mew Document Preset
Preset Mame: | 12 cm X% 9 cm
Include In Saved Settings.

Resolution Content
Mode Profie
Bit: Depth PFixel Aspect Ratio

1 Walues not included in the saved preset
wiill default to their last used value.

Step 4. Next time you need the document of this size, just call the command File => New
and in the Preset fall-out menu in the New Document dialog box select the 12 cm x 9
cm' preset.

.Click File on the menu bar
e Click New
e Enter the required width in the Width text box
e Enter the required height in the Height text box
e Click OK

OPENING & SAVING AN FILES

If the image you have is saved on a disk, select File > Open, and then navigate
to the disk drive where your image is saved. Choose the image file and click Open.

To save your file, select File >Save As and type in the new name of the file in the dialog
box.

SAVING A FILE OPTIONS:

Use Save As to save a file under a new name and to preserve a copy of the
original file .Open a file in one file format (e.g., .BMP) and save it in another file format
(e.g., .JPG)

PHOTOSHOP SAVE FOR WEB:

The Save For Web dialog box doesn't provide as much flexibility in the output image
file formats as the Save As dialog, but it does offer more flexibility with each supported
option. Supported output file formats include:

e JPEG - Selection of Quality level (1-100). No transparency.
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e GIF - Different palette sizes (2-256) and dithering options define quality.

Supports single-bit transparency.
e PNG-8 - Reduced color depth (2-256 colors) and dithering options defines quality.

Supports multi-bit transparency.
e PNG-24 - "Lossless" 24-bit quality. Supports multi-bit transparency.

e WBMP - Black & White dithered output.

Sawve For Web - Powered By Imagefeady
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IMPORT AND SCANNED IMAGE
Get photos from scanners

s

Before you try to scan and open your photos in Elements Organizer, make sure that
you’ve installed all the software that came with your scanner. Carefully read any
documentation that came with your scanner to make sure that it’s connected properly to

your computer.

1. Make sure that your scanner is connected and switched on.
2. In Elements Organizer, do one of the following:

e Click Import. Select From Scanner.
e Select File > Get Photos And Videos >
From Scanner.
3. In the Get Photos From Scanner dialog box, choose the name of the scanner from
the Scanner menu.

(1 Click Browse to select a location for saving the photos.

[1 Choose a file format from the Save As menu. JPEG, the default format, is usually the
best choice. If you choose JPEG, drag the Quality slider to increase or decrease the
quality of the scan. The higher the quality, the larger the file size.
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Get Photos from X

Scanner: | CanoScan LIDE 100 >

Save Files in:
CAUsers\gimenhta\Pl. . .dobe\Scanned Photos Browse...

Quality: 6 (Medium)

Save As: Jpeg ™ -
2,

| oK | [ cancer

Quality slider

Click OK. If you’re using a scanner with a TWAIN driver, Elements Organizer launches
the driver that came with your scanner. Follow the instructions that came with the driver
software to scan your photo. Typically, you can also select an area to scan or correct any
color issues that you may see.

(OR)
b) Write short notes on Tools in Photo shop with a neat sketch.
TOOLS:
CROP TOOL
Selects and cuts parts of an image. I L
SLICE TOOL

Used to cut images into slices, which can be exported to a web page.

|

PATH SELECTION TOOL You use this tool when working with paths. Since this is

all about the basics, I won’t go into details. It’s related to the Pen Tool (see below)
though.

A Y

N, T
d @&

SLICE TOOL This is used mostly for building websites, or splitting up one image into
smaller ones when saving out. It’s kind of an advanced tool, and since you’re in here for
the basics, we’ll kind of skip over it. Kind a makes you mad | made you read all that for
nothing, huh?

G 7,
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THE SHAPE TOOLS

Photoshop gives us six Shape tools to choose from — the Rectangle Tool, the Rounded
Rectangle Tool, the Ellipse Tool, the Polygon Tool, the Line Tool, and the Custom Shape
Tool, and they’re all nested together in the same spot in the Tools panel. By default, the
Rectangle Tool is the one that’s visible in the Tools panel, but if we click on the tool’s
icon and hold our mouse button down for a second or two, a fly-out menu appears
showing us the other Shape tools we can choose from:

L | Rectangle Tool

|| Rounded Rectangle Toaol
o 2 Ellipse Tool
S @ Polygon Tool
{,“i" # Line Tool

&7 Custom Shape Tool

= O T e e

Healing Brush
O Corrects small blemishes in scanned photos.

O Select the tool, hold down the ALT key and left-click on the base color you need
to heal. Then left-click over the blemish.

Brush Tool

e Draws lines of different thicknesses and colors.
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e Select the tool. Then click on the selected area, drag to draw lines. Use the
Options bar to change the Brush, Mode, Opacity, and Flow.

r

Clone Stamp

U Takes a sample of an image and applies over another image, or a part of the same
image.

O Select the tool. Hold down the ALT key and left-click on a certain point of the
document where you want to start your copy point.

U Then, put your mouse over whatever part of the new document you want the
picture to go to. Hold down the left mouse button and drag the mouse across the
page to copy the picture.

Art History Brush

O Paints over an image using the source data from a specified history state or
snapshot.

O Select the tool, specify the Brush, Blending Mode,Opacity, Style, Area, and
Tolerance.

Erase Tool
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U Removes part of an existing path or stroke. You can use the Erase tool on paths,
but not on text.

U Select the tool, click on the part of the image you wish to erase. Drag to erase

pixels.
[ -

Paint Bucket Tool
U Fills and entire area with a specific color of your choice.
U Select the tool. Choose a foreground color in the Color Box.

U Select an area you wish to apply the color to. Click the tool button, then click on

the selected area.
l E 4

Applies a gradient fill to a selected part of the image or to an entire layer

o

Gradient Tool

Type Tool

O Types text on a page. Every time you click the Type Tool on a new portion of
the page a new layer will be created.

O Select the tool, click on the page and begin to type. You can specify the font and
size in the Options bar. You can also resize and transform the text box by
dragging the squares at the sides and corners. Use the Move Tool to move the
text on the page.
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T

O Draws a rectangle shape. Other shapes that are hidden in this tool are: Rounded

Rectangle Tool, Ellipse Tool ,Polygon Tool, Line Tool, and Custom Shape
Tool.

Rectangle Tool

U Select the tool, click and drag on the page to draw a shape. The shape will be
automatically filled with the current foreground color.

L

a4

ANNOTATION

The following list details the Annotation, Measuring, and Navigation tools:

Notes (N): Click and drag with this tool to create a virtual sticky note for the image
When you’re finished typing the text of the annotation, click the close button on the
note. Drag the note around by clicking and dragging the note’s icon. Open the note by

double-clicking it. Change the note’s color in the Options bar. Notes are nonprinting
elements.

SN
S\ N/

‘R
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PART-A (20*1=20 Marks)
(Answer All The Questions)

1. The Letter used as shortcuts for Marquee Tool
a.Q b. L c. A d M

2. Which among the following is not the selection tool
a. Marquee b. Move c. lasso d. Eraser

3. The file menu has a
a. Open recent command b.images c.windows d. palettes

4. The smudges data in an image.
a. Sponge tool b. Smudge tool c. Sharpen tool  d. Dodge tool

5. The hue value is changes from
a.0to 80 b. 0to 360 c.0to 30 d. Oto 100

6. tool creates hard-edged lines
a. Airbrush b. paintbrush C. eraser d. Pencil

7. The tool paints a copy of the selected state or snapshot into the current image
window.
a.Paint Bucket b. Art History brush  c. History Brush d. gradient

8. tool is used to create straight edged selection borders.
a.lasso tool b. elliptical tool c. polygonal tool d. slice tool

©

. The brush palette is attached to the bar
a. menu b. status c. tool d. option
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10. has various tools for editing the image
a.Palettes b. toolbox C. menubar d. interface

11. tool sprays paint or pixel on the canvas

a.Airbrush b. paintbrush C. eraser d. Pencil
12. The sharpens soft edges in an image.

a.Sponge tool b. Smudge tool c. Sharpen tool  d. Dodge tool
13. palettes displays the names of its colors

a. Swatches b. info c. layers d. history

14. The ratio of the height and width of the actual document
a.aspect ratio b.matrix ratio c. reference ratio d. max_ratio

15. If 0 is entered in the saturation box, the color will be

a.Gray b. red C. white d.black

16. lets you select a specific color in an image for use another part of your
image
a. Slice b. crop c. eyedropper d.magic wand

17. The Letter __ used as shortcuts for Lasso Tool

a.Q b.L c. A d M
18. The tool erases solid-colored areas to transparency with a single click.
a.Eraser b.Background Eraser c. Magic Eraser d. Light Eraser
19 is a two or three pixel border around an edge that blends into the adjacent color
to create a small transistion zone.
a. feather b. anti-alias c. marquee  d. stripes.
20. are horizontal or vertical lines that can be positioned anywhere on the image
surface.
a. guides b. grids c. rules d. lines

PART - B (3* 10 = 30 Marks)
(Answer ALL the Questions)
21. a) Discuss the various ways to save files in Photo shop.
OPENING & SAVING AN FILES

If the image you have is saved on a disk, select File > Open, and then navigate
to the disk drive where your image is saved. Choose the image file and click Open.

To save your file, select File >Save As and type in the new name of the file in the dialog
box.
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SAVING A FILE OPTIONS:

Use Save As to save a file under a new name and to preserve a copy of the
original file .Open a file in one file format (e.g., .BMP) and save it in another file format
(e.g., .JPG)

PHOTOSHOP SAVE FOR WEB:

The Save For Web dialog box doesn't provide as much flexibility in the output image
file formats as the Save As dialog, but it does offer more flexibility with each supported
option. Supported output file formats include:

e JPEG - Selection of Quality level (1-100). No transparency.

e GIF - Different palette sizes (2-256) and dithering options define quality.

Supports single-bit transparency.

e PNG-8 - Reduced color depth (2-256 colors) and dithering options defines

quality. Supports multi-bit transparency.

e PNG-24 - "Lossless" 24-bit quality. Supports multi-bit transparency.

e WBMP - Black & White dithered output.

Sawve For Web - Powered By Imagefeady
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IMPORT AND SCANNED IMAGE

Get photos from scanners

Before you try to scan and open your photos in Elements Organizer, make sure that
you’ve installed all the software that came with your scanner. Carefully read any
documentation that came with your scanner to make sure that it’s connected properly to
your computer.

1. Make sure that your scanner is connected and switched on.
2. In Elements Organizer, do one of the following:

e Click Import. Select From Scanner.

e Select File > Get Photos And Videos >
From Scanner.
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3. In the Get Photos From Scanner dialog box, choose the name of the scanner from
the Scanner menu.

(1 Click Browse to select a location for saving the photos.

1 Choose a file format from the Save As menu. JPEG, the default format, is usually the
best choice. If you choose JPEG, drag the Quality slider to increase or decrease the
quality of the scan. The higher the quality, the larger the file size.

Get Photos froen Scannes xX

Scanner: | CanoScan LIDE 100 w

Save Flles In:
Causers\gimenta\Pl...dobe\Scanned Photos |  Browse...

L pe—— Q‘amy:ﬁaMa-dvunl'

oK | Cancel

Quality slider

Click OK. If you’re using a scanner with a TWAIN driver, Elements Organizer launches
the driver that came with your scanner. Follow the instructions that came with the driver
software to scan your photo. Typically, you can also select an area to scan or correct any
color issues that you may see
(OR)

b) How do you create a document in Photo shop? Explain.

Adobe Photoshop is software’s that will enable the students to use the
various tools and effects available for photo editing and graphic design.
Because of the growth of technology in this day and age, it is necessary to have the
ability to work with digital media. This presentation is an introduction to the basics of
Adobe Photoshop.
CREATING NEW DOCUMENT

To create a new document, click File > New. This will open the Document Setup dialog
box

New
Name: Untitled-1 @
Presat: Default Photoshop Size 7] ( Cancel )
a Save Preset...
Width: | 7 inches 3]
Height: |5 inches 7‘ T R
Resolution: |72 | pixels/inch 2
Color Mode: | RGB Color %) | 8 bit %) , 300 ppi, RGB,
Background Contents: White I3 | Image Size:
531.6K
El Advanced -
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Mew
Marne: | Urtitled-1 [ K. |
Preset: | Custom V | Reset |
Width: | 12 Crm v [ Save Preset, ., ]
Height: | 9| cm |
Resolution: | 200 pixels/inch v
Color Mode: | RGE Color V 8 hit v
Backaround Contents: | Transparent ™ Amegs e
o 4,31M
%) Advanced
Color Profile: | Working RGE: sRGE [EC61966-2.1 | v
Fizel &zpect Ratio: | Sguare v

Step 3. Press Save Preset... and you will see the New Document Preset dialog box.
The program offers us to save the preset as 12 cm x 9 cm™. It's quite a good name, so

we just press Ok to save the preset.

Mew Document Preset

=)

Preset Mame: | 12 cm X% 9 cm

Include In Saved Settings:

Resolution Content
Mode Profie
Bit: Depth PFixel Aspect Ratio

1

Walues not included in the saved preset
wiill default to their last used value.

Step 4. Next time you need the document of this size, just call the command File => New
and in the Preset fall-out menu in the New Document dialog box select the **12 cm x 9

cm' preset.

. Click File on the menu bar
Click New

Click OK

Enter the required width in the Width text box

Enter the required height in the Height text box
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22. a) Describe about Displaying Images in Photo shop.
DISPLAYING THE IMAGE

1) The Zoom Tool

Choose the Zoom tool from Tool palette. Place your cursor on the area of the
image. you will see the Zoom tool cursor with a plus sign indicate the Zoom tool with
enlarge the view .The image appear larger to maximum view size of 1600 percent.

if) Scrolling in Photoshop
The Hand Tool: choose the Hand tool .click the image and drag to move the image.

Scroll Bar: Click and Drag scroll Handle or click an arrow at end of the scroll
bar.

Keyboard : you can use the keyboard to scroll the image up ,down, left, or
right.

Keyboard commands for scrolling

Scroll Action Mac KB Mac Extended KB Windows KB
Up Control+K PgUp PgUp
Up Slightly Shift+Control+K Shift+PgUp Shift+PgUp
Down Control+L PgDn PgDn
Down Slightly Shift+Control+L Shift+PgDn Shift+PgDn
Left Cmd+Control+K Cmd+Control+PgUp Ctrl+PgUp
Left Slightly  Shift+Cmd+Ctrl+K Shift+Cmd+Ctrl+PgUp
Shift+Ctrl+PgUp
Right Cmd+Control+K Cmd+Control+PgDn Ctrl+PgDn
Right Slightly  Shift+Cmd+Control+L Shift+Cmd+Control+PgDn
Shift+Ctrl+PgDn

iii) Navigation shortcuts
Centering the image: This technique centers and zoom and area of image on the
screen.
Restoring the display to a 100 % view: Double click the Zoom tool icon in the tool
palette
Toggling to the Zoom tool:
eHold down the command or ctrl key and space bar and click the mouse to
zoom in.
eHold down the option or alt key and space bar and click the mouse to
zoom out.
Toggling to the Hand tool:

The hand tool lets you scroll around the image when it exceeds the size of the
image window.

iv) The Navigator
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The navigator is map of the image displayed as thumbnails showing the exact location
of what appears in the image window relative to the entire image. Navigational features
are,

View box:

The red rectangle on the thumbnail indicates what is currently displayed in the image
window .you can choose a color from pull down menu or click the swatch to choose a
color from the color picker.

Zoom slider:

You can Zoom in on the image by moving the slider to the right , or zoom out by
moving the slider to the left.

Zoom in & Zoom out buttons:

The button with the small mountains on the left of the slider zooms out, and the
button with the large mountain to the right of the slider zooms in. The buttons use the
same predefined increments as the Zoom tool.

Magnification Box

At the bottom-left of the Navigator palette, you can enter a specific percentage at
which to view your image.

Sizing the Navigate Palette

You drag the lower-right corner of the Navigator box to increase or decrease the
size of the Navigator palette and its image thumbnail.

v) The View Menu

For example, the View—>Zoom In command achieves the same result as the
keyboard shortcut Command /Ctrl + plus sign; The Zoom Out command is the same as
typing Command/ctrl+minus sign. These techniques are identical to the Zoom tool and
,0f course, all of these commands are similar to the function of the Navigator and the
magnification box, slide variations.

The other options in the View menu are
Fit on screen displays the image at the maximum horizontal or vertical size the monitor
screen will accommodate.

Actual Pixels displays the image in a 1:1 ratio with the monitor’s screen resolution.

Print Size accurately displays the height and width dimensions of the image.

71



Second internal answer key

New View the View—>New View command displays multiple windows of the same
document. Multiple windows give you the ability to observe two or more views of your
image simultaneously, so that you can see the close-up detail in which you are working
and the global effect on the entire image. When you edit the image, you will see the
changes on both views.

vi) Display Modes

Three icons on the Tool palette determine how the image is seen on screen. These
modes act like electronic mats. There are three options:

Standard Background The default view displays the image up against the
operating system’s desktop.

Full Screen with Menu bar The image takes up almost the entire surface of the
monitor screen and displays menu bars across the top. When you zoom to a smaller
display size, the image appears centered against a great background.

Full Screen The image takes up the entire surface of the monitor screen. When
you zoom to the smaller display size, the image appears centered against a black
background.

(OR)
b) llustrate about choosing colors and creating own colors in photoshop.
CHOOSING COLORS

Picking a color in Photoshop 6 is as simple as squeezing paint from a tube. It is a
matter of choosing a color from one of Photoshop’s three color interfaces. In addition you
can sample color directly from an image.

There are two color swatches near the bottom of the tool palette, representing the
current foreground and back ground colors. The swatch on the left is this foreground
color, a which is applied by any of the painting tools. The default foreground color is
black. The background color on the right is applied with this eraser tool or if you cut a
selected portion of an image on the background. The default background is white.

You can reverse the fore ground and background colors by clicking the curved

arrow to the upper _right of the swatches.

i)The color picker
"To choose the fore ground or back ground color, click its swatch; the color picker

appears. The color picker lets you choose from four methods of defining your colors:
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HSB, RGB, Lab, and CMYK. Your main tool in the color picker is a vertical slider and a
large colors field.

Hue: This is the position of the color on a color wheel. When the H radio button
it’s selected in the color picker, the vertical slider is displays in the spectrum of all of the
available hues, and the color fields presents that hue's saturation and brightness variation.
Notice that the top and bottom of the spectrum slider or both red. If you drag the slider to
the top or bottom of the color bar, the values in the hue box are the same: 0 degrees. No,
we are not taking the hue's temperature; we're determining its position on a color wheel.
The vertical bar is actually a color wheel that has been cut and straightened at the 0
degree, or red, position drag the slider anywhere on the bar, notice that the hue values
change the to a number between 0 and 360 degrees. As you move the slider, the field to
the left changes color.

Saturation: The color field on the left determines the saturation and brightness of
the hue. Saturation is the intensity of a particular hue. There are two ways to determine
the saturation of color in the color picker: Enter the value in the saturation box, or click or
drag within the coloe field. If the value in the saturation box is 100%, or if the circle on
the color fields is to the far right, the color will be as intense as it can possibly be. Ifa 0 is
entered in the saturation box, or if the circle is the placed at the far left of the field, the
color will be gray

Brightness: The value of the color is controlled in a simalar manner. Brightness
is the lightness or darkness of a color.Lower values produce darker color,with 0%
equaling black.Higher values produce lighter colors,with 100%equaling white when there
is no colors saturation or the lightest possible combination of hue and saturation. Click
toward the bottom of the color field to darken the color or toward the top to lighten it.

ii) Active parameters of colors

By default, the color picker opens in HSB mode with hue as the active parameter.
The slider represents the colors (hues) on the color wheel, and the field represents the
saturation and brightness of the selected hue. The color picker can be changed to display
several different configurations: the color section of this book includes a side by side
comparison of the color picker's appearance when using each of the value fields.

The color picker can be configured for HSB, RGB, Lab, and CMYK active
parameters by clicking a radio button next to the desired model. Then vertical bar then

represents the selected characteristic in the selected model When the S radio is active, for
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instance, active parameter of the color picker shifts to saturation mode and the vertical
bar becomes a saturation slider. The color field now displays hue and brightness
variations. If you click or drag in the field to the left or right, you affect the hue: if you
click or drag up or down, you affect the brightness.

When the B radio button is checked, the active parameter of the color picker shifts
to brightness, on the vertical bar becomes a brightness slider the color field now displays
hue and saturation variation: clicking in field or dragging the circle to the left or right
affect the hue and dragging it up or down affect the saturation.

In the case of RGB and Lab (lightness, a, b) when a color channel's radio button is
selected the vertical slider displays the variation of the color within that channel, and the
color field becomes the other two color is channels, one represented the horizontally and
the other represented vertically.

The color swatch at the top of the color picker has two parts. The bottom of the
swatch shows the current color setting: the top shows the color you have selected in the
color picker
Specifying CMYK Colors

Let's say a client walks into your office and wants you to add a logo to an image
with specific CMYK color values to correspond to the official corporate colors of her
business. Once you have scanned to logo, you can define the colors in the color picker
and fill the logo with the exact tint values of cyan, magenta, yellow, black needed to
produce the corporate color.

To define and apply CMYK colors:

1. Click the foreground swatch to display the color picker.

2. Enter the CMYK %value in the boxes.

3. Click OK. The color appears as the foreground color.

4. Select the area to be filled.

5. Press option + delete (Mac) or Alt + Backspace (Win) to fill the selected area.
The CMYK Gamut Warning

You would think that because CMYK is represented by 4 color channels instead
of three would be more colors available in this color mode. But in fact, a high percentage
of black plus any combination of cyan, yellow and magenta usually yields black. This

greatly limits the possibilities of CMYK. In fact, the CMYK gamut is so small that some
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colors can’t be produce at all especially highly saturated one’s the color section includes
a schematic comparison of the gamut of visible, RGB, and CMYK Colors.

If you choose a color in HSB or RGB that is outside the printable range or gamut
of CMYK, you will see the percentage values in the CMYK boxes. However, you will
also see a CMKY Gamut Warning next to the swatch in the Color Picker. The small
swatch blow the warning is a representation of how the color will print. Some CMYK
colors, especially highly saturated colors, can vary significantly from their RGB counter
part. If you get a warning, you may want to specify a different color for a close match, or
be prepared to accept considerable variation of the color on the printed piece.

Specifying Web Colors

In HTML code, colors are coded with a combination of six hexadecimal digits so
that WWW browsers can read and display them. Not all browses can display all colors
you can use the Color Picker to assure that the colors you use are browser-safe.

To Specify a Web color, check the Only Web Color box at the bottom of the
Color Picker. The color bar and color field then unique themselves to 216 Web-
Compatible colors.

Like CMYK colors, Web colors have a very limited gamut compared to RGB.
When the Only Web Colors box is unchecked, the Color Picker displays a Web Color
Gamut Warning next to the large swatch in the Color Picker. The small swatch below the
warning shows how the color will be seen on Web browser.

Specifying Custom Colors

The PANTONE Matching System is a group of inks used to print spot colors.
where CMYK mixes only 4 colors to produce a full color a spectrum, PANTONE inks
are solid colors used to print rich solid or tinted areas.

To specify a custom color:

1. Click a color swatch to display the Color Picker.

2. Click the Custom button to display the Custom
Color dialog box.

3. From the Book pop-up list, choose the desire
matching system.

4. Enter the color’s number using the keypad. you

can, instead, scroll through the color list using
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the slider; when you find the color you want,
click it.
5. Click OK.
iii) Using color palettes
While the color picker displays all of the color characteristics and models in one
integrated fields, it is sometimes cumbersome to use because it is not context-sensitive. A
context-sensitive palette’s will response immediately to your commands without having
to click an OK button. But the color picker must be displayed by clicking the foreground
or background swatch. You must then choose a color model and a color. Finally you must
click OK. This process can be time-consuming because of the many steps involved.
Instead, you may want to use the context-sensitive color and swatch palettes that
conveniently float on the desktop.
The Swatches Palette
To display individual swatches of color, choose the Swatches palette from

the palette cluster. Predefined color can be chosen, or new colors can be added and saved.

Swatches Technique How To Do It

To Select a Foreground Color Click it; the color will appear as the

foreground swatch on the Tool palette

To Select a Background Color Press the Option(Mac)or Alt(Win) key while

clicking the color

Add Color Place your cursor in the blank space below
the color swatches. The cursor changes to
paint can. Click your mouse, name the color
and the foreground color will appear in the

palette as a new swatch.

To Delete a Color Press the Command (Mac) or Ctrl(Win) key
and click the swatch. Or, control-click
(Mac)or right-click(Win) and select Delete

Swatch from the shortcut menu.

To Save a Swatch Palette Once you have added colors to the swatches,

you may want to save the palette for use in
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other documents. From the Swatches palette
menu, choose Save Swatches. Designate a
folder in which to store your palette

To Load Swatches To access a saved palette, choose Load
Swatches from the Swatches palette menu.
You can then access the Swatch from folder
in which you saved it, or choose a specific
palette like PANTONE, Focoltone , ANPA,
or Web Save Colors from the list.

To Reset Swatches The Reset Swatches command on the palette
menu restores the swatches to the Photoshop
default palette.

To Name a Swatch Color Swatches can be named for
identification. To name a swatch, double-
click it and enter the name in the Swatch
Name dialog box. Or Control-click (Mac) or

right-click (Win) and select Name Swatch.

iv) Sampling Colors

Foreground and background colors can be specified by sampling directly from the
image.
To sample a color, choose the Eyedropper from the Tool palette and click or drag across
the image. As you drag, notice that the foreground swatch changes to the color the
eyedropper is touching. To sample a background color, hold down the Option or Alt key

as you click.

23. a) Explain the role of Painting & Editing Tools.
The painting and editing tools are used to manually apply color or to modify an

area of the image. You can access the painting and editing tool by clicking them in the
tool palette or by pressing the appropriate letter key on the keyboard.
i) The Painting Tools

The painting tools include the Airbrush, paintbrush and pencil; these tools are

designed to simulate real studio painting techniques.
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Airbrush (Shortcut Key-J)

Use the airbrush to spray color. By placing your cursor on the image, clicking
your mouse, and dragging, you can spray a pattern of color. If you drag slowly or stop
dragging the color will build just like a real airbrush. You can adjust the pressure of the
airbrush in the options bar, which controls amount of color that is deposited.
Paintbrush (B)

You apply color to the image with the paint brush by clicking your mouse
Button and dragging. By default, the stroke is a solid color. You can adjust the
characteristics of the tool to alter quality of the paint stroke.

Opacity The transparency of the stroke is controlled with the opacity
slider from 0% t0100%.When painted on a colored surface, the transparent of translucent
stroke will reveal the pixels underneath it.

Wet Edges this adjustment provides a water color stroke that looks as
though the color is concentrated along its edges and translucent in its center.

Pencil (B)
The pencil is the only tool that produces an aliased or hard-edged stroke. Use the pencil
to draw crisp horizontal or vertical lines or stair-stepped diagonals.
Like the paint brush, you can adjust the opacity or assign a color mode to the stroke.
You can use the pencil as an eraser by checking the auto eraser box. If you start
painting an a area containing the foreground color, the auto erase function replaces it
with background color. If you start painting on an area containing any color other than
the foreground color, the pencil paints with the foreground color.
ii) The Editing Tools
The editing tools include the clone stamp, pattern stamp, history brush, Art
history brush, eraser, background eraser, magic eraser, blur, sharpen, smudge, dodge,
burn, and saturate tools. While the editing tools don’t apply the color directly to the
image, they are essential for manipulating small regions with in the image and modifying
existing colors.
Clone Stamp (S)
To clone an area,you must 1% sample it:

1. Choose the Colne Stamp from the Tool paletee.
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2. Choose an appropriate brush from the Bush menu on the
Options bar.

3. Press the Option(Mac) or Alt(Win) key and click your mouse
on the point that you want to copy.

4. Release your mouse and reposition the cursor were you want
sample to be painter.

5. Click your mouse and begin painting. As you paint, that tool
will begin coping the point of the image that was sampled.A
small cross will indicate the area that is begin copied as you
drag the brush across the image.

Pattern Stamp(S)

Use the pattern stamp to paint an area with a repeating pattern that you choose
from the pattern pull-down menu on the options bar.

Check the aligned option to maintain the alignment of the brush with the pattern.
Each time release the mouse, move the brush, and resume painting, the alignment of the
pattern continues. If aligned is unchecked, the image time you click, the center of the

pattern till will again the source of the new image.

History Brush(Y)

The History Brush restores a portion of the image to a formal state. Choose the
History Brush and target a state in the History palette, choose a brush size, press the
mouse and drag across the image.

Art History Brush(Y)

This tools is quite handy for creating instant Impressionists effects. When
you paint with the Art History Brush,color is deposited rapidly in several directions.
Choose from a list of characteristics in the Options bar that affect the style of the stroke
and the rapidity in which it is deposited.

*Style Determines the size and shape of the strokes that art deposited.

Choose from a list that includes Tight,Loose,Short,Long,Dabs,and Curls.
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*Fidelity Is a percentage(from 0% to 100%) that affects the color of the
stroke and how close it will be to the color on which your painting. Higher values
produce more monochromatic affects,and lower values produce more color variation.

*Area Determines how wide a region the strokes will be deposited over,
from 0 to 500 px. Higher —resolution files need higher values.

*Spacing Control the freequency(from 0% to 100%) at which the stroke
is deposited as you drag. Dragging faster produces wider gaps between stroke clusters.
Eraser(E)

The Eraser performs differently depending on whether you’re working on the
Background or a layer.when working on the Background,the Eraser replace the area with
the background color in the Tool palette.When erasing to a layer,it replaces the layer
content with transparency.if the transparency option on the layer is locked,then the pixels
are replaced with the background color.

The Eraser offers 4 modes in which to work:Airbrus,Paintbrush,Pencil,or Block.
The characteristics of each tool are inherent in the erasure. For eg,if you choose the Wet
Edges option in paintbrush mode, the Eraser erases to a watercolor effect.

You can erase the image back to a history state by clicking the 1% column in the
history palette to set a source and choosing the Erase To history option from the options
bar.

Background Eraser(E)

The Background Eraser tool is a combination of the Magic Wand tool and the
eraser,in that it lets you sample and set a tolerance to determine what range of color will
be erased. You can also determine the sharpness of the remaining edges. The Background
Eraser erases to transparency of a layer,or automatically converts the Background into a

layer when applied there.

1. Erasing Modes Control what pixels will be erased. Choose:

@ Discontiguous To erase all of the pixels within the

tolerance range on the entire layer.

@ Contiguous To erase pixels of the sampled color

that are adjacent to each other.

16 |



Second internal answer key

@ Find Edges To erase pixels of the sampled color
that are adjacent to each other but better preserve the

sharpness of the edge pixels of the remaining iamge.

2. Tolerance Controls the range of colors to be erased. Low tolerance
erases colors that are similar to the sampled colors : High tolerance

erases to colors that are more diverse in range.

3. Sampling Option Determines the method in which the colors will be
chosen

@ Continues Sample color continuously as you drag,

erasing area‘s of different colors.

@ Once Samples a color when you 1% click and then
continues to erase only that color. Use this option to erase

areas of solid color.

@ Background Swatch Erases areas that are the
current background color.
Magic Eraser(E)
The Magic Eraser erases all px of similar color within the Tolerance range when

you click the color you want to erase . It allows you isolate the erasure 2 specific colors.
1. Tolerance In the options bar controls the range of colors to be erased.
Low tolerance erases color that are similar to the sampled colors ;

High tolerance erases to colors that are more diverse In range.

2. Opacity Determines the strength of the erasure.
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3. Contiguous Determines what px will be erased. When checked, you
erase only adjacent px of the color. With Contiguous unchecked,the
magic eraser erases all px of the color on the layer.

4. Use All Layers Determines where the information will be erased.
With this option checked,the magic eraser erases through all of the
visible layers ; without this option, it erases only the px on the target
layer.

Blur(R)

The blur tool soften the region us you apply it by decreasing the relative contrast
of adjacent pixels. Use it to blend colors and soften edges,or to reduce focus of a
background. Increase the pressure setting in the options bar to strengthen the effect.
Sharpen(R)

The sharpen tool increases the relative the contrast values of adjacent pixels. As
you drag over an area, the px randomly change color. Sharpening fools your eyes into
thinking and image is in focus. This tool can be used to enhance portions of an image that
you want to emphasize,or as a quick fix for photographs that are slightly out of focus.
Smudge(R)

Use the smudge tool to simulate charcoal or pastel effects . As you drag with the
smudge tool,you move one area of color into another while blending and mixing the
colors as you move them.

Dodge(O)

Dodging is a technique used by photographer in the darkroom to overexpose or
lighten specific areas of an image. In photoshop,the dodge tool performs a similar
function by increasing the brightness values of pixels you paint with it. The effect on the
specific range of tonality by choosing Highlights,Midtones, or Shadows from the range
pull-down menu.

Burn(O)

Photoshop’s burn tool darkens by lowering the brightness values of pixels as you

move it over the image .As with dodge tool, the options bar lets you pick a range of px to

effect by choosing Highlights, Midtones, or Shadows from the menu.

Sponge(O)
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The sponge tool changes the intensity as it touches pixels. From the Option bar,
choose either Saturate to enhance a color or desaturate to diminish the color and push it
toward gray.
iii)Brush Dynamics

The behavior of all of the painting tools can be controlled from the brush
dynamics menu on the right side of the options bar. This control lets you fade ,taper, or
changed the color of a stroke over a specified distance.

Choose from the following characteristics:

Size Specify a number of steps to gradually taper the thickness of the
brush stroke until it disappears.

Opacity Set a number of steps to gradually fade the brush until it
completely disappears.

Color Enter a number of steps gradually fade the foreground color into the
background color.
iv)Color Blending Modes

Blending modes control the relation of the color that is begin apply to the existing
colors on the image. The normal blending mode, at 100% opacity, applies in a color as if
it were painted straight out of a tube.
v)Painting Tools Shortcuts

Here are a couple of shortcuts that will increase your dexterity in handling the
painting tools and performing tasks the would be otherwise impossible. For horizontal
and vertical lines, press the Shift key as you drag up or down, left or right. for straight
line in any other direction, click and release your mouse, then move the cursor to a new
location as shift-click

(OR)
b) Elucidate about different selection tools and its techniques with examples.
Photoshop’s selection tools are similar in principle, but quite difference in

application to the traditional mask. Masking techniques in Photoshop 6 afford even more
control and are even more user friendly than in previous version. The selection tools
range from purely manual, like the Lasso, to semi manual, likely marquee, to semi
automatic, likely magnetic Lasso, to fully automatic, like the magic wand. Each selection
tool is designed to hasten the masking process, developing on the characteristics of the

image.
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There are many situations were one selection tool is insufficient and several must
be combined to surround the target area. Often, other selection techniques will be
employed in combination with tools for grated accuracy or to isolate a tricky area.

Using Selection Tools

When you make a selection in Photoshop, an animated marquee defines the
boundaries of the selected area. This moving dash lined border is sometimes referred to
as the “Marching ants” because of its resemblance to a column of tiny insects on the
move.

There are Photoshop’s selection tool are located at the top of the tool palette.
When you press and hold the mouse on the rectangular marquee tool, the palette expanse
to reveal three additional tools. When you expand the Lasso tool, two more tools are
revealed, for a total of eight different selection tools.

i) The Selection Tool Options Bar

Photoshop 6’s Options bar replaces the tool options palettes of prior versions.
Choosing a tool displays its options automatically in the Options bar. Each tools has
specific options, but some options are universal to all of the selection tools.

When you choose a selection tool, the icon that represents it appears on the left
end of the options bar. The next four icons represent selection option that in format
version were performed only by key commands.

*New Selection Click this button to create a new selection with the chosen
selection tool.

*Add To Selection Click this button to add to an existing selection with the
chosen selection tool. You can perform the same function by holding down the shift key
as you drag with the selection tool.

*Subtract From Selection Click this button to omit from an existing selection
with the chosen selection tool. You can perform the same function by holding down the
option or alt key as you drag with the selection tool.

*Intersect Selection After the first selection is made, you draw another selection
that overlaps it. Photoshop makes the selection from only the overlapping area of the two
selections. You can perform the same operation by pressing shift+options or shift + alt as

you use the second selection tool.
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*Feather Prior to drawing a selection, you can program a tool to produce a soft
edged selection by specifying a numerical value in the feather field in the tools Option’s
bar

Feathering creates a gradual transition between in inside and the outside of the
border. When u apply an effect tool a feathered selection, it diminishes and becomes
more transparent, producing a softening of blurring effect.

When you choose select—>Feather, a dialog box appears; Enter the value for a
feather Radius, The Feather Radius extends the specified number of pixels into the
selection outline and outside the selection border.

A feather differs from anti-alias in that you can determine the size of the soft edge
in pixels that the marquee will affect. The width of an anti-alias is determined by the
resolution of the image; you have no control over its size.

When you apply a feather to an existing selection border, sometimes you will see
it decrease in size or slightly change shape.

*Anti-Aliased An anti-alias is a two-or three-pixel border around an edge that
blends into the adjacent color to create a small transition zone. It is intended to simulate
depth of field in a photograph. Without the anti-alias, an image would look “aliased”
stair-stepped, without smooth transitions between colors
i) Shapes Selection Tools

The Rectangular Marquee tool and its fly-out, the Elliptical Marquee tool, are
useful when you need to select a fairly standard shape within your image-a rectangle,
square, circle, or ellipse.

From the Tool palette (but for some reason not included in the Shift+M key short-
but when you cycle through them), you have more options for these’predefined”
selections: the Single Column Marguee and the Single Row Marquee.

Rectangular Marquee

The Rectangular Marquee tool is used to select rectangular or square portion of
the image. Click the image and dragging any direction to select rectangular area of the
image.

The Style menu in the Marquee tools’ Options bar enables you to choose from
three methods for sizing the Rectangular and Elliptical Marquees.

*Normal By choosing Normal, you determine the size and proportion of the

marquee by dragging.
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*Constrained Aspect Ratio Enter numerical values for the proportion of the
marquee in the Height and Width fields.

*Fixed Size The size of the marquee is determined by the values in pixels, that to
enter in the Height and Width fields. The marquee size is defined by pixels because it

can’t select anything smaller.

Elliptical Marquee
Use this tool to create ellipses or circle. Its performance is identical to the
Rectangular Marquee: Click and drag in any direction to produce and elliptical or circle
selection
Single Column Marquee
The Single Column Marquee tool selects a single vertical column or pixels. Click
any-where in the image, and a selection marquee appears around single column of
adjacent pixels that runs vertically across the entire image.
One way you can use this feature used to create stripes that can later the colorizes
to produce wood-grain effects. Here’s how:
1. Open an RGB document with a white background.
2. Select a single column of pixels.
3. Choose Filter->Noise—> Add Noise—=>400, and click OK,
4. Choose Edit—> Transform->Scale. Drag the center handle of the
left or right edge to the left or right.
5. Press the Return/Enter key to initiate the transformation (or the
Esc key to cancel).
Single Row Marquee
The Single Row Marquee tools select a single horizontal row of pixels. Click
enters on the image, and a selection marquee appears around single, continuous row of
adjacent pixels that runs horizontally across the entire image.
iii) Free-Form Selection Tools
Photoshop offers three main ways to make irregular-shaped selections. The Lasso
tool (and its fly-outs, the Polygonal Lasso and Magnetic Lasso)draw selection based on
your mouse movements, in varying degrees of freedom. Cycle through these tools by

pressing Shift+L.
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The Magic Wand tool (shortcut key Shift +W) allows you to select without regard
for position, instead based on the brightness of the pixels in your image.
Lasso

The Lasso tool draws free-form selections. Click the edge of the area you want
select and drag the tool surround the area with the selection border. Close the marquee by
placing the cursor on the starting point are release the mouse to close the selection with a
straight line.
Polygonal Lasso

The Polygonal Lasso tool is used to create straight —edged selection borders.
Click and release mouse. Reposition the mouse to the next corner of the polygon, and
click and release again. Repeat the process until the area is surrounded. Close the
marquee by clicking the starting point again.
Magnetic Lasso

The Magnetic Lasso tool intuitively makes selections based on the contrast values
of pixels. As you click and drag, the Magnetic Lasso deposits a path that is attracted to
areas of the most contrast. When the mouse is released, the path becomes a selection.

The tool as 3 settings in the Options bar that affect is behavior:

*Width (in pixels) This setting determine the distance from the path of
mouse within which pixels will be evaluated for contrast by the Magnetic Lasso.

*Edge Contrast This is the minimum percentage of pixel contrast that the
Magnetic Lasso will be attracted to. The higher the number, the smaller the range of
contrast, hence the more selective the tool will be.

*Frequency Enter the value for the frequency with which points are
automatically deposited. The points create segments along the path that fix the previous
segments and better control its behavior.

Magic Wand

The Magic Wand tools select the areas of an image that are similar in brightness.
To use the Magic Wand, place your cursor on the area to be selected and click your
mouse. Adjacent pixels of similar color will be included in the selection.

You can affect the range of pixels that are selected by adjusting the Tolerance in
the tool’s Options bar. Higher Tolerance values include in the selection more pixel of

grater color and brightness range. Lower values include fewer pixels in the selection.

23|



Second internal answer key

Other values in the Options bar enhance your ability to control the operation of
the Magic Wand tool:

*Contiguous By default, the Contiguous box is checked, which limits the
selection to adjacent pixels. Uncheck this box to select all the pixels in the image with in
the same Tolerance range.

*Use All Layers If this box is unchecked, you will limit the selection to
only pixels within the same Tolerance range on the same layer.

Applying Selection Techniques

There are several ways to modify a selection outline; among them, you can
conceal it, transform it, add to it, subtract from it, soften its edges, and eliminate it. These
commands are important because they facilitate the process of masking.

i) The Select Menu

Some selection adjustment can be automatically applied by accessing them from
the Select menu or applying a shortcut key command.

*Select All (Cmd + A on Macintosh, Ctrl+A in Windows) This command selects
the entire content of an image or a targeted layer.

*Deselect(Cmd/Ctrl+D) Use Select->Deselect to deactivate the selection.
Another method is to click off the selection, anywhere on the image.

*Reselect(Shift + Cmd/Ctrl+D) Choose this command to reactivate the last
deselected selection border.

*Inverse(Shift+Cmd/Ctrl+I) To deselect the selected portion of the image and
select the masked portion, choose Select = Inverse. This technique can save time when
an image has been photographed on a single color background. The background can be
selected quickly with the Magic Wand and inverted to select desired content.

*Hide Edges (Cmd /Ctrl+H) Use Select->Hide Edge to conceal and reveal the
marching ants from view whiled selection remains active. This command is useful to be
able to see changes to the image without the distracting selection border.

*Feather After you’ve made a selection, you can soften its edges by applying a
feather radius to it.

*Modify Once a selection has been made, you can alter its dimensions by
choosing one of the Select->Modify sub commands. Each command changes the

selection marquee and alters its dimensions:
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=> Border frames a selection and deselects the inside area of the outline,
producing a selected “border” of specific thickness. When you choose
Select->Modify->Border, you are presented with a window. To determine the thickness
of the border by entering a value in pixels into the Width field.

=>Smooth round sharp corners of a selection, eliminating protrusions and
stair-stepped areas of the selection border. When you choose Select—>Modify—>Smooth,
you are asked to put in a Sample Radius value. Enter the large values to increase the
effect.

=>Expand and Contract both perform in the same way to enlarge are
reduce the size of the selection by a specified number of pixels. This command is quite
useful  for trimming off stubborn, unwanted edge pixels. Choose
Select->Modify->Expand or Contract. And enter the value between 1 &16 pixels. Click
OK to implement the operation.

*Grow The value entered in the Tolerance field of the Magic Wand’s Options bar
determines how much selection will grow. When you choose Select-> Grow, the select
marquee expands to include adjacent pixel that are lighter or darker by no more then the
Tolerance range.

* Similar In order to use this operation, a selection must be activated. When you
choose Select->Similar, Photoshop select all pixels within the image that are the same
colors as the pixels within the selected area.

ii) Transforming a Selection

Once you have made a selection, you may want to alert it safe before
applying one of Photoshop’s many powerful operations to its content. Photoshop gives
you the ability to scale, rotate, or move a selection border. To transform a selection,
choose Select-> Transform Selection. The Rectangular transformation box appears around
the selection border. You can then transform the size, angle, or position of the selection
border with the following procedures:

*Move To move the selection, place your cursor within the rectangular
transformation box; the Move cursor appears. Press your mouse button and drag the
selection into position, then release the mouse.

*Scale To scale a selection border, place your cursor on one of the square

handles on the corners or sides are the box. The Scale cursor appears. Press your mouse
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button and drag. To constraint the selection border to its current position, press your Shift
key while dragging.

*Rotate To rotate a selection, place your cursor outside the box. The
Rotate cursor appears. Press your mouse button and drag to rotate the selection.

After you have chosen Select->Transform Selection and the
transformation box is displayed, you can also apply many more transformation to the
selection by choosing Edit->Transform. A list of options appears, including Skew,
Distort, Perspective, and various precise Rotate commands. The Flip Horizontal or Flip
Vertical commands will mirror the marquee across a horizontal or vertical axis passing
through its point of origin icon
iii) Other Selection Techniques

Once selection has been made, you can reposition the marquee with or without its
contents using the following techniques:
Move Selection Outline
While in any selection tool, click inside the marquee and drag. When you've
relocated the outline, release the mouse.
Nudge Selection Outline
While in any selection tool, press the right, left, up, or down arrow keys to move
the selection name increments of one pixel. Press the shift key plus any of the arrow key
to move the selection outline ten pixels at a time.
Move Selection Content
Choose the move tool; click inside the marquee and drag. When you have
relocated the marquee, release the mouse. You can also move the contents while in any
selection tool: Cmd_click or Ctrl_click inside the marquee and drag. When you've
relocated the selection, Release the mouse and then the key.
Nudge Selection Contents
You can nudge the selection content in one pixel increment: With the move to
active press the right, left, up, or down arrow keys press the shift key plus any of the
arrow key to move the selection outline ten pixels at a time.
Duplicate Selection Contents
Position the cursor inside the marquee, hold down the option+command (Mac)or
alt+ctrl(Win) while you click and drag.(Or get the move tool and hold down option or alt

while you drag.)When you have relocated the copy to the desired position, release the

26 |



Second internal answer key

mouse.
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